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1. Start Here

This book aims to teach you how to build Android applications
using Jetpack Compose 1.3, Android Studio Flamingo (2022.2.1),

Material Design 3, and the Kotlin programming language.

The book begins with the basics by explaining how to set up an

Android Studio development environment.

The book also includes in-depth chapters introducing the Kotlin
programming language, including data types, operators, control
flow, functions, lambdas, coroutines, and object-oriented

programming.

An introduction to the key concepts of Jetpack Compose and
Android project architecture is followed by a guided tour of
Android Studio in Compose development mode. The book also
covers the creation of custom Composables and explains how
functions are combined to create user interface layouts, including

row, column, box, and list components.

Other topics covered include data handling using state properties,
key user interface design concepts such as modifiers, navigation
bars, and user interface navigation. Additional chapters explore

building your own reusable custom layout components.



The book covers graphics drawing, user interface animation,

transitions, Kotlin Flows, and gesture handling.

Chapters also cover view models, SQLite databases, Room
database access, the Database Inspector, live data, and custom
theme creation. Using in-app billing, you will also learn to

generate extra revenue from your app.

Finally, the book explains how to package up a completed app
and upload it to the Google Play Store for publication.

Along the way, the topics covered in the book are put into
practice through detailed tutorials, the source code for which is

also available for download.

Assuming you already have some rudimentary programming
experience, are ready to download Android Studio and the Android
SDK, and have access to a Windows, Mac, or Linux system, you

are ready to start.



1.1 For Kotlin programmers

This book addresses the needs of existing Kotlin programmers and
those new to Kotlin and Jetpack Compose app development. If
you are familiar with the Kotlin programming language, you can

probably skip the Kotlin-specific chapters.



1.2 For new Kotlin programmers

If you are new to Kotlin programming, the entire book is

appropriate for you. Just start at the beginning and keep going.



1.3 Downloading the code samples

The source code and Android Studio project files for the examples

contained in this book are available for download at:

https: //www.ebookfrenzy.com /retail /composei3 /index.php

The steps to load a project from the code samples into Android

Studio are as follows:

1. Click on the Open button option from the Welcome to Android
Studio dialog.

2. In the project selection dialog, navigate to and select the folder

containing the project to be imported and click on OK.


https://www.ebookfrenzy.com/retail/compose1

1.4 Feedback

We want you to be satisfied with your purchase of this book.
Therefore, if you find any errors in the book or have any

comments, questions, or concerns, please contact us at



1.5 Errata

While we make every effort to ensure the accuracy of the content
of this book, inevitably, a book covering a subject area of this
size and complexity may include some errors and oversights. Any
known issues with the book will be outlined, together with

solutions, at the following URL:

https: //www.ebookfrenzy.com ferrata /compose13.html

If you find an error not listed in the errata, email our technical

support team at


https://www.ebookfrenzy.com/errata/compose1

2. Setting up an Android Studio Development Environment

Before any work can begin on the development of an Android
application, the first step is to configure a computer system to
act as the development platform. This involves several steps
consisting of installing the Android Studio Integrated Development
Environment (IDE) which also includes the Android Software
Development Kit (SDK), the Kotlin plug-in and Open)DK Java

development environment.

This chapter will cover the steps necessary to install the requisite
components for Android application development on Windows,

macOS, and Linux-based systems.



2.1 System requirements

Android application development may be performed on any of the

following system types:

«Windows 8/10/11 64-bit

«macOS 10.14 or later running on Intel or Apple silicon

«Chrome OS device with Intel i5 or higher

«Linux systems with version 2.31 or later of the GNU C Library
(glibc)

«Minimum of 8GB of RAM

«Approximately 8GB of available disk space

«1280 x 800 minimum screen resolution



2.2 Downloading the Android Studio package

Most of the work involved in developing applications for Android
will be performed using the Android Studio environment. The
content and examples in this book were created based on Android
Studio Flamingo 2022.2.1 using the Android APl 33 SDK

(Tiramisu) which, at the time of writing, are the latest versions.

Android Studio is, however, subject to frequent updates so a

newer version may have been released since this book was

published.

The latest release of Android Studio may be downloaded from the

primary download page which can be found at the following URL:

https: //developer.android.com /studio /index.html

If this page provides instructions for downloading a newer version
of Android Studio it is important to note that there may be some
minor differences between this book and the software. A web
search for “Android Studio Flamingo” should provide the option to
download the older version if these differences become a problem.
Alternatively, visit the following web page to find Android Studio

Flamingo 2022.2.1 in the archives:

https: //developer.android.com /studio /archive


https://developer.android.com/studio/index.html
https://developer.android.com/studio/archive

2.3 Installing Android Studio

Once downloaded, the exact steps to install Android Studio differ
depending on the operating system on which the installation is

being performed.



2.3.1 Installation on Windows

Locate the downloaded Android Studio installation executable file
(named in a Windows Explorer window and double-click on it to
start the installation process, clicking the Yes button in the User

Account Control dialog if it appears.

Once the Android Studio setup wizard appears, work through the
various screens to configure the installation to meet your
requirements in terms of the file system location into which
Android Studio should be installed and whether or not it should
be made available to other users of the system. When prompted
to select the components to install, make sure that the Android

Studio and Android Virtual Device options are all selected.

Although there are no strict rules on where Android Studio should
be installed on the system, the remainder of this book will
assume that the installation was performed into C:\Program
Files\Android\Android Studio and that the Android SDK packages
have been installed into the user’'s AppData\Local\Android\sdk sub-
folder. Once the options have been configured, click on the Install

button to begin the installation process.

On versions of Windows with a Start menu, the newly installed
Android Studio can be launched from the entry added to that

menu during the installation. The executable may be pinned to



the taskbar for easy access by navigating to the Android Studio\bin
directory, right-clicking on the studio64 executable, and selecting
the Pin to Taskbar menu option (on Windows 11 this option can

be found by selecting Show more options from the menu).



2.3.2 Installation on macOS

Android Studio for macOS is downloaded in the form of a disk
image (.dmg) file. Once the android-studio--mac.dmg file has been
downloaded, locate it in a Finder window and double-click on it to

open it as shown in Figure

| X N ") Android Studio 4.3.0

Android Studio Applications

Figure 2-1

To install the package, simply drag the Android Studio icon and drop
it onto the Applications folder. The Android Studio package will then



be installed into the Applications folder of the system, a process that

will typically take a few seconds to complete.

To launch Android Studio, locate the executable in the Applications

folder using a Finder window and double-click on it.

For future, easier access to the tool, drag the Android Studio icon

from the Finder window and drop it onto the dock.



2.3.3 Installation on Linux

Having downloaded the Linux Android Studio package, open a
terminal window, change directory to the location where Android

Studio is to be installed and execute the following command:

unzip /to package>/android-studio-ide--linux.zip

Note that the Android Studio bundle will be installed into a
subdirectory named android-studio. Assuming, therefore, that the
above command was executed in the software packages will be

unpacked into /home/demo/android-studio.

To launch Android Studio, open a terminal window, change
directory to the android-studio/bin sub-directory and execute the

following command:

.[studio.sh

When running on a 64-bit Linux system, it may be necessary to
install some 32-bit support libraries before Android Studio will run.
On Ubuntu these libraries can be installed using the following

command:



sudo apt-get install libc6:i386 libncursess:iz86 libstdc++6:i386
lib32z1 libbz2-1.0:i386

On Red Hat and Fedora-based 64-bit systems, use the following

command:

sudo yum install zlib.i686 ncurses-libs.i686 bzip2-libs.i686



2.4 The Android Studio setup wizard

If you have previously installed an earlier version of Android Studio,
the first time this new version is launched, a dialog may appear
providing the option to import settings from a previous Android
Studio version. If you have settings from a previous version and
would like to import them into the latest installation, select the
appropriate option and location. Alternatively, indicate that you do not
need to import any previous settings and click on the OK button to

proceed.

If you are installing Android Studio for the first time, the initial
dialog that appears once the setup process starts may resemble that

shown in Figure 2-2 below:



@ 5] Android Studio Setup Wizard

%  Welcome
Android Studio

Figure 2-2

If this dialog appears, click the Next button to display the Install
Type screen On this screen, select the Standard installation option

before clicking Next.



@ 5] Android Studio Setup Wizard

ou can customize installation settings and components installed.

Previous

Figure 2-3

On the Select Ul Theme screen, select either the Darcula or Light
theme based on your preferences. After making a choice, click Next,
and review the options in the Verify Settings screen before
proceeding to the License Agreement screen. Select each license
category and enable the Accept checkbox. Finally, click on the Finish

button to initiate the installation.

After these initial setup steps have been taken, click the Finish
button to display the Welcome to Android Studio screen using your

chosen Ul theme:



Android Studio
Flaminge | 2022.2.1

Customize
Plugins

Learn Android Studio

Welcome to Android Studio

Welcome to Android Studio

Create a new project to start from scratch.
Open existing project from disk or version control.

+ = 4
New Project Open Get from VCS

Maore Actions v

Figure 2-4



2.5 Installing additional Android SDK packages

The steps performed so far have installed the Android Studio IDE
and the current set of default Android SDK packages. Before
proceeding, it is worth taking some time to verify which packages

are installed and to install any missing or updated packages.

This task can be performed by clicking on the More Actions link
within the welcome dialog and selecting the SDK Manager option
from the drop-down menu. Once invoked, the Android SDK screen of

the Preferences dialog will appear as shown in Figure

] L Preferences
Appaarance & Bahavier > Systam Settinge » Andraid SDE Rasat 4
~ Appearance & Behavior Manager for the Android SDK and Tools used by the IDE
Appearance Andraid 30K Location:  fUsersfreilsmythfLibrary/Androidtsdk Edit Optimize disk space

Metus and Toolbars
Pl i
System Sattings SDK Platforms SCK Tools SDK Update Sites
HTTP Proxy Each Andraid SDK Plattorm package includes the Android platform and sources pertaining to an
& hari APl lavel by default. Once installed, the IDE will automatically ¢eheck for updates. Check "show
ata Sharing package details" ta display individual SDK components.

Date Formats

Narme AP| Leval Revision  Stalus
Updates Android UpsideDownCake Preview UpsideDownCake 3 Mot installed
Process Elevation Android TiramisuPrivacySandbox Preview  TiramisuPrivacySandbox 8 Not installad
Passwords ¥ Android 13.0 {Tisamisu} 33 2 Update availakle
Android 12L 5+2) 32 1 Partially instalied
- Android 12.0 {5} 3| 1 Wot installed
Memory Settings . .

RARS Android 11.0 {R) 30 3 Mot installed
Motificatians Android 10.0) () 29 5 Mot installed
Quick Lists Android 9.0 (Pie) 28 & Not installed
Fath Variables Android 8.1 {Oreo) 27 3 Mot installed

Keymap Android 8.0 (Oreo) 26 2 Not installed
- editor Andraid 7.1.1 {Nougat) 25 3 Mot installed
i ) Andraid 7.0 {Maugat} 24 2 Mot installed
RREC e xecU OnIDERIOVINEDE Android 6.0 (Marshmallow] 23 3 Not installed
Kotlin Android 5.1 {Lollipop} 22 2 Not installed
5 Tools Angroid 5.0 [Loliipop) 21 p Not instalied
Athvanced Settings Android 4.4W (KitKat Wear} 20 3 Mot installed
Android 4.4 (KitKat) 19 4 Mot installed
Layout Inspector )
Android 4.3 [Jelly Bean) 18 3

Not installed

PO R I A " s - maaiiad

Hide Obsaoleta Packages Show Package Details

7 1 [ Cancel Apply “



Figure 2-5

Immediately after installing Android Studio for the first time it is
likely that only the latest released version of the Android SDK has
been installed. To install older versions of the Android SDK simply
select the checkboxes corresponding to the versions and click on the
Apply button. The rest of this book assumes that the Android
Tiramisu (AP| Level 33) SDK is installed.

Most of the examples in this book will support older versions of
Android as far back as Android 8.0 (Oreo). This is to ensure that
the apps run on a wide range of Android devices. Within the list of
SDK versions, enable the checkbox next to Android 8.0 (Oreo) and
click on the Apply button. In the resulting confirmation dialog click
on the OK button to install the SDK. Subsequent dialogs will seek
the acceptance of licenses and terms before performing the

installation. Click Finish once the installation is complete.

It is also possible that updates will be listed as being available for
the latest SDK. To access detailed information about the packages
that are ready to be updated, enable the Show Package Details option
located in the lower right-hand corner of the screen. This will display

information similar to that shown in Figure

Marme APl Level Rewvision Status

Android TV ARM 64 v8a System Image 33 1) Not installed
Android TV Intel x86 Atom System Image 33 5 Not installed

Google TV ARM 64 v8a System Image 33 5 Not installed

Gaooagle TV Intel xB86 Atom System Image 33 3] Not installed

] Google APls ARM 64 v8a System Image 33 8 G:Update A\:ailable: 2 b
Google APIs Intel x86 Atom_64 System Image 33 9 Not Inetaned
7 Google Play ARM 64 vBa System image 33 7 Installed



Figure 2-6

The above figure highlights the availability of an update. To install
the updates, enable the checkbox to the left of the item name and

click on the Apply button.

In addition to the Android SDK packages, several tools are also
installed for building Android applications. To view the currently
installed packages and check for updates, remain within the SDK

settings screen and select the SDK Tools tab as shown in Figure

Appearance & Behavior ! System Settings * Android SDK

* Appearance & Behavior Manager for the Android SOX and Tools used by the 1DE
Appearance Android SDK Location:  CAUsersyneilvippDataLocalAndroidySdk Edit Optimize disk spac
Menus and Taolbars
50K Platformg DK Update Sites
System Settings pd
HTTP Proxy Below are the available SDK developer tools. Once installed, thel IDE will automatically
check far updates. Check “show package details” (o display available versions of an
Diata Sharing SOK Teol.
Date Formats Narme Yersion Status
Updates B Android SDK Build-Tools Update Available: 32.0.1
Process Elevation NDK [Side by side) Mot Installed
Passwords Android SBK Command-fine Tools fatest) s tallee}
e CMake Mot Installed
bl android Auto APi Simulators i Mot installed
Memary Settings Android Auto Desktop Head Unit Emulator 20 Mot installed

Figure 2-7

Within the Android SDK Tools make sure that the following packages

are listed as Installed in the Status
«Android SDK Build-tools

«Android Emulator



«Android SDK Platform-tools

«Google Play Services

eIntel x86 Emulator Accelerator (HAXM

«Google USB Driver (Windows only)

Layout Inspector image server for APl 31 and T

the Intel x86 Emulator Accelerator (HAXM installer) cannot be

installed on Apple silicon-based Macs.

If any of the above packages are listed as Not Installed or requiring
an update, simply select the checkboxes next to those packages and
click on the Apply button to initiate the installation process. If the
HAXM emulator settings dialog appears, select the recommended

memory allocation:



e @ HAXM

0 Emulator Settings

We have detected that your system can run the Android emulator in an accelerated performance made,

Set the maximum amount ot RAM available for the intel® Hardware Accelerated Execution Manager (HAXM] to use tor afll xB6 emulator instances. You can
change these seltings at any time by running the Intel® HAXM instalier.

Refer to the Intel® HAXM Documentation » for mere information.

512.0 MB 2.0GB 3.3GB 4.6 GB 8.0 GB
{Recammeandead)

RAM allosation: 2,048 5 MiB Wise reconmnendad sice

Cancel Previoua m ish

Figure 2-8

Once the installation is complete, review the package list and make
sure that the selected packages are now listed as Installed in the
Status column. If any are listed as Not installed, make sure they are

selected and click on the Apply button again.



2.6 Installing the Android SDK Command-line Tools

Android Studio includes a set of tools that allow some tasks to be

performed from your operating system command line. To install these

tools on your system, open the SDK Manager, select the SDK Tools

tab and enable the Show Package Details option in the bottom left-

hand corner of the window. Next, scroll down the list of packages

and, when the Android SDK Command-line Tools (latest) package

comes into view,

~ Appedrance & Behavior
Appearance
Menus and Toolbars
Systern Settings
HTTP Froxy
Data Sharing
Date Formats
Updates
Prucess Elevation
Passwords
Memosy Settings
Notifications
Quick Lists
Path “ariables
Keyrmap
> Editor
> Build, Executicn, Deployment
Kotiin
» Tools
Advanced Settings

Layout Inspector

enable it as shown in Figure

Preferences

Appearance & Behavior @ System Sattings @ Android SOK Resat &

Manager for the Andraid SDK and Tools used by the IDE

Android SOK Logation:  fUsersfneilsmyth/Library/Androidfsdk Edit Optimize disk space
SDK Platforms SDK Tools SDK Update Sites

Below ara the availabla SDK developar tocls. Once installed, the IDE will automatically check far
updates. Check "show package details" to display available versions of an S0OK Tool.

Narne vergion Ztatus
EAVEARRS S -2 PV FAVAVRSE L D2s VAV INUL W sdil e
19.2.5345600 19.2.5345600 Mat installad
18.1.6063045 18.1.5063045 Mat instaltad
17.2.4988734 17.2.4988734 Mot installed
16.1.44 79459 1614479459 Mot installed

Android SDK Command-line Tools {latest) 10.0.0 rcd Irstallad
X Ardroid SDK Command-line Tools 9.0 Mot installed
Android 30K Cemmand-line Tools &0 Installed
Android 50K Cemmand-line Toals .0 Installed
Android 5DK Command-line Tools 5.0 Instalied
Android 50K Command-iine Tools 5.0 Installed
Android SDK Command-line Tools 44 Imstalled
Android 50K Cemmand-line Tools 3.0 Installed
Andrgid SOK Command-line Toals 2.1 Installed
Android SDK Command-line Tools 1.0 Installed
CMake
2220 3221 Mot installad
32181 2181 Mot installad
3.10.2.4938404 3.10.2 Mot installed

Hide Ohsolete Packages Show Package Details

n ts Cancel Apply “

Figure 2-9



After you have selected the command-line tools package, click on
Apply followed by OK to complete the installation. When the
installation completes, click Finish and close the SDK Manager

dialog.

For the operating system on which you are developing to be able to
find these tools, it will be necessary to add them to the system’s

PATH environment variable.

Regardless of your operating system, you will need to configure the
PATH environment variable to include the following paths (where
represents the file system location into which you installed the
Android SDK):

/sdk/cmdline-tools/latest/bin

[sdk/platform-tools

You can identify the location of the SDK on your system by
launching the SDK Manager and referring to the Android SDK field
located at the top of the settings panel, as highlighted in Eigure

Appearance & Behavior > System Settings > Android SDK

Manager for the Android SDK and Tao the
——

w._r -'_ o - -
Android SDK Locatior§ ,,.fUsersmeiIsmyth!l.ibrarw’Android!sdk

Edit Optimize disk space

SDK Platforms SDK Tools 50K Update Sites

Each Andrgoid SDK Platform package includes the Android platform and sources pertaining to
an APl level by default. Once installed, the IDE will automatically check for updates. Check
“show package details” to display individual SDK components.



Figure 2-10

Once the location of the SDK has been identified, the steps to add
this to the PATH variable are operating system dependent:



2.6.1 Windows 8.1

1. On the start screen, move the mouse to the bottom right-hand
corner of the screen and select Search from the resulting menu.
In the search box, enter Control Panel. When the Control Panel
icon appears in the results area, click on it to launch the tool on

the desktop.

2. Within the Control Panel, use the Category menu to change the
display to Large lcons. From the list of icons select the one

labeled System.

3. In the Environment Variables dialog, locate the Path variable in
the System variables list, select it and click on the Edit... button.
Using the New button in the edit dialog, add three new entries to
the path. For example, assuming the Android SDK was installed
into C:\Users\demo\AppData\Local\Android\Sdk, the following

entries would need to be added:

C:\Users\demo\AppData\Local\Android\Sdk\cmdline-tools\latest\bin

C:\Users\demo\AppData\Local\Android\Sdk\platform-tools

4. Click on OK in each dialog box and close the system

properties control panel.



Open a command prompt window by pressing Windows + R on
the keyboard and entering c¢md into the Run dialog. Within the

Command Prompt window, enter:

echo %Path%

The returned path variable value should include the paths to the
Android SDK platform tools folders. Verify that the platform-tools

value is correct by attempting to run the adb tool as follows:

adb

The tool should output a list of command-line options when

executed.

Similarly, check the tools path setting by attempting to run the
AVD Manager command-line tool (don’t worry if the avdmanager

tool reports a problem with Java - this will be addressed later):

avdmanager

If a message similar to the following message appears for one or
both of the commands, it is most likely that an incorrect path

was appended to the Path environment variable:

'adb' is not recognized as an internal or external command,



operable program or batch file.



2.6.2 Windows 10

Right-click on the Start menu, select Settings from the resulting
menu and enter “Edit the system environment variables” into the
Find a setting text field. In the System Properties dialog, click the
Environment Variables... button. Follow the steps outlined for

Windows 8.1 starting from step 3.



2.6.3 Windows 11

Right-click on the Start icon located in the taskbar and select
Settings from the resulting menu. When the Settings dialog
appears, scroll down the list of categories and select the “About”
option. In the About screen, select Advanced system settings from
the Related links section. When the System Properties window
appears, click on the Environment Variables... button. Follow the

steps outlined for Windows 8.1 starting from step 3.



2.6.4 Linux

On Linux, this configuration can typically be achieved by adding a
command to the .bashrc file in your home directory (specifics may
differ depending on the particular Linux distribution in use).

Assuming that the Android SDK bundle package was installed into

the export line in the .bashrc file would read as follows:

export PATH=/home/demo/Android/sdk/platform-
tools:/home/demo/Android/sdk/cmdline-
tools/latest/bin:/home/demo/android-studio/bin:$PATH

Note also that the above command adds the android-studio/bin
directory to the PATH variable. This will enable the studio.sh script
to be executed regardless of the current directory within a

terminal window.



2.6.5 macOS

Several techniques may be employed to modify the $PATH
environment variable on macOS. Arguably the cleanest method is
to add a new file in the /etc/paths.d directory containing the paths
to be added to $PATH. Assuming an Android SDK installation
location of the path may be configured by creating a new file
named android-sdk in the /etc/paths.d directory containing the

following lines:

/Users/demo/Library/Android/sdk/cmdline-tools/latest/bin

/Users/demo/Library/Android/sdk/platform-tools

Note that since this is a system directory it will be necessary to

use the sudo command when creating the file. For example:

sudo vi /etc/paths.d/android-sdk



2.7 Android Studio memory management

Android Studio is a large and complex software application that
consists of many background processes. Although Android Studio has
been criticized in the past for providing less than optimal
performance, Google has made significant performance improvements
in recent releases and continues to do so with each new version.
These improvements include allowing the user to configure the
amount of memory used by both the Android Studio IDE and the
background processes used to build and run apps. This allows the

software to take advantage of systems with larger amounts of RAM.

If you are running Android Studio on a system with sufficient unused
RAM to increase these values (this feature is only available on 64-bit
systems with 5GB or more of RAM) and find that Android Studio
performance appears to be degraded it may be worth experimenting
with these memory settings. Android Studio may also notify you that
performance can be increased via a dialog similar to the one shown

below:

e,

) Studio performance could be improved

Increasing the maximum heap size from 1280MB
to 2048MB could make the IDE perform better,
based on the available memory and your project
size.

Actions ¥ Don't show again



Figure 2-1

To view and modify the current memory configuration, select the File
-> Settings... Studio -> on macOS) menu option and, in the resulting
dialog, select Appearance & Behavior followed by the Memory Settings
option listed under System Settings in the left-hand navigation panel,

as illustrated in Figure 2-12 below.

When changing the memory allocation, be sure not to allocate more
memory than necessary or than your system can spare without

slowing down other processes.

Appearance & Behaviar  System Settings ' Memary Settings

' Appearance & Behavior Configure the maximum amount of RAM the S should allocate for Andreid Studio processes.
A such as the core I_DE or Gradle daemen, Similar to allocating toa little memaory, allocating too
much memory might degrade perfarmance.
Menus and Toolbars
¥ System Settings IDE Heap Size Sattings
HTTP Proxy

Data Sharing IDE max heap size: 1280 MB - current -

Date Formats This 1 @ Il EETING THIt dpokes T0 A HIONCTS ol OpEn ukng Androsd 5
robed 1 restart tha 1DE birive Sy Changes fm i fveap sz cake athecy

Updates
Process Elevation

Daaman Haap Size Sattings
Passwords P g

Android SDK These settings apply only to the aurrent project, and changes take affect anly after you rebuitd

Mumuty Sellings your project (by selecting Build = Rebuild Project fram the meny bar). After changing the heap

size and rabuilding your project. you may find dagmons with old settings and stop them manually.

File Colors

Scopes

Waotifications Gradle daermon max heap size: 2048 MB - current bt
Quick Lists

Path Variables Katlin dagmicn max hesp sine 2048 MB - current -

Figure 2-12

The IDE heap size setting adjusts the memory allocated to Android
Studio and applies regardless of the currently loaded project. On the



other hand, when a project is built and run from within Android
Studio, a number of

background processes (referred to as daemons) perform the task of
compiling and running the app. When compiling and running large
and complex projects, build time could be improved by adjusting the
daemon heap settings. Unlike the IDE heap settings, these daemon
settings apply only to the current project and can only be accessed
when a project is open in Android Studio. To display the SDK
Manager from within an open project, select the Tools -> SDK

Manager... menu option.



2.8 Updating Android Studio and the SDK

From time to time new versions of Android Studio and the
Android SDK are released. New versions of the SDK are installed
using the Android SDK Manager. Android Studio will typically

notify you when an update is ready to be installed.

To manually check for Android Studio updates, use the Help ->
Check for Updates... menu option from the Android Studio main
window Studio -> Check for Updates... on macQOS).



2.9 Summary

Before beginning the development of Android-based applications,
the first step is to set up a suitable development environment.
This consists of the Android SDKs and Android Studio IDE (which
also includes the Open)DK development environment). In this
chapter, we have covered the steps necessary to install these

packages on Windows, macOS, and Linux.



3. A Compose Project Overview

Now that we have installed Android Studio, the next step is to
create an Android app using Jetpack Compose. Although this
project will make use of several Compose features, it is an
intentionally simple example intended to provide an early
demonstration of Compose in action and an initial success on
which to build as you work through the remainder of the book.
The project will also serve to verify that your Android Studio

environment is correctly installed and configured.

This chapter will create a new project using the Android Studio
Compose project template and explore both the basic structure of
a Compose-based Android Studio project and some of the key
areas of Android Studio. In the next chapter, we will use this

project to create a simple Android app.

Both chapters will briefly explain key features of Compose as they
are introduced within the project. If anything is unclear when you
have completed the project, rest assured that all of the areas
covered in the tutorial will be explored in greater detail in later

chapters of the book.



3.1 About the project

The completed project will consist of two text components and a
slider. When the slider is moved, the current value will be
displayed on one of the text components, while the font size of
the second text instance will adjust to match the current slider
position. Once completed, the user interface for the app will

appear as shown in Figure
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Figure 3-1



3.2 Creating the project

The first step in building an app is to create a new project within
Android Studio. Begin, therefore, by launching Android Studio so that
the “Welcome to Android Studio” screen appears as illustrated in

Figure

@ @ Welcome to Android Studio
0 Android Studic
Flaming 22 2 1

- -
Customize Welcome to Android Studio
Plugins Create a new project to start from scratch
Learn Android Studio Or xisting project from disk or version control.
h p
MNew Project Cpen Get from VTS

More Actions v

Figure 3-2

Once this window appears, Android Studio is ready for a new project

to be created. To create the new project, click on the New Project



button to display the first screen of the New Project wizard.



3.3 Creating an activity

The next step is to define the type of initial activity that is to be
created for the application. The left-hand panel provides a list of
platform categories from which the Phone and Tablet option must be
selected. Although a range of different activity types is available when
developing Android applications, only the Empty Activity template
provides a pre-configured project ready to work with Compose. Select

this option before clicking on the Next button:

@ D New Project
r - .-, .S .- ‘
Phone and Tablet H ]
[ ]
Wear 0OS : ]
. i )
Android  eaeaeee
+
Automotive .
No Activity Empty Activity Basic Views Activity
(_

_-

Bottom Navigation Views Activity Empty Views Activity Navigation Drawer Views Activity

Cancel Previous m Finish

Figure 3-3



3.4 Defining the project and SDK settings

In the project configuration window set the Name field to The
application name is the name by which the application will be
referenced and identified within Android Studio and is also the name
that would be used if the completed application were to go on sale

in the Google Play store:

@ B Mew Project

Empty Activity
Create a new empty activity with Jetpack Compose

Name Cormposallemo
Package name  com.exampie.composedemo

Save location Tiyth{Oropbox/Documents/BooksfJetpack_Compose_1. 3fJetpackComposel3SamplesfComposelDemo

Minimum SCK | API 26 Android 8.0 (Orea)

© our app will run on approximately 90.7% of devices.
Help me choose

Cancel Previous N

Figure 3-4

The Package name is used to uniquely identify the application within

the Google Play app store application ecosystem. Although this can



be set to any string that uniquely identifies your app, it is
traditionally based on the reversed URL of your domain name
followed by the name of the application. For example, if your domain
is and the application has been named then the package name

might be specified as follows:

com.mycompany.composedemo

If you do not have a domain name you can enter any other string
into the Company Domain field, or you may use example.com for
testing, though this will need to be changed before an application

can be published:

com.example.composedemo

The Save location setting will default to a location in the folder
named AndroidStudioProjects located in your home directory and may
be changed by clicking on the folder icon to the right of the text

field containing the current path setting.

Set the minimum SDK setting to APl 26: Android 8.0 (Oreo). This is
the minimum SDK that will be used in most of the projects created
in this book unless a necessary feature is only available in a more
recent version. The objective here is to build an app using the latest
Android SDK, while also retaining compatibility with devices running
older versions of Android (in this case as far back as Android 8.0).
The text beneath the Minimum SDK setting will outline the

percentage of Android devices currently in use on which the app will


example.com

run. Click on the Help me choose link to see a full breakdown of the

various Android versions still in use:

ANDROID PLATFORM
VERSION

APT LEVEL

—Loliipop
Lollipap

Marshrmatlow

Nougat
Nougat

Last updated: January Sth, 2023

Click on the Finish button

Andraid PlatformyAP! Yersion Distribution

CUMULATIVE Oreo
DISTRIBUTION

System

Custom data stone
JobSehaduler impravements
Cached data

User Interface

Ficture-in-Ficture moda
Improved Motifications
Autofil fiamework
Dawrlpadable tonts
Mulli-disglay supparl
Adaptive lcons

Madia

ValumeShaper

Audio focus enhancements
Media metrics

MediaFlayer and MediaRecorder
improvements

Irproved nedia fils accees

Wiraless & Connectivity

Wi-Fi Aware
Bluetaoth updates
Companion davice pairing
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to create the project.
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3.5 Previewing the example project

At this point, Android Studio should have created a minimal example

application project and opened the main window.
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The newly created project and references to associated files are listed

in the Project tool window located on the left-hand side of the main

project window. The Project tool window has several modes in which

information can be displayed. By default, this panel should be in

Android mode. This setting is controlled by the menu at the top of

the panel as highlighted in Figure If the panel is not currently in

Android mode, use the menu to switch mode:



ComposeDemo app src main java com example

QI T v

Project

o' Proje

Packages
Project Files
Production xdemo
¢ Tests |
Project Source Files ’
Project Non-Source Files  *demo (androidlest)
Open Files xdemo (test)

o Scratches and Consoles

Figure 3-7

o> Resource Manager

The code for the main activity of the project (an activity corresponds
to a single user interface screen or module within an Android app)
is contained within the MainActivity.kt file located under app -> java -
> com.example.composedemo within the Project tool window as

indicated in Figure



& Android = @ E - % =

v G app
> manifests
™ java

™ com.example.composedemo

> ui.theme

> com.example.composedemo (androidTest)
> com.example.composedemo (test)
> res
> & Gradle Scripts

Figure 3-8

Double-click on this file to load it into the main code editor panel.
The editor can be used in different modes when writing code, the
most useful of which when working with Compose is Split mode.
The current mode can be changed using the buttons marked A in
Figure Split mode displays the code editor (B) alongside the Preview

panel (C) in which the current user interface design will appear:



¢ MainActivity kt

= Code =M Split B Design
package com.ebookfrenzy.composedemo Analyzing

yzing
import ...

e class MainActivity : ComponentActivity() {
o override fun onCreate(savedInstanceState: Bundle?) {

super.onCreate(savedInstanceState)

setContent {

ComposeDemoTheme {
/2 e s rfr

Surface(color = MaterialTheme.colors.backaround) {
Greeting( name: "Android")

: | d f
A successful build is needed before the preview can be
} F C J a I a D T 12 pr an
} Build & Refresh... (\C4GHR)
} e
@Composable e
fun Greeting(name: String) {

Text(text = "Hello $name!")

}

iew(showBackground = true)
able
0 fun DefaultPreview() {
ComposeDemoTheme

Greeting( name: "Android")

}

Figure 3-9

To get us started, Android Studio has already added some code to
the MainActivity.kt file to display a Text component configured to

display a message which reads “Hello Android”.

If the project has not yet been built, the Preview panel will display

the message shown in Figure

A successful build is needed before the preview can be displayed

Build & Refresh... (\{{#R)



Figure 3-10

If you see this notification, click on the Build & Refresh link to
rebuild the project. After the build is complete, the Preview panel

should update to display the user interface defined by the code in
the MainActivity.kt file:

Hello Android

Figure 3-11



3.6 Reviewing the main activity

Android applications are created by bringing together one or more
elements known as An activity is a single, standalone module of
application functionality that either correlates directly to a single user
interface screen and its corresponding functionality, or acts as a
container for a collection of related screens. An appointments
application might, for example, contain an activity screen that
displays appointments set up for the current day. The application
might also utilize a second activity consisting of multiple screens
where new appointments may be entered by the user and existing

appointments edited.

When we created the ComposeDemo project, Android Studio created
a single initial activity for our app, named it MainActivity, and
generated some code for it in the MainActivity.kt file. This activity
contains the first screen that will be displayed when the app is run
on a device. Before we modify the code for our requirements in the
next chapter, it is worth taking some time to review the code

currently contained within the MainActivity.kt file.

The file begins with the following line (keep in mind that this may

be different if you used your own domain name instead of

package com.example.composedemo

This tells the build system that the classes and functions declared in

this file belong to the com.example.composedemo package which we



configured when we created the project.

Next are a series of import directives. The Android SDK is comprised

of a vast collection of libraries that provide the foundation for

building Android apps. If all of these libraries were included within

an app the resulting app bundle would be too large to run efficiently

on a mobile device. To avoid this problem an app only imports the

libraries that it needs to be able to run:

import

import

import

import

import

import

import

android.os.Bundle

androidx.activity. ComponentActivity

androidx.activity.compose.setContent

androidx.compose.foundation.layout.fillMaxSize

androidx.compose.material3.MaterialTheme

androidx.compose.material3.Surface

androidx.compose.material3.Text



Initially, the list of import directives will most likely be “folded” to
save space. To unfold the list, click on the small “+” button

indicated by the arrow in Eigure 3:12 below:

package com.ebookfrenzy.composedemo

import

>4

— class MainActivity : ComponentActivity() {
Figure 3-12

The MainActivity class is then declared as a subclass of the Android

ComponentActivity class:

class MainActivity : ComponentActivity() {

The MainActivity class implements a single method in the form of
This is the first method that is called when an activity is launched
by the Android runtime system and is an artifact of the way apps
used to be developed before the introduction of Compose. The

onCreate() method is used here to provide a bridge between the



containing activity and the Compose-based user interfaces that are to

appear within it:

override fun onCreate(savedInstanceState: Bundle?) {

super.onCreate(savedInstanceState)

setContent {

ComposeDemoTheme {

The method declares that the content of the activity’s user interface
will be provided by a composable function named This composable
function is declared in the Theme.kt file located under the app ->
name> -> ui.theme folder in the Project tool window. This, along with
the other files in the ui.theme folder defines the colors, fonts, and
shapes to be used by the activity and provides a central location
from which to customize the overall theme of the app’s user

interface.



The call to the ComposeDemoTheme composable function is
configured to contain a Surface composable. Surface is a built-in
Compose component designed to provide a background for other

composables:

ComposeDemoTheme {

/| A surface container using the 'background' color from the

theme

Surface(

modifier = Modifier.fillMaxSize(),

color = MaterialTheme.colorScheme.background

In this case, the Surface component is configured to fill the entire
screen and with the background set to the standard background color
defined by the Android Material Design theme. Material Design is a
set of design guidelines developed by Google to provide a consistent

look and feel across all Android apps. It includes a theme (including



fonts and colors), a set of user interface components (such as
button, text, and a range of text fields), icons, and generally defines

how an Android app should look, behave and respond to user

interactions.

Finally, the Surface is configured to contain a composable function

named Greeting which is passed a string value that reads “Android™:

ComposeDemoTheme {

/| A surface container using the 'background' color from the

theme
Surface(
modifier = Modifier.filMaxSize(),
color = MaterialTheme.colorScheme.background
) 1

Greeting("Android")



Outside of the scope of the MainActivity class, we encounter our
first composable function declaration within the activity. The function
is named Greeting and is, unsurprisingly, marked as being

composable by the @Composable annotation:

@Composable

fun Greeting(name: String, modifier: Modifier = Modifier) {

Text(

text = "Hello $namel!",

modifier = modifier

The function accepts a String parameter (labeled and calls the built-
in Text composable, passing through a string value containing the
word “Hello” concatenated with the name parameter. The function
also accepts an optional modifier parameter (a topic covered in the

chapter titled “Using_Modifiers in As will soon become evident as you

work through the book, composable functions are the fundamental

building blocks for developing Android apps using Compose.

The second composable function declared in the MainActivity.kt file

reads as follows:



@ Preview(showBackground = true)

@Composable

fun GreetingPreview() {

ComposeDemoTheme {

Greeting("Android")

Earlier in the chapter, we looked at how the Preview panel allows us
to see how the user interface will appear without having to compile
and run the app. At first glance, it would be easy to assume that
the preview rendering is generated by the code in the onCreate()
method. In fact, that method only gets called when the app runs on
a device or emulator. Previews are generated by preview composable
functions. The @ Preview annotation associated with the function tells
Android Studio that this is a preview function and that the content
emitted by the function is to be displayed in the Preview panel. As
we will see later in the book, a single activity can contain multiple
preview composable functions configured to preview specific sections

of a user interface using different data values.



In addition, each preview may be configured by passing parameters
to the @Preview annotation. For example, to view the preview with
the rest of the standard Android screen decorations, modify the

preview annotation so that it reads as follows:

Once the preview has been updated, it should now be rendered as

shown in Figure



13:00 -
Hello Android!

Figure 3-13



3.7 Preview updates

One final point worth noting is that the Preview panel is live and
will automatically reflect minor changes made to the composable
functions that make up a preview. To see this in action, edit the call
to the Greeting function in the GreetingPreview() preview composable
function to change the name from “Android” to “Compose”. Note
that as you make the change in the code editor, it is reflected in the

preview.

More significant changes will require a build and refresh before being
reflected in the preview. When this is required, Android Studio will
display the following “Out of date” notice at the top of the Preview
panel and a Build & Refresh button (indicated by the arrow in Figure

= @ Out of date

Figure 3-14

Simply click on the button to update the preview for the latest
changes. Occasionally, Android Studio will fail to update the preview
after code changes. If you believe that the preview no longer

matches your code, hover the mouse pointer over the Up-to-date



status text and select Build & Refresh from the resulting menu, as

illustrated in Eigure

* (@

= Code =l Split BN Design E

=

Up-to-date ¢ ;

The preview is up to date : E
Build & Refresh (X< $R) / £
=

)

Figure 3-15

The Preview panel also includes an interactive mode that allows you
to trigger events on the user interface components (for example
clicking buttons, moving sliders, scrolling through lists, etc.). Since
ComposeDemo contains only an inanimate Text component at this

stage, it makes more sense to introduce interactive mode in the next

chapter.



3.8 Bill of Materials and the Compose version

Although Jetpack Compose and Android Studio appear to be tightly
integrated, they are two separate products developed by different
teams at Google. As a result, there is no guarantee that the most
recent Android Studio version will default to using the latest version
of Jetpack Compose. It can, therefore, be helpful to know which
version of Jetpack Compose is being used by Android Studio. This is
declared in a Bill of Materials setting within the build configuration
files of your Android Studio projects.

To identify the BOM for a project, locate the Gradle Scripts ->
build.gradle (Module: app) file (highlighted in the figure below) and

double-click on it to load it into the editor:



= Android )

[0l
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e

v L. app
> manifests

N java
v L0 com.example.composedemo
> ui.theme
+ MainActivity.kt
> com.example.composedemo (androidTest)
> [ com.example.composedemo (test)

= res (generated)
v & Gradle Scripts

' uard Rules for ":app")
i1 aradle.properties (Project Properties)

1 gradle-wrapper.properties (Gradle Version)

Figure 3-16

With the file loaded into the editor, locate the compose-bom entry in

the dependencies section:

dependencies {



implementation

In the above example, we can see that the project is using BOM
2022.10.00. With this information, we can use the BOM to library
version mapping web page at the following URL to identify the library

versions being used to build our app:

https: //developer.android.com /jgtpack /compose /bom /bom-mapping

Once the web page has loaded, select the BOM version from the
menu highlighted in Figure 3-17_below. For example, the figure shows

that BOM 2022.10.00 uses version 1.3.2 of the Compose libraries:

BOM to library version mapping - -

Library group BOM Versions
androidx compose. animationanimation 1.3.2
androidx.compose.animation:animation-core 1.3.2
andreidx. compose. animationanimation-graphics 1.3.2

androidx. compose. foundation foundation 1.3.2


https://developer.android.com/j
androidx.com

Figure 3-17

The BOM does not currently define the versions of all the
dependencies listed in the build file. Therefore, you will see some
library dependencies in the build.gradle file that include a specific

version number, as is the case with the core-ktx and lifecycle-runtime-

ktx libraries:
dependencies {
implementation

implementation

You can add specific version numbers to any libraries you add to the
dependencies, though it is recommended to rely on the BOM
settings whenever possible to ensure library compatibility. However, a
version number declaration will be required when adding libraries not
listed in the BOM. You can also override the BOM version of a
library by appending a version number to the declaration. The
following declaration, for example, overrides the version number in

the BOM for the compose.ui library:

implementation



3.9 Summary

In this chapter, we have created a new project using Android
Studio’s Empty Activity template and explored some of the code
automatically generated for the project. We have also introduced
several features of Android Studio designed to make app
development with Compose easier. The most useful features, and
the places where you will spend most of your time while

developing Android apps, are the code editor and Preview panel.

While the default code in the MainActivity.kt file provides an
interesting example of a basic user interface, it bears no
resemblance to the app we want to create. In the next chapter,
we will modify and extend the app by removing some of the

template code and writing our own composable functions.



4. An Example Compose Project

In the previous chapter, we created a new Compose-based Android
Studio project named ComposeDemo and took some time to
explore both Android Studio and some of the project code that it
generated to get us started. With those basic steps covered, this
chapter will use the ComposeDemo project as the basis for a new
app. This will involve the creation of new composable functions,
introduce the concept of state, and make use of the Preview
panel in interactive mode. As with the preceding chapter, key
concepts explained in basic terms here will be covered in

significantly greater detail in later chapters.



4.1 Getting started

Start Android Studio if it is not already running and open the
ComposeDemo project created in the previous chapter. Once the
project has loaded, double-click on the MainActivity.kt file (located
in Project tool window under app -> java -> to open it in the
code editor. If necessary, switch the editor into Split mode so that

both the editor and Preview panel are visible.



4.2 Removing the template Code

Within the MainActivity.kt file, delete some of the template code

so that the file reads as follows:

package com.example.composedemo

class MainActivity : ComponentActivity() {
override fun onCreate(savedinstanceState: Bundle?) {
super.onCreate(savedInstanceState)
setContent {
ComposeDemoTheme {
Surface(

modifier = Modifier.filMaxSize(),



color =

MaterialTheme.colorScheme.background

) {

Greeting("Android")

@Composable

fun Greeting(name: String, modifier: Modifier = Modifier) {

Text(

text = "Hello $namel",

modifier = modifier



@Preview(showSystemUi = true)

@Composable

fun GreetingPreview() {

ComposeDemoTheme {

Greeting("Android")



4.3 The Composable hierarchy

Before we write the composable functions that will make up our user
interface, it helps to visualize the relationships between these
components. The ability of one composable to call other
composables essentially allows us to build a hierarchy tree of
components. Once completed, the composable hierarchy for our

ComposeDemo main activity can be represented as shown in Figure

ComponentActivity

‘ ComposeDemoTheme |
Surface
DemoScreen
Column
I
| | | |
‘ DemoText ‘ ‘ Spacer ‘ ‘ DemosSlider | [ Text
‘ Text ‘ ‘ Slider |
Figure 4-1

All of the elements in the above diagram, except for
ComponentActivity, are composable functions. Of those functions, the
Surface, Column, Spacer, Text, and Slider functions are built-in
composables provided by Compose. The DemoScreen, DemoText, and

DemoSlider composables, on the other hand, are functions that we



will create to provide both structure to the design and the custom
functionality we require for our app. You can find the

ComposeDemoTheme composable declaration in the ui.theme ->
Theme.kt file.



4.4 Adding the DemoText composable

We are now going to add a new composable function to the activity
to represent the DemoText item in the hierarchy tree. The purpose of
this composable is to display a text string using a font size value
that adjusts in real-time as the slider moves. Place the cursor
beneath the final closing brace (}) of the MainActivity declaration and

add the following function declaration:

@Composable

fun DemoText() {

The @Composable annotation notifies the build system that this is a
composable function. When the function is called, the plan is for it

to be passed both a text string and the font size at which that text
is to be displayed. This means that we need to add some

parameters to the function:

@Composable

fun String, fontSize: {



The next step is to make sure the text is displayed. To achieve this,
we will make a call to the built-in Text composable, passing through
as parameters the message string, font size and, to make the text

more prominent, a bold font weight setting:

@Composable

fun DemoText(message: String, fontSize: Float) {

Text(
text = message,
fontSize = fontSize.sp,
fontWeight = FontWeight.Bold
)

Note that after making these changes, the code editor indicates that
“sp” and are undefined. This happens because these are defined and
implemented in libraries that have not yet been imported into the
MainActivity.kt file. One way to resolve this is to click on an
undefined declaration so that it highlights as shown below, and then
press Alt+Enter (Opt+Enter on macOS) on the keyboard to import

the missing library automatically:



@Composable
fun De t(message: String, fontSize: Float) {
Text(

androidx.compose.uitext.font.FontWeight? 0 &

TUITCIILIZLZE = Ty /LILLG .S,

fontWeight = FontWeight.Bold

Figure 4-2

Alternatively, you may add the missing import statements manually to

the list at the top of the file:

import androidx.compose.ui.text.font.FontWeight

import androidx.compose.ui.unit.sp

In the remainder of this book, all code examples will include any

required library import statements.



We have now finished writing our first composable function. Notice
that, except for the font weight, all the other properties are passed
to the function when it is called (a function that calls another

function is generally referred to as the This increases the flexibility,
and therefore re-usability, of the DemoText composable and is a key

goal to keep in mind when writing composable functions.



4.5 Previewing the DemoText composable

At this point, the Preview panel will most likely be displaying a
message which reads “No preview found”. The reason for this is that
our MainActivity.kt file does not contain any composable functions
prefixed with the @Preview annotation. Add a preview composable

function for DemoText to the MainActivity.kt file as follows:

@ Preview

@Composable

fun DemoTextPreview() {

ComposeDemoTheme() {

DemoText(message = "Welcome to Android", fontSize = 12f)

After adding the preview composable, the Preview panel should have
detected the change and displayed the link to build and refresh the
preview rendering. Click the link and wait for the rebuild to
complete, at which point the DemoText composable should appear as

shown in Eigure



L
Welcome to Android

Figure 4-3

Minor changes made to the code in the MainActivity.kt file such as
changing values will be instantly reflected in the preview without the
need to build and refresh. For example, change the “Welcome to
Android” text literal to “Welcome to Compose” and note that the text
in the Preview panel changes as you type. Similarly, increasing the
font size literal will instantly change the size of the text in the

preview. This feature is referred to as Live Edit.



4.6 Adding the DemoSlider composable

The DemoSlider composable is a little more complicated than
DemoText. It will need to be passed a variable containing the
current slider position and an event handler function or lambda to
call when the slider is moved by the user so that the new
position can be stored and passed to the two Text composables.

With these requirements in mind, add the function as follows:

import androidx.compose.foundation.layout.*

import androidx.compose.material3.Slider

import androidx.compose.ui.unit.dp

@Composable



fun DemosSlider(sliderPosition: Float, onPositionChange: (Float) ->
Unit ) {

Slider(

modifier = Modifier.padding(10.dp),

valueRange = 20f..38f,

value = sliderPosition,

onValueChange = { onPositionChange(it) }

The DemoSlider declaration contains a single Slider composable
which is, in turn, passed four parameters. The first is a Modifier
instance configured to add padding space around the slider.
Modifier is a Kotlin class built into Compose which allows a wide
range of properties to be set on a composable within a single
object. Modifiers can also be created and customized in one
composable before being passed to other composables where they

can be further modified before being applied.



The second value passed to the Slider is a range allowed for the
slider value (in this case the slider is limited to values between

20 and 38).

The next parameter sets the value of the slider to the position
passed through by the caller. This ensures that each time

DemoSlider is recomposed it retains the last position value.

Finally, we set the onValueChange parameter of the Slider to call
the function or lambda we will be passing to the DemoSlider
composable when we call it later. Each time the slider position
changes, the call will be made and passed the current value
which we can access via the Kotlin it keyword. We can further
simplify this by assigning just the event handler parameter name
and leaving the compiler to handle the passing of the current

value for us:

onValueChange = onPositionChange



4.7 Adding the DemoScreen composable

The next step in our project is to add the DemoScreen
composable. This will contain a variable named sliderPosition in
which to store the current slider position and the implementation
of the handlePositionChange event handler to be passed to the
DemoSlider. This lambda will be responsible for storing the
current position in the sliderPosition variable each time it is called
with an updated value. Finally, DemoScreen will contain a Column
composable configured to display the DemoText, Spacer,
DemoSlider and the second, as yet to be added, Text composable

in a vertical arrangement.

Start by adding the DemoScreen function as follows:

import androidx.compose.runtime.*

@Composable



fun DemoScreen() {

var sliderPosition by remember { mutableStateOf{20f) }

val handlePositionChange = { position : Float ->

sliderPosition = position

The sliderPosition variable declaration requires some explanation. As
we will learn later, the Compose system repeatedly and rapidly
recomposes user interface layouts in response to data changes. The
change of slider position will, therefore, cause DemoScreen to be
recomposed along with all of the composables it calls. Consider if
we had declared and initialized our sliderPosition variable as

follows:

var sliderPosition = 20f

Suppose the user slides the slider to position 21. The
handlePositionChange event handler is called and stores the new

value in the sliderPosition variable as follows:



val handlePositionChange = { position : Float >

sliderPosition = position

The Compose runtime system detects this data change and
recomposes the user interface, including a call to the DemoScreen
function. This will, in turn, reinitialize the sliderposition target state
causing the previous value of 21 to be lost. Declaring the
sliderPosition variable in this way informs Compose that the current

value needs to be remembered during recompositions:

var sliderPosition by remember { mutableStateOf(20f) }

The only remaining work within the DemoScreen implementation

is to add a Column containing the required composable functions:

import androidx.compose.ui.Alignment



@Composable

fun DemoScreen() {

var sliderPosition by remember { mutableStateOf(20f) }

val handlePositionChange = { position : Float >

sliderPosition = position

}
Column(
horizontalAlignment = Alignment.CenterHorizontally,
verticalArrangement = Arrangement.Center,
modifier = Modifier.fillMaxSize()
) {

DemoText(message = "Welcome to Compose", fontSize =

sliderPosition)



Spacer(modifier = Modifier.height(150.dp))

DemoSlider(

sliderPosition = sliderPosition,

onPositionChange = handlePositionChange

Text(

style = MaterialTheme.typography.headlineMedium,

text = sliderPosition.tolnt().toString() + "sp"

Points to note regarding these changes may be summarized as

follows:



«When DemoSlider is called, it is passed a reference to our
handlePositionChange event handler as the onPositionChange

parameter.

«The Column composable accepts parameters that customize
layout behavior. In this case, we have configured the column to

center its children both horizontally and vertically.

«A Modifier has been passed to the Spacer to place a 150dp

vertical space between the DemoText and DemoSlider components.

«The second Text composable is configured to use the
headlineMedium style of the Material theme. In addition, the
sliderPosition value is converted from a Float to an integer so that
only whole numbers are displayed and then converted to a string

value before being displayed to the user.



4.8 Previewing the DemoScreen composable

To confirm that the DemoScreen layout meets our expectations,

we need to modify the DemoTextPreview composable:

= true)

@Composable

fun DemoTextPreview() {

ComposeDemoTheme {

DemoScreen()

Note that we have enabled the showSystemUi property of the

preview so that we will experience how the app will look when



running on an Android device.

After performing a preview rebuild and refresh, the user interface

should appear as originally shown in Eigure



4.9 Adjusting preview settings

The showSystemUi preview property is only one of many preview
configuration options provided by Android Studio. In addition,
properties are available to change configuration settings, such as the
device type, screen size, orientation, APl level, and locale. To access
these configuration settings, click on the settings button located in
the gutter to the left of the @Preview line in the code editor, as

shown in Figure

\xi“%;ieview(showSystemUi = true)

@Composable
Lb fun DemoTextPreview() {
ComposeDemoTheme A{
DemoScreen()

Figure 4-4

When the button is clicked, the panel shown in Eigure 4-5_will

appear, from which the full range of preview configuration settings is

available:
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4.10 Testing in interactive mode

At this stage, we know that the user interface layout for our activity
looks how we want it to, but we don’t know if it will behave as
intended. One option is to run the app on an emulator or physical
device (topics covered in later chapters). A quicker option, however,
is to switch the preview panel into interactive mode. To start
interactive mode, hover the mouse pointer over the area above the
preview canvas so that the two buttons shown in Figure 4-6 appear

and click on the left-most button:

DemoTextPreview RO

13:00 vi

Figure 4-6

When clicked, there will be a short delay when interactive mode
starts, after which it should be possible to move the slider and

watch the two Text components update:
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Figure 4-7

Click the button (highlighted in Eigure 4-8 below) to exit interactive

mode:

% Live Edit of literals: ON +~ = Code =M Split B Design

M Stop Interactive Mode Up-to-date ¢

N




Figure 4-8



4.11 Completing the project

The final step is to make sure that the DemoScreen composable
is called from within the Surface function located in the onCreate()

method of the MainActivity class. Locate this method and modify
it as follows:

class MainActivity : ComponentActivity() {
override fun onCreate(savedinstanceState: Bundle?) {
super.onCreate(savedInstanceState)
setContent {
ComposeDemoTheme {
Surface(

modifier = Modifier.filMaxSize(),



color =

MaterialTheme.colorScheme.background

) {

DemoScreen()

This will ensure that, in addition to appearing in the preview
panel, our user interface will also be displayed when the app runs
on a device or emulator (a topic that will be covered in later

chapters).



4.12 Summary

In this chapter, we have extended our ComposeDemo project to
include some additional user interface elements in the form of
two Text composables, a Spacer, and a Slider. These components
were arranged vertically using a Column composable. We also
introduced the concept of mutable state variables and explained
how they are used to ensure that the app remembers state when
the Compose runtime performs recompositions. The example also
demonstrated how to use event handlers to respond to user
interaction (in this case, the user moving a slider). Finally, we
made use of the Preview panel in interactive mode to test the
app without the need to compile and run it on an emulator or

physical device.



5. Creating an Android Virtual Device (AVD) in Android Studio

Although the Android Studio Preview panel allows us to see the
layout we are desighing and test basic functionality using
interactive mode, it be will necessary to compile and run an
entire app to fully test that it works. An Android application may
be tested by installing and running it either on a physical device
or in an Android Virtual Device (AVD) emulator environment.
Before an AVD can be used, it must first be created and
configured to match the specifications of a particular device
model. In this chapter, we will work through the creation of such

a virtual device using the Pixel 4a phone as a reference example,



5.1 About Android Virtual Devices

AVDs are essentially emulators that allow Android applications to be
tested without the necessity to install the application on a physical
Android-based device. An AVD may be configured to emulate a
variety of hardware features including options such as screen size,
memory capacity, and the presence or otherwise of features such as
a camera, GPS navigation support, or an accelerometer. As part of
the standard Android Studio installation, several emulator templates
are installed allowing AVDs to be configured for a range of different
devices. Custom configurations may be created to match any physical
Android device by specifying properties such as processor type,

memory capacity, and the size and pixel density of the screen.

An AVD session can appear either as a separate window or
embedded within the Android Studio window.

New AVDs are created and managed using the Android Virtual
Device which may be used either in command-line mode or with a
more user-friendly graphical user interface. To create a new the first
step is to launch the AVD Manager. This can be achieved from
within the Android Studio environment by selecting the Tools ->

Device Manager menu option from within the main window.

Once launched, the manager will appear as a tool window as shown

in Eigure
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Create device ?
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Create virtual device

Figure 5-1

To add a new AVD, begin by making sure that the Virtual tab is
selected before clicking on the Create device button to open the

Virtual Device Configuration
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Within the dialog, perform the following steps to create a Pixel 4a

compatible emulator:

1. From the Category panel, select the Phone option to display the
list of available Android phone AVD templates.

2. Select the Pixel 4a device option and click

3. On the System Image screen, select the latest version of Android.
Note that if the system image has not yet been installed a Download
link will be provided next to the Release Name. Click this link to
download and install the system image before selecting it. If the

image you need is not listed, click on the x86 Images (or ARM



images if you are running a Mac with Apple Silicon) and Other

images tabs to view alternative lists.

4. Click Next to proceed and enter a descriptive name (for example

Pixel 4a API into the name field or simply accept the default name.

5. Click Finish to create the AVD.

6. With the AVD created, the Device Manager may now be closed. If
future modifications to the AVD are necessary, simply re-open the
Device Manager, select the AVD from the list, and click on the pencil

icon in the Actions column to edit the settings.



5.2 Starting the emulator

To perform a test run of the newly created AVD emulator, simply
select the emulator from the Device Manager and click on the

launch button (the triangle in the Actions column). The emulator will
appear embedded into the main Android Studio window and begin
the startup process. The amount of time it takes for the emulator to
start will depend on the configuration of both the AVD and the

system on which it is running:

| ] ] ComposeDemo — MainActivity.kt [ComposeDemo.app]
app src  main  java ©om  example  composedema MainActivity. kt s App * , Pixeld API 32 [ 5 ™Mo & [l &
2 hzirhotivity: kt Emulator: o Pixel 4 API 32
e
& = Code MSplit MOesiogn O s % D) (0 « @# @ @ D
[ ™ -
3 import com. example.compasedeso.vi. these ComposelemoTheme
=
2
g class MainActivity : Componentdctivity(} |
g 2] override fun onCreste(savedInstanceState: Bundle?) {
= super.anCreate(savedInstanceState)
setlentant {
m L {
(
Hodifier FiilMaxSize(),
HaterialThese.colors . backaround
¥ A
QO
g y
3 ¥
)
o ¥
+
£ }
%
2
]
- fon OemoScreen() {
i
2 var sliderPosition by ber { mutsbleStote0f( 28€) }
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Figure 5-3

To hide and show the emulator tool window, click on the Emulator

o.n

tool window button (marked A above). Click on the “x” close button
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next to the tab (B) to exit the emulator. The emulator tool window
can accommodate multiple emulator sessions, with each session
represented by a tab. Figure for example, shows a tool window with

two emulator sessions:

Running Devices: Pixel 4 API 33 s Resizable AP133 - 0

Q@ I0 « ¢ m @ D ¢

Figure 5-4

To switch between sessions, simply click on the corresponding tab.

Although the emulator probably defaulted to appearing in portrait
orientation, this and other default options can be changed. Within
the Device Manager, select the new Pixel 4a entry and click on the
pencil icon in the Actions column of the device row. In the
configuration screen, locate the Startup orientation section and change
the orientation setting. Exit and restart the emulator session to see
this change take effect. More details on the emulator are covered in
the next gnd Configuring_the Android Studio AVD

To save time in the next section of this chapter, leave the emulator

running before proceeding.



5.3 Running the application in the AVD

With an AVD emulator configured, the example ComposeDemo
application created in the earlier chapter now can be compiled and
run. With the ComposeDemo project loaded into Android Studio,
make sure that the newly created Pixel 4a AVD is displayed in the
device menu (marked A in Eigure 5.5_below), then either click on the
run button represented by a green triangle (B), select the Run ->

Run ‘app’ menu option or use the Ctrl-R keyboard shortcut:

app ¥ L Pixel 4aAPI33 v P £ (7

Figure 5-5

The device menu (A) may be used to select a different AVD instance
or physical device as the run target, and also to run the app on
multiple devices. The menu also provides access to the Device

Manager as well as device connection configuration and

troubleshooting options:
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Running devices

"1 Pixel 4a API 33 !
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(L Pixel 4 API 32
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Select Multiple Devices...
Pair Devices Using Wi-Fi

2 )

Device Manager

Troubleshoot Device Connections

Figure 5-6

The app can also be run on the currently selected target by clicking
on the icon in the editor gutter next to the preview composable

declaration as indicated by the arrow in Figure



90 B @Preview(showSystemUi = true)
@Composable
L. fun DemoTextPreview() {
ComposeDemoTheme {
DemoScreen()

Figure 5-7

Once the application is installed and running, the user interface
layout defined by the MainScreen function will appear within the

emulator:



457 & © Lo

Welcome to Compose




Figure 5-8

If the activity does not automatically launch, check to see if the
launch icon has appeared among the apps on the emulator. If it has,
simply click on it to launch the application. Once the run process
begins, the Run tool window will become available. The Run tool
window will display diagnostic information as the application package
is installed and launched. Figure s5-9_shows the Run tool window

output from a successful application launch:

]
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0P \ BRP g -
@8/21 1@:317:5@: Launching 'app® on Paxel 4 API 2A.
Inztalt successfully fanished in 1 5 529 ms.
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, Capturing and displaying loqat messages from application. This befavior can be disabled in the “Logcat output” sectinn of the “Debugger” settings page.
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DftletworkSecurityConfig: Mg Network Security Config specified, using platform defaulr
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Figure 5-9

If problems are encountered during the launch process, the Run tool
window will provide information that will hopefully help to isolate the

cause of the problem.

Assuming that the application loads into the emulator and runs as
expected, we have safely verified that the Android development

environment is correctly installed and configured.



5.4 Real-time updates with Live Edit

With the app running, now is an excellent time to introduce the
Live Edit feature. Like interactive mode in the Preview panel, Live
Edit updates the appearance and behavior of the app running on
the device or emulator as changes are made to the code. This
feature allows code changes to be tested in real time without
having to build and re-run the project. Try out Live Edit by
changing the text displayed by the DemoText composable as

follows:

DemoText(message = is Compose fontSize = sliderPosition)

With each keystroke, the text in the running app will update to
reflect the change. Live Edit is currently limited to changes made
within the body of existing functions. It will not, for example,

handle the addition, removal, or renaming of functions.



5.5 Running on multiple devices

The run menu shown in Eigure 5-6 above includes an option to run
the app on multiple emulators and devices in parallel. When
selected, this option displays the dialog shown in Figure 5-10
providing a list of both the AVDs configured on the system and any
attached physical devices. Enable the checkboxes next to the

emulators or devices to be targeted before clicking on the Run
button:

@ & Run on Multiple Devices
Available devices

Type Device

5 Pixel 4 API 30

8 Foldable API 30

<
0

(V] L Pixel 3a API 29

Cancel m

Figure 5-10

After the Run button is clicked, Android Studio will launch the app

on the selected emulators and devices.



5.6 Stopping a running application

To stop a running application, simply click on the stop button

located in the main toolbar as shown in Eigure

Y , app v LPixelda APIZ0 » (& X 5 & & E @R Lle e OQ
app
’ Stop 'app' #F2
Figure 5-1

An app may also be terminated using the Run tool window. Begin by
displaying the Run tool window using the window bar button that

becomes available when the app is running as illustrated in Figure

3
om
aml

i= TODO [P Version Control » Run @ Problems B Terminal

Il Launch succeeded (2 minutes ago)
Figure 5-12

Once the Run tool window appears, click the stop button highlighted

in Figure 5-13_below:
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Figure 5-13



5.7 Supporting dark theme

Android 10 introduced the much-awaited dark theme, support for
which is enabled by default in Android Studio Compose-based app
projects. To test dark theme in the AVD emulator, open the Settings
app within the running Android instance in the emulator. Within the
Settings app, choose the Display category and enable the Dark theme
option as shown in Figure 5-14_so that the screen background turns

black:

Appearance

Dark theme
Will never turn off automatically

Figure 5-14

With dark theme enabled, run the ComposeDemo app and note that
it appears using a dark theme including a black background and a

purple background color on the button as shown in Figure
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Figure 5-15

Return to the Settings app and turn off Dark theme mode before

continuing.



5.8 Running the emulator in a separate window

So far in this chapter, we have only used the emulator as a tool
window embedded within the main Android Studio window. To run
the emulator in a separate window, select the File -> Settings... menu
option Studio -> Preferences... on macOS), navigate to Tools ->
Emulator in the left-hand navigation panel of the preferences dialog,

and disable the Launch in a tool window option:

Tools * Emulator -

4 Launch in a tool window 3

Appearance & Behavior
> System Setiings

Fite Colors

Scopes

MNotifications &4 Enable clipboard sharing
Quick Lists

@ show camera caontrol prompts
Path Variables

Velocity control keys for virtual scene camera:
Keymagp

> Editer WASDQE (for QWERTY keyboard) -

Plugins

. When encountering snapshots incompatible with the current configuration:
> Wersion Centrol e 2 # 2

» Build, Execution, Deployment Ask before deleting -

» Languages & Frameworks

Figure 5-16

With the option disabled, click the Apply button followed by OK to
commit the change, then exit the current emulator session by
clicking on the close button on the tab marked B in Eigure 5-3

above.

Run the sample app once again, at which point the emulator will

appear as a separate window as shown below:
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Figure 5-17

The choice of standalone or tool window mode is a matter of
personal preference. If you prefer the emulator running in a tool
window, return to the settings screen and re-enable the Launch in a
tool window option. Before committing to standalone mode, however,
keep in mind that the emulator tool window may also be detached
from the main Android Studio window by clicking on the settings
button (represented by the gear icon) in the tool emulator toolbar

and selecting the View Mode -> Float menu option:

Emulator: 5 Pixel 4 API 32 X — =
v Show Zoom Controls

v Show Device Frame
v Show Toolbar

O 0 « @8 B9

10:59 & © View Mode 9 v Dock Pinned
Move to b Dock Unpinned
Resize > Undock
Remove from Sidebar m
I = Window

Figure 5-18



5.9 Enabling the device frame

The emulator can be configured to appear with or without the device
frame To change the setting, open the Device Manager, select the
AVD from the list, and click on the pencil icon in the Actions
column to edit the settings. In the settings screen, locate and

change the Enable Device Frame option:

Verify Configuration
AVD Name  Pixel 4 API 32
L) Pixel 4 5.7 1080x2280 xxhdpi

Android API 32 arm64-v8a

Startup orientation D
Portrait Landscape

Emulated
Performance

Graphics:

Device Fra

Figure 5-19



5.10 Summary

A typical application development process follows a cycle of
coding, compiling, and running in a test environment. Android
applications may be tested on either a physical Android device or
using an Android Virtual Device (AVD) emulator. AVDs are created
and managed using the Android Studio Device Manager tool.
When creating an AVD to simulate a specific Android device
model, the virtual device should be configured with a hardware

specification matching that of the physical device.

The AVD emulator session may be displayed as a standalone

window or embedded into the main Android Studio user interface.



6. Using and Configuring the Android Studio AVD Emulator

Before the next chapter explores testing on physical Android
devices, this chapter will take some time to provide an overview
of the Android Studio AVD emulator and highlight many of the
configuration features that are available to customize the

environment in both standalone and tool window modes.



6.1 The Emulator Environment

When launched in standalone mode, the emulator displays an
initial splash screen during the loading process. Once loaded, the
main emulator window appears containing a representation of the
chosen device type (in the case of Figure 6-1 this is a Pixel 4

device):



Andraid Emulator - Pixel_4_API_32:5554

Play Store Photos YouTube

. B




Figure 6-1

Positioned along the right-hand edge of the window is the toolbar
providing quick access to the emulator controls and configuration

options.



6.2 Emulator Toolbar Options

The emulator toolbar provides access to a range of options
relating to the appearance and behavior of the emulator

environment.
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Figure 6-2



Each button in the toolbar has associated with it a keyboard
accelerator which can be identified either by hovering the mouse
pointer over the button and waiting for the tooltip to appear or

via the help option of the extended controls panel.

Though many of the options contained within the toolbar are self-
explanatory, each option will be covered for the sake of

completeness:

eExit / Minimize — The uppermost X’ button in the toolbar exits

the emulator session when selected while the ‘-’ option minimizes

the entire window.

ePower — The Power button simulates the hardware power button
on a physical Android device. Clicking and releasing this button
will lock the device and turn off the screen. Clicking and holding

this button will initiate the device “Power oftf” request sequence.

eVolume Up / Down — Two buttons that control the audio volume

of playback within the simulator environment.

eRotate Left/Right — Rotates the emulated device between portrait

and landscape orientations.

eTake Screenshot — Takes a screenshot of the content currently

displayed on the device screen. The captured image is stored at



the location specified in the Settings screen of the extended

controls panel as outlined later in this chapter.

eZoom Mode — This button toggles in and out of zoom mode,

details of which will be covered later in this chapter.

eBack — Performs the standard Android “Back” navigation to

return to a previous screen.

eHome — Displays the device home screen.

eOverview — Simulates selection of the standard Android
“Overview” navigation which displays the currently running apps

on the device.

eFold Device — Simulates the folding and unfolding of a foldable
device. This option is only available if the emulator is running a

foldable device system image.

eExtended Controls — Displays the extended controls panel,
allowing for the configuration of options such as simulated
location and telephony activity, battery strength, cellular network

type, and fingerprint identification.



6.3 Working in Zoom Mode

The zoom button located in the emulator toolbar switches in and
out of zoom mode. When zoom mode is active the toolbar
button is depressed and the mouse pointer appears as a
magnifying glass when hovering over the device screen. Clicking
the left mouse button will cause the display to zoom in relative
to the selected point on the screen, with repeated clicking
increasing the zoom level. Conversely, clicking the right mouse
button decreases the zoom level. Toggling the zoom button off

reverts the display to the default size.

Clicking and dragging while in zoom mode will define a
rectangular area into which the view will zoom when the mouse

button is released.

While in zoom mode the visible area of the screen may be
panned using the horizontal and vertical scrollbars located within

the emulator window.



6.4 Resizing the Emulator Window

The size of the emulator window (and the corresponding
representation of the device) can be changed at any time by
clicking and dragging on any of the corners or sides of the

window.



6.5 Extended Control Options

The extended controls toolbar button displays the panel illustrated in
Figure By default, the location settings will be displayed. Selecting a
different category from the left-hand panel will display the

corresponding group of
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6.5.1 Location

The location controls allow simulated location information to be
sent to the emulator in the form of decimal or sexigesimal
coordinates. Location information can take the form of a single
location, or a sequence of points representing movement of the
device, the latter being provided via a file in either GPS Exchange
(GPX) or Keyhole Markup Language (KML) format. Alternatively,
the integrated Google Maps panel may be used to visually select

single points or travel routes.



6.5.2 Displays

In addition to the main display shown within the emulator screen,
the Displays option allows additional displays to be added running
within the same Android instance. This can be useful for testing
apps for dual-screen devices such as the Microsoft Surface Duo.
These additional screens can be configured to be any required
size and appear within the same emulator window as the main

screen.



6.5.3 Cellular

The type of cellular connection being simulated can be changed
within the cellular settings screen. Options are available to
simulate different network types (CSM, EDGE, HSDPA, etc) in
addition to a range of voice and data scenarios such as roaming

and denied access.



6.5.4 Battery

A variety of battery state and charging conditions can be
simulated on this panel of the extended controls screen, including

battery charge level, battery health, and whether the AC charger is

currently connected.



6.5.5 Camera

The emulator simulates a 3D scene when the camera is active.
This takes the form of the interior of a virtual building through
which you can navigate by holding down the Option key (Alt on
Windows) while using the mouse pointer and keyboard keys when
recording video or before taking a photo within the emulator. This
extended configuration option allows different images to be

uploaded for display within the virtual environment.



6.5.6 Phone

The phone extended controls provide two very simple but useful
simulations within the emulator. The first option allows for the

simulation of an incoming call from a designated phone number.
This can be of particular use when testing how an app handles

high-level interrupts of this nature.

The second option allows the receipt of text messages to be
simulated within the emulator session. As in the real world, these
messages appear within the Message app and trigger the standard

notifications within the emulator.



6.5.7 Directional Pad

A directional pad (D-Pad) is an additional set of controls either
built into an Android device or connected externally (such as a
game controller) that provides directional controls (left, right, up,
down). The directional pad settings allow D-Pad interaction to be

simulated within the emulator.



6.5.8 Microphone

The microphone settings allow the microphone to be enabled and
virtual headset and microphone connections to be simulated. A
button is also provided to launch the Voice Assistant on the

emulator.



6.5.9 Fingerprint

Many Android devices are now supplied with built-in fingerprint
detection hardware. The AVD emulator makes it possible to test
fingerprint authentication without the need to test apps on a
physical device containing a fingerprint sensor. Details on how to
configure fingerprint testing within the emulator will be covered in

detail later in this chapter.



6.5.10 Virtual Sensors

The virtual sensors option allows the accelerometer and
magnetometer to be simulated to emulate the effects of the
physical motion of a device such as rotation, movement, and

tilting through yaw, pitch and roll settings.



6.5.11 Snapshots

Snapshots contain the state of the currently running AVD session
to be saved and rapidly restored making it easy to return the
emulator to an exact state. Snapshots are covered in later in this

chapter.



6.5.12 Record and Playback

Allows the emulator screen and audio to be recorded and saved

in either WebM or animated GIF format.



6.5.13 Google Play

If the emulator is running a version of Android with Google Play
Services installed, this option displays the current Google Play
version and provides the option to update the emulator to the

latest version.



6.5.14 Settings

The settings panel provides a small group of configuration
options. Use this panel to choose a darker theme for the toolbar
and extended controls panel, specify a file system location into
which screenshots are to be saved, configure OpenGL support
levels, and configure the emulator window to appear on top of

other windows on the desktop.



6.5.15 Help

The Help screen contains three sub-panels containing a list of
keyboard shortcuts, links to access the emulator online

documentation, file bugs and send feedback, and emulator version

information.



6.6 Working with Snapshots

When an emulator starts for the very first time it performs a cold
boot much like a physical Android device when it is powered on.
This cold boot process can take some time to complete as the
operating system loads and all the background processes are started.
To avoid the necessity of going through this process every time the
emulator is started, the system is configured to automatically save a
snapshot (referred to as a quick-boot of the emulator’s current state
each time it exits. The next time the emulator is launched, the quick-
boot snapshot is loaded into memory and execution resumes from
where it left off previously, allowing the emulator to restart in a

fraction of the time needed for a cold boot to complete.

The Snapshots screen of the extended controls panel can be used to
store additional snapshots at any point during the execution of the
emulator. This saves the exact state of the entire emulator allowing
the emulator to be restored to the exact point in time that the
snapshot was taken. From within the screen, snapshots can be taken
using the Take Snapshot button (marked A in Figure To restore an
existing snapshot, select it from the list (B) and click the run button
(C) located at the bottom of the screen. Options are also provided
to edit (D) the snapshot name and description and to delete (E) the

currently selected snapshot:
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Figure 6-4

To force an emulator session to perform a cold boot instead of

using a previous quick-boot snapshot, enable the checkbox marked F

in the above figure.

You can also choose whether to start an emulator using either a
cold boot, the most recent quick-boot snapshot, or a previous
snapshot by making a selection from the run target menu in the

main toolbar, as illustrated in Eigure
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6.7 Configuring Fingerprint Emulation

The emulator allows up to 10 simulated fingerprints to be configured
and used to test fingerprint authentication within Android apps. To
configure simulated fingerprints begin by launching the emulator,
opening the Settings app, and selecting the Security & Location

option.

Within the Security settings screen, select the Use fingerprint option.
On the resulting information screen click on the Next button to
proceed to the Fingerprint setup screen. Before fingerprint security
can be enabled a backup screen unlocking method (such as a PIN)
must be configured. Click on the Fingerprint + PIN button and, when
prompted, choose not to require the PIN on device startup. Enter
and confirm a suitable PIN and complete the PIN entry process by

accepting the default notifications option.

Proceed through the remaining screens until the Settings app
requests a fingerprint on the sensor. At this point display the
extended controls dialog, select the Fingerprint category in the left-
hand panel and make sure that Finger 1 is selected in the main

settings panel:



@ Location Fingerprint

Finger 1 -
O Displays
Touch Sensor
4 Cellular
B Battery

Figure 6-6

Click on the Touch Sensor button to simulate Finger 1 touching the
fingerprint sensor. The emulator will report the successful addition of

the fingerprint:
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Fingerprint added!
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fingerprint for identification or to authorize
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ADD ANOTHER m




Figure 6-7

To add additional fingerprints click on the Add Another button and
select another finger from the extended controls panel menu before

clicking on the Touch Sensor button once again.



6.8 The Emulator in Tool Window Mode

As outlined in the previous chapter gn_Android Virtual Device
(AVD)_in_Android Android Studio can be configured to launch the

emulator as an embedded tool window so that it does not appear

in a separate window. When running in this mode, the same
controls available in standalone mode are provided in the toolbar

as shown in Figure

Emulator: [ Pixel 4 API 33 B a% —
e 0 « @# 8 B WD

Figure 6-8

From left to right, these buttons perform the following tasks

(details of which match those for standalone mode):

«Power

«Volume Up

Volume Down

«Rotate Left

«Rotate Right



«Back

eHome

«Overview

«Screenshot

«Snapshots

«Extended Controls



6.9 Creating a Resizable Emulator

In addition to emulators configured to match specific Android device
models, Android Studio also provides a resizable AVD that allows
you to switch between phone, tablet and foldable device sizes. To
create a resizable emulator, open the Device Manager and click the
Create device button. Next, select the Resizable device definition

illustrated in Figure and follow the usual steps to create a new AVD:

Choose a device definition

[0 Resizable (Experimental)

Categary MName - Play Store  Size Resclution  Density
m Resizable (Experimeantal) -m 1080x23... | 420dpi
1080p%
Takel Pixel XL LAl 1440%325_ SE0dapi Size: large
Ratio:  lang
Wear 0S Pixel 6 Pro 6.7" 1340x31..  560dp Pensiirda200p)
60 2340px This devke resizes to:
Desktog Pixel & 6.4" 1080x24... azadpl Phona (1080 x 2340 @ 420dpD
Foldable (1768 x 2208 (@ 420d4p0)
. o ’ Tablet {1920 x« 1200 & 240dph
TV Pixegl & 6.0 1080x23...  440dpi Beskiop (1920 x 1080 @ 160dmi
Automotive Pixel 4a 5.8 1080x%23...  440dpl
Figure 6-9

When you run an app on the new emulator within a tool window,
the Display mode option will appear in the toolbar, allowing you to

switch between emulator configurations as shown in Figure

Emulator: - Resizable API 33 R =
O 0W <« @ 0 ) O D

[ Unfolded Foldable
] Tablet



Figure 6-10

If the emulator is running in standalone mode, the Display mode

option can be found in the side toolbar as shown below:

11:28 B

AndroidSample

dollars

Figure 6-11
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6.10 Summary

Android Studio contains an Android Virtual Device emulator
environment designed to make it easier to test applications
without the need to run on a physical Android device. This
chapter has provided a brief tour of the emulator and highlighted
key features that are available to configure and customize the

environment to simulate different testing conditions.



7. A Tour of the Android Studio User Interface

While it is tempting to plunge into running the example
application created in the previous chapter, doing so involves
using aspects of the Android Studio user interface which are best

described in advance.

Android Studio is a powerful and feature-rich development
environment that is, to a large extent, intuitive to use. That being
said, taking the time now to gain familiarity with the layout and
organization of the Android Studio user interface will considerably
shorten the learning curve in later chapters of the book. With this
in mind, this chapter will provide an initial overview of the
various areas and components that make up the Android Studio

environment.



7.1 The Welcome Screen

The welcome screen is displayed any time that Android Studio is
running with no projects currently open (open projects can be closed
at any time by selecting the File -> Close Project menu option). If
Android Studio was previously exited while a project was still open,
the tool will bypass the welcome screen next time it is launched,

automatically opening the previously active project.

@ =] Welcome to Android Studio
@ Android Studio
F inge i) 1

Customize Welcome to Android Studio
Plugins
Learn Android Studio Open existing project 1 disk er version cont

F.— P

New Project Open Get from VCS

More Actions

Figure 7-1



In addition to a list of recent projects, the welcome screen provides
options for performing tasks such as opening and creating projects
along with access to projects currently under version control. In
addition, the Customize screen provides options to change the theme
and font settings used by both the IDE and the editor. Android
Studio plugins may be viewed, installed, and managed using the

Plugins option.

Additional options are available by clicking on the menu button as

shown in Figure

New Project Open Get from VCS :
1< Prefile or Debug APK
I¥ Import Project {Gradle, Eclipse ADT, etc.)
Jemo

" Impert an Android Code Sample
i, SDK Manager
(L Virtual Device Manager

Figure 7-2



7.2 The Main Window

When a new project is created, or an existing one opened, the
Android Studio main window will appear. When multiple projects are
open simultaneously, each will be assigned its own main window.
The precise configuration of the window will vary depending on
which tools and panels were displayed the last time the project was

open, but will typically resemble that of Figure
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The various elements of the main window can be summarized as

follows:



A — Menu Bar — Contains a range of menus for performing tasks

within the Android Studio environment.

B — Toolbar — A selection of shortcuts to frequently performed
actions. The toolbar buttons provide quick access to a select group
of menu bar actions. The toolbar can be customized by right-clicking
on the bar and selecting the Customize Menus and Toolbars... menu
option. If the toolbar is not visible, it can be displayed using the

View -> Appearance -> Toolbar menu option.

C - Navigation Bar — The navigation bar provides a convenient way
to move around the files and folders that make up the project.
Clicking on an element in the navigation bar will drop down a menu
listing the sub-folders and files at that location ready for selection.
Similarly, clicking on a class name displays a menu listing methods
contained within that class. Select a method from the list to be
taken to the corresponding location within the code editor. Hide and
display this bar using the View -> Appearance -> Navigation Bar menu

option.

D - Editor Window — The editor window displays the content of the
file on which the developer is currently working. When multiple files
are open, each file is represented by a tab located along the top

edge of the editor as shown in Figure

MainActivity kt <3y Colors . xml build gradle (:app)

= Code =0 Split B2 Design

setContent {
ComposelemoTheme {



Figure 7-4

E — Status Bar — The status bar displays informational messages

about the project and the activities of Android Studio together with
the tools menu button located in the far left corner. Hovering over
items in the status bar will display a description of that field. Many
fields are interactive, allowing the user to click to perform tasks or

obtain more detailed status information.

F — Project Tool Window — The project tool window provides a
hierarchical overview of the project file structure allowing navigation
to specific files and folders to be performed. The toolbar can be
used to display the project in several different ways. The default
setting is the Android view which is the mode primarily used in the

remainder of this book.

The project tool window is just one of many tool windows available

within the Android Studio environment.



7.3 The Tool Windows

In addition to the project view tool window, Android Studio also
includes many other windows which, when enabled, are displayed
along the bottom and sides of the main window. The tool window
quick access menu can be displayed by hovering the mouse pointer
over the button located in the far left-hand corner of the status bar

without clicking the mouse
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Selecting an item from the quick access menu will cause the

corresponding tool window to appear within the main window.

Alternatively, a set of tool window bars can be displayed by clicking
on the quick access menu icon in the status bar. These bars appear
along the left, right, and bottom edges of the main window (as
indicated by the arrows in Figure and contain buttons for showing
and hiding each of the tool windows. When the tool window bars

are displayed, a second click on the button in the status bar will
hide

S H o ¢ app - Prcnl & API 30 P n N L 6 [ ] ] O

AndroldSample  app  grc  maln  res fayoul L acklvity_mpinooml

= TODO M Tarminal A, Buld & Logoa 2 Profiler % Dolabase Inspector Pk 4 Run Event L Layouk Inspechor

Figure 7-6

Clicking on a button will display the corresponding tool window while

a second click will hide the window. Buttons prefixed with a number
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(for example 1: Project) indicate that the tool window may also be
displayed by pressing the Alt key on the keyboard (or the Command

key for macOS) together with the corresponding number.

The location of a button in a tool window bar indicates the side of
the window against which the window will appear when displayed.
These positions can be changed by clicking and dragging the buttons

to different locations in other window toolbars.

Each tool window has its own toolbar along the top edge. The
buttons within these toolbars vary from one tool to the next, though
all tool windows contain a settings option, represented by the cog
icon, which allows various aspects of the window to be changed.

Figure 7-7_shows the settings menu for the Project tool window.

Options are available, for example, to undock a window and to allow
it to float outside of the boundaries of the Android Studio main

window, and to move and resize the tool
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All of the windows also include a far-right button on the toolbar
providing an additional way to hide the tool window from view. A
search of the items within a tool window can be performed simply
by giving that window focus by clicking in it and then typing the
search term (for example the name of a file in the Project tool
window). A search box will appear in the window’s toolbar and items

matching the search highlighted.

Android Studio offers a wide range of tool windows, the most

commonly used of which are as follows:

Inspector - Provides access to the Database and Background Task
inspectors. The Database Inspector allows you to inspect, query, and
modify your app’s databases while the app is running. The
Background Task Inspector allows background worker tasks created

using WorkManager to be monitored and managed.

eBuild - The build tool window displays information about the build
process while a project is being compiled and packaged and displays

details of any errors encountered.

Variants — The build variants tool window provides a quick way to
configure different build targets for the current application project (for
example different builds for debugging and release versions of the

application, or multiple builds to target different device categories).

File Explorer — Available via the View -> Tool Windows -> Device File

Explorer menu, this tool window provides direct access to the



filesystem of the currently connected Android device or emulator
allowing the filesystem to be browsed and files copied to the local

filesystem.

Manager - Provides access to the Device Manager tool window where
physical Android device connections and emulators may be added,

removed, and managed.

- Contains the AVD emulator if the option has been enabled to run
the emulator in a tool window as outlined in the chapter entitled
“Creating_an Android Virtual Device (AVD)_in Android

Log — The event log window displays messages relating to events
and activities performed within Android Studio. The successful build
of a project, for example, or the fact that an application is now

running will be reported within this tool window.

— A variety of project items can be added to the favorites list. Right-
clicking on a file in the project view, for example, provides access to
an Add to Favorites menu option. Similarly, a method in a source file
can be added as a favorite by right-clicking on it in the Structure
tool window. Anything added to a Favorites list can be accessed

through this Favorites tool window.

oFind - Search for code and text within your project files.

— The Gradle tool window provides a view of the Gradle tasks that
make up the project build configuration. The window lists the tasks

that are involved in compiling the various elements of the project



into an executable application. Right-click on a top-level Gradle task
and select the Open Gradle Config menu option to load the Gradle
build file for the current project into the editor. Gradle will be

covered in greater detail later in this book.

Inspector - Provides a visual 3D rendering of the hierarchy of

components that make up a user interface layout.

— The Logcat tool window provides access to the monitoring log
output from a running application in addition to options for taking
screenshots and videos of the application and stopping and restarting

d process.

- A central location in which to view all of the current errors or
warnings within the project. Double-clicking on an item in the

problem list will take you to the problem file and location.

— The Android Profiler tool window provides real-time monitoring and
analysis tools for identifying performance issues within running apps,
including CPU, memory and network usage. This option becomes

available when an app is currently running.

— The project view provides an overview of the file structure that
makes up the project allowing for quick navigation between files.
Generally, double-clicking on a file in the project view will cause that

file to be loaded into the appropriate editing tool.

Manager - A tool for adding and managing resources and assets

such as images, colors, and layout files contained with the project.



— The run tool window becomes available when an application is
currently running and provides a view of the results of the run
together with options to stop or restart a running process. If an
application is failing to install and run on a device or emulator, this
window will typically provide diagnostic information relating to the

problem.

— The structure tool provides a high-level view of the structure of the
source file currently displayed in the editor. This information includes
a list of items such as classes, methods, and variables in the file.
Selecting an item from the structure list will take you to that

location in the source file in the editor window.

eRunning Devices - Displays any AVD instances running within the

current Android Studio session.

eTerminal — Provides access to a terminal window on the system on
which Android Studio is running. On Windows systems, this is the
Command Prompt interface, while on Linux and macOS systems this

takes the form of a Terminal prompt.

— As the name suggests, this tool provides a place to review items
that have yet to be completed on the project. Android Studio
compiles this list by scanning the source files that make up the
project to look for comments that match specified TODO patterns.
These patterns can be reviewed and changed by selecting the File ->
Settings... menu option Studio -> Preferences... on macQOS) and

navigating to the TODO page listed under



eVersion Control - This tool window is used when the project files
are under source code version control, allowing access to Git

repositories and code change history.



7.4 Android Studio Keyboard Shortcuts

Android Studio includes an abundance of keyboard shortcuts
designed to save time when performing common tasks. A full
keyboard shortcut keymap listing can be viewed and printed from
within the Android Studio project window by selecting the Help ->
Keyboard Shortcuts menu option. You may also list and modify the
keyboard shortcuts by selecting the File -> Settings... menu option
Studio -> Preferences... on macOS) and clicking on the Keymap entry

as shown in Figure 7-8 below:
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7.5 Switcher and Recent Files Navigation

Another useful mechanism for navigating within the Android Studio
main window involves the use of the Accessed via the Ctrl-Tab
keyboard shortcut, the switcher appears as a panel listing both the

tool windows and currently open

Switcher
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(0 M Device Manager
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T Terminal
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~/OneDrive/Documents/Bocks{Jetpack_ComposefJetpackComposeEssentialsfComposeDemo/fapp

Figure 7-9

Once displayed, the switcher will remain visible for as long as the

Ctrl key remains depressed. Repeatedly tapping the Tab key while



holding down the Ctrl key will cycle through the various selection
options while releasing the Ctrl key causes the currently highlighted

item to be selected and displayed within the main window.

In addition to the switcher, navigation to recently opened files is
provided by the Recent Files panel This can be accessed using the
Ctrl-E keyboard shortcut (Cmd-E on macOS). Once displayed, either
the mouse pointer can be used to select an option or the keyboard
arrow keys used to scroll through the file name and tool window

options. Pressing the Enter key will select the currently item.
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7.6 Changing the Android Studio Theme

The overall theme of the Android Studio environment may be
changed either from the welcome screen using the Customize option
or via the File -> Settings... menu option Studio -> Preferences... on

macOS) of the main window.

Once the settings dialog is displayed, select the Appearance &
Behavior option followed by Appearance in the left-hand panel and
then change the setting of the Theme menu before clicking on the
Apply button. The themes available will depend on the platform but
usually include options such as Light, Intelli], Windows, High
Contrast, and Darcula. Figure 7-11_shows an example of the main

window with the Darcula theme selected:

A idSample [=/Docur lin_Android_Studio_3.&/WORK/AndreidSamela] - .. fapp/sre/mainfresfayout/fragment_firstxml [apg]

Figure 7-1



To synchronize the Android Studio theme with the operating system
light and dark mode setting, enable the Sync with OS option and

use the drop-down menu to control which theme to use for each

mode:

Appearance & Behavior > Appearance

Theme: Sync with 0S &

Preferred Theme

Vv IntelliJ Light

v/ Darcula
High contrast

Use custom font: .AppleSystemUlFont

Accessibility

Support screen readers Re 5 restart

Use contrast scrollbars

Figure 7-12



7.7 Summary

The primary elements of the Android Studio environment consist
of the welcome screen and main window. Each open project is
assigned its own main window which, in turn, consists of a menu
bar, toolbar, editing and design area, status bar, and a collection
of tool windows. Tool windows appear on the sides and bottom
edges of the main window and can be accessed either using the
quick access menu located in the status bar or via the optional

tool window bars.

There are very few actions within Android Studio that cannot be
triggered via a keyboard shortcut. A keymap of default keyboard
shortcuts can be accessed at any time from within the Android

Studio main window.



8. Testing Android Studio Apps on a Physical Android Device

While much can be achieved by testing applications using an
Android Virtual Device (AVD), there is no substitute for
performing real-world application testing on a physical Android
device and there are some Android features that are only available

on physical Android devices.

Communication with both AVD instances and connected Android
devices is handled by the Android Debug Bridge (ADB). In this
chapter, we explain how to configure the adb environment to
enable application testing on an Android device with macOS,

Windows, and Linux-based systems.



8.1 An overview of the Android Debug Bridge

The primary purpose of the ADB is to facilitate interaction
between a development system, in this case, Android Studio, and
both AVD emulators and Android devices to run and debug
applications. ADB allows you to connect to devices either over a

WiFi network or directly using a USB cable.

The ADB consists of a client, a server process running in the
background on the development system, and a daemon
background process running in either AVDs or real Android

devices such as phones and tablets.

The ADB client can take a variety of forms. For example, a client
is provided in the form of a command-line tool named adb
located in the Android SDK platform-tools sub-directory. Similarly,

Android Studio also has a built-in client.

A variety of tasks may be performed using the adb command-line
tool. For example, a listing of currently active virtual or physical
devices may be obtained using the devices command-line
argument. The following command output indicates the presence

of an AVD on the system but no physical

$ adb devices

List of devices attached



emulator-5554 device



8.2 Enabling USB debugging ADB on Android devices

Before ADB can connect to an Android device, that device must first
be configured to allow the connection. On phone and tablet devices

running Android 6.0 or later, the steps to achieve this are as follows:

1. Open the Settings app on the device and select the About tablet
or About phone option (on some versions of Android this can be

found on the System page of the Settings app).

2. On the About screen, scroll down to the Build number field and
tap on it seven times until a message appears indicating that
developer mode has been If the Build number is not listed on the
About screen it may be available via the Software information option.

Alternatively, unfold the Advanced section of the list if available.

Kernel version

Build number

Figure 8-1



3. Return to the main Settings screen and note the appearance of a
new option titled Developer options (on newer versions of Android
this option is listed on the System settings screen). Select this
option and on the resulting screen, locate the USB debugging option

as illustrated in Eigure

Debugging

USB debugging ()
Debug mode when USB is connected

Figure 8-2

4. Enable the USB debugging option and tap the Allow button when

confirmation is requested.

At this point, the device is now configured to accept debugging
connections from adb on the development system over a USB
connection. All that remains is to configure the development system
to detect the device when it is attached. While this is a relatively
straightforward process, the steps involved differ depending on
whether the development system is running Windows, macOS, or
Linux. Note that the following steps assume that the Android SDK
platform-tools directory is included in the operating system PATH

environment variable as described in the chapter entitled “Setting up

an_Android Studio Development



8.2.1 macOS ADB configuration

To configure the ADB environment on a macOS system, connect the
device to the computer system using a USB cable, open a terminal
window and execute the following command to restart the adb

server.

$ adb kill-server

$ adb start-server

* daemon not running. starting it now on port 5037 *

* daemon started successfully *

Once the server is successfully running, execute the following

command to verify that the device has been detected:

$ adb devices

List of devices attached

74CE000600000001 offline

If the device is listed as go to the Android device and check for the

presence of the dialog shown in Eigure 8-3_seeking permission to




Allow USB debugging. Enable the checkbox next to the option that

reads Always allow from this before clicking on

Allow USB debugging?

The computer's RSA key fingerprint is:
6E:BF:56:13:95:F8:9B:7E:12:CF:C5:67

Always allow from this computer

CANCEL OK

Figure 8-3

Repeating the adb devices command should now list the device as

being available:

List of devices attached

015d41d4454bf8oc device

If the device is not listed, try logging out and then back into the

macOS desktop and, if the problem persists, rebooting the system.



8.2.2 Windows ADB configuration

The first step in configuring a Windows-based development system
to connect to an Android device using ADB is to install the
appropriate USB drivers on the system. The USB drivers to install
will depend on the model of the Android Device. If you have a
Google device such as a Pixel phone, then it will be necessary to
install and configure the Google USB Driver package on your
Windows system. Detailed steps to achieve this are outlined on

the following web page:

https: //developer.android.com /sdk/win-usb.html

For Android devices not supported by the Google USB driver, it
will be necessary to download the drivers provided by the device
manufacturer. A listing of drivers together with download and

installation information can be obtained online at:

https: //developer.android.com /tools /extras /oem-usb.html

With the drivers installed and the device now being recognized as
the correct device type, open a Command Prompt window and

execute the following command:

adb devices


https://developer.android.com/sdk/win-usb.html
https://developer.android.com/tools/extras/oem-usb.html

This command should output information about the connected

device similar to the following:

List of devices attached

HT4CTJTo1906 offline

If the device is listed as offline or go to the device display and
check for the dialog shown in Eigure 8-3_seeking permission to
Allow USB Enable the checkbox next to the option that reads

Always allow from this before clicking on Repeating the adb devices

command should now list the device as being ready:

List of devices attached

HT4CT|To1906 device

If the device is not listed, execute the following commands to

restart the ADB server:

adb kill-server

adb start-server



If the device is still not listed, try executing the following

command:

android update adb

Note that it may also be necessary to reboot the system.



8.2.3 Linux adb configuration

For this chapter, we will once again use Ubuntu Linux as a
reference example in terms of configuring adb on Linux to

connect to a physical Android device for application testing.

Physical device testing on Ubuntu Linux requires the installation of
a package named android-tools-adb which, in turn, requires that the
Android Studio user be a member of the plugdev group. This is
the default for user accounts on most Ubuntu versions and can
be verified by running the id command. If the plugdev group is

not listed, run the following command to add your account to the

group:

sudo usermod -aG plugdev $SLOGNAME

After the group membership requirement has been met, the
android-tools-adb package can be installed by executing the

following command:

sudo apt-get install android-tools-adb

Once the above changes have been made, reboot the Ubuntu
system. Once the system has restarted, open a Terminal window,

start the adb server and check the list of attached devices:



$ adb start-server

* daemon not running. starting it now on port 5037 *

* daemon started successfully *

$ adb devices

List of devices attached

015d41d4454bf80c offline

If the device is listed as offline or go to the Android device and
check for the dialog shown in Eigure 8-3_seeking permission to
Allow USB debugging.



8.3 Resolving USB connection issues

If you are unable to successfully connect to the device using the
above steps, display the run target menu and select the

Troubleshoot Device Connections option:

LPixeldAPI32 v | @ Q@ E & (7

] lallalnBm =1T; y
3 rUNNING devices

5 Pixel 4 APl 32

Select Multiple Devices...
| T Pair Devices Using Wi-Fi
I
@ Wear OS emulator pairing assistant

[L Device Manager

‘= Troubleshoot Device Connections

Figure 8-4

The connection assistant will scan for devices and report problems

and possible solutions.



8.4 Enabling wireless debugging on Android devices

Follow steps 1 through 3 from section 2.2 _above, this time enabling

the Wireless Debugging option as shown in Figure

Wireless debugging ()

Debug mode when Wi-Fi is connected

Figure &-5

Next, tap the above Wireless debugging entry to display the screen

shown in Figure



Wireless debugging

Use wireless debugging ‘)

Device name
sdk_gphone64_arm64

|P address & Port
10.0.2.16:38159

asim  Pair device with QR code
Pair new devices using QR code scanner

.« Pair device with pairing code
Pair new devices using six digit code

Figure 8-6



If the device you are using has a camera, select Pair device with QR
otherwise select the Pair device with pairing code option. Depending
on your selection, the Settings app will either start a camera session

or display a pairing code as shown in Eigure

Pair with device

Wi-Fi pairing code

909814

|IP address & Port
10.0.2.16:43967

Figure &-7

With an option selected, return to Android Studio and select the Pair

Devices Using WiFi option from the run target menu as illustrated in

Figure



[L Pixel 4API33 v | P P N v

Available devices
L, Pixel 4 API 33
5 Resizable API 33

Select Multiple Devices...
=" Pair Devices Using Wi-Fi
(). Device Manager

Troubleshoot Device Connections

Figure 8-8

In the pairing dialog, select either Pair using QR code or Pair using

pairing code depending on your previous selection in the Settings app

on the device:



@ L Pair devices over Wi-Fi

Pair new devices over Wi-Fi

Pair devices to enable wireless debugging. Pair camera-enabled devices using a QR code.
Other devices can be paired using a pairing code. Leaarn more

Pair using QR code Pair using pairing code

To pair an Android 11+ device
scan the QR code from your device

QR scanner available at:
Developer options > Wireless debugging > Pair using QR code

- Clase

Figure 8-9

Either scan the QR code using the Android device or enter the
pairing code displayed on the device screen into the Android Studio

dialog to complete the pairing process:



@ & Enter pairing code

Enter the 6 digit code shown on the device at
10.0.2.15:43967 to pair.

Cancel

Figure 8-10

If the pairing process fails, try rebooting both the development

system and Android device and try again.

Pair



8.5 Testing the adb connection

Assuming that the adb configuration has been successful on your
chosen development platform, the next step is to try running the test
application created in the chapter entitled “An_Example Compose
Project” on the device. Launch Android Studio, open the
ComposeDemo project, and verify that the device appears in the

device selection menu as highlighted in Eigure
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Figure 8-11

Select the device from the list and click on the run button (the
green arrow button located immediately to the right of the device

menu) to install and run the app.



8.6 Summary

While the Android Virtual Device emulator provides an excellent
testing environment, it is important to keep in mind that there is
no real substitute for making sure an application functions
correctly on a physical Android device. This, after all, is where the

application will be used in the real world.

By default, however, the Android Studio environment is not
configured to detect Android devices as a target testing device. It
is necessary, therefore, to perform some steps to be able to load
applications directly onto an Android device from within the
Android Studio development environment either via a USB cable
or over a WiFi network. The exact steps to achieve this goal differ
depending on the development platform being used. In this
chapter, we have covered those steps for Linux, macOS, and

Windows-based platforms.



9. The Basics of the Android Studio Code Editor

Developing applications for Android involves a considerable
amount of programming work which, by definition, involves typing,
reviewing, and modifying lines of code. It should come as no
surprise that the majority of a developer’s time spent using
Android Studio will typically involve editing code within the editor

window.

The modern code editor needs to go far beyond the original
basics of typing, deleting, cutting, and pasting. Today the
usefulness of a code editor is generally gauged by factors such as
the amount by which it reduces the typing required by the
programmer, ease of navigation through large source code files,
and the editor’s ability to detect and highlight programming syntax
errors in real-time as the code is being written. As will become
evident in this chapter, these are just a few of the areas in which

the Android Studio editor excels.

While not an exhaustive overview of the features of the Android
Studio editor, this chapter aims to provide a guide to the key
features of the tool. Experienced programmers will find that some
of these features are common to most code editors available
today, while a number are unique to this particular editing

environment.



9.1 The Android Studio editor

The Android Studio editor appears in the center of the main window

when a Java, Kotlin, XML, or other text-based file is selected for

editing. Figure for example, shows a typical editor session with a

Kotlin source code file loaded:

[ ] @ ComposeDemo - MainActivity. kt [ComposeDemes.app]
e composedemo Mainaciivity.kt  f DemoSci A,  mapp v 4 Pixel 4 API32 v Rl - |
g Mai nActivity.kt o strings.xmi o
2 —
[
L]

package com.example.composedemo
5
g :
- impert ...
=
8
§ F- clacs MainActivity : Compormentlctivity() {
2|24 of override fun onCreate(savedInstanceState: Bundle?) {
= super.onCreate(savedInstanceState)

setfontent {
ComposeDemaThene {
: £ U entainer using the 'background' coler from the
e Surfocel
odifier = Modifier.fillMox5ize(),
olc MaterialTheme.colors.backaround
)4
g DemoScreent)
s }
@
o2 }
}

£ }
&3 }
.
*

[¢Com abl
g fun DenoScreen() {
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Y
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The elements that comprise the editor window can be summarized

as follows:



A — Document Tabs — Android Studio is capable of holding multiple
files open for editing at any one time. As each file is opened, it is
assigned a document tab displaying the file name in the tab bar
located along the top edge of the editor window. A small drop-down
menu will appear in the far right-hand corner of the tab bar when
there is insufficient room to display all of the tabs. Clicking on this
menu will drop down a list of additional open files. A wavy red line
underneath a file name in a tab indicates that the code in the file
contains one or more errors that need to be addressed before the

project can be compiled and run.

Switching between files is simply a matter of clicking on the
corresponding tab or using the Alt-Left and Alt-Right keyboard
shortcuts. Navigation between files may also be performed using the

Switcher mechanism (accessible via the Ctrl-Tab keyboard shortcut).

To detach an editor panel from the Android Studio main window so
that it appears in a separate window, click on the tab and drag it to
an area on the desktop outside of the main window. To return the
editor to the main window, click on the file tab in the separated
editor window and drag and drop it onto the original editor tab bar

in the main window.

B — The Editor Gutter Area - The gutter area is used by the editor
to display informational icons and controls. Some typical items,
among others, which appear in this gutter area are debugging
breakpoint markers, controls to fold and unfold blocks of code,

bookmarks, change markers, and line numbers. Line numbers are



switched on by default but may be disabled by right-clicking in the

gutter and selecting the Show Line Numbers menu option.

C - Code Structure Location - This bar at the bottom of the editor
displays the current position of the cursor as it relates to the overall
structure of the code. In the following figure, for example, the bar
indicates that the onCreate() method is currently being edited and

that this method is contained within the MainActivity class.

ComposeDemo app src main java com  example  composedemo MainActivity.kt ‘£ MainAclivity ™ onCreate{savedinstanceState: Bundle?]

hainsdctivity.kt way StingExmd

Figure 9-2

Double-clicking an element within the bar will move the cursor to
the corresponding location within the code file. For example, double-
clicking on the onCreate() entry will move the cursor to the top of
that method within the source code. Similarly clicking on the
MainActivity.kt entry will drop down a list of available code navigation

points for selection:

ComposeDemo app src  main java com example composedemo MainActivity.kt = ¢
5 Android v+ € =T = £ — MainActivity.kt f. DemoScreen
[o}]
[+ 5
= R app fu DemoSlider
b= .
% > [ manifests 5 fu DemoText
E v java PEERAQE GRit-cSo fx DemoTextPreview
o ¥ P
8 v [ com.example.composedemo (G MainActivity

imnant

Figure 9-3



D — The Editor Area — This is the main area where the code is
displayed, entered, and edited by the user. Later sections of this

chapter will cover the key features of the editing area in detail.

E — The Validation and Marker Sidebar — Android Studio incorporates
a feature referred to as “on-the-fly code analysis”. What this
essentially means is that as you are typing code, the editor is
analyzing the code to check for warnings and syntax errors. The
indicators at the top of the validation sidebar will update in real-time
to indicate the number of errors and warnings found as code is
added. Clicking on this indicator will display a popup containing a
summary of the issues found with the code in the editor as

illustrated in Figure

=
>
<

L L}

1 error, 1 warning

Highlight: All Problems

Figure 9-4

The up and down arrows may be used to move between the error
locations within the code. A green checkmark indicates that no

warnings or errors have been detected.

The sidebar also displays markers at the locations where issues have

been detected using the same color-coding. Hovering the mouse



pointer over a marker when the line of code is visible in the editor

area will display a popup containing a description of the issue:

! Too many arguments for public open fun show(): Unit defined in com.google.android.material.snackbar.Snackbar

Unresolved reference: nul

Create abstract property 'nu Mare actior

Figure 9-5

Hovering the mouse pointer over a marker for a line of code that is
currently scrolled out of the viewing area of the editor will display a
“lens” overlay containing the block of code where the problem is
located allowing it to be viewed without needing to scroll to that

location in the editor:

override fun onOptionsItemSelected{item: MenuItem): Boolean {

return when {item.itemId) {
R.id.action_settings -= true -
else -= super.onﬂptionsltemSelected(item]I.I Unresolved reference: | || Expecting an elemeat

}

ppppp Trtlatnr AntlatalD manit mamil masn manil

Figure 9-6

It is also worth noting that the lens overlay is not limited to
warnings and errors in the sidebar. Hovering over any part of the
sidebar will result in a lens appearing containing the code present at

that location within the source file.

F — The Status Bar — Though the status bar is part of the main

window, as opposed to the editor, it does contain some information



about the currently active editing session. This information includes
the current position of the cursor in terms of lines and characters
and the encoding format of the file (UTF-8, ASCII, etc.). Clicking on
these values in the status bar allows the corresponding setting to be
changed. Clicking on the line number, for example, displays the Go

to Line dialog.

Having provided an overview of the elements that comprise the
Android Studio editor, the remainder of this chapter will explore the

key features of the editing environment in more detail.



9.2 Code mode

The code editor has three modes in which it can be placed using
the buttons located in the top right-hand corner of the editor

panel. In Figure 9-7_below, for example, Code mode has been

selected:

Code =N Split B Design

oy 5:‘\[‘

Figure 9-7

When in code mode, only the code editor panel is displayed and
the Preview panel is hidden from view. In Split mode, the editor
shows the Code and Preview panels side-by-side. In Design mode,

only the Preview panel is displayed.



9.3 Splitting the editor window

By default, the editor will display a single panel showing the content

of the currently selected file. A particularly useful feature when

working simultaneously with multiple source code files is the ability

to split the editor into multiple panes. To split the editor, right-click

on a file tab within the editor window and select either the Split

Vertically or Split Horizontally menu option. Figure for example,

shows the splitter in action with the editor split into three panels:

o Bctivity_android_sample.xm| o Strings.xmi =T
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Figure 9-8

AndroidSampleActivity || onCreate() | fab.setOnClickListenerd{.
package com.ebookfrenzy.androidsample w

import ...

class AndroidSampleActivity : AppCompatActivity() {

override fun onCreate(savedInstanceState: Bundle?) {
super.onCreate(savedInstanceState)
setContentView(R. layout.activity_android_sample)
setSupportActionBar(toolbar)

fab.setOnClickListener { view =>»
Snackbar.make(view, "Replace with your own ac
.setAction("Action”, null).show()
}
}

override fun onCreateOptionsMenu(menu: Menu): Boolean
ff Inflate the menu; this adds items to the actior
menulnflater,inflate(R.menu.menu_android_sample,
return true

}

override fun cnUptmnsItemSElected(ltem HenuItemJ
!/ Handle acti 2 's i
ticall
u specify & £
return when(item.ite Id] {
R.id.action_settings —> true
else —> super.onOptionsItemSelected(item)

The orientation of a split panel may be changed at any time by

right-clicking on the corresponding tab and selecting the Change



Splitter Orientation menu option. Repeat these steps to unsplit a
single panel, this time selecting the Unsplit option from the menu.
All of the split panels may be removed by right-clicking on any tab

and selecting the Unsplit All menu option.

Window splitting may be used to display different files, or to provide
multiple windows onto the same file, allowing different areas of the

same file to be viewed and edited concurrently.



9.4 Code completion

The Android Studio editor has a considerable amount of built-in
knowledge of Kotlin and Compose programming syntax and the
classes and methods that make up the Android SDK, as well as
knowledge of your codebase. As code is typed, the editor scans what
is being typed and, where appropriate, makes suggestions about what
might be needed to complete a statement or reference. When a
completion suggestion is detected by the editor, a panel will appear
containing a list of suggestions. In Figure for example, the editor is

suggesting possibilities for the beginning of a String declaration:

var_name:. Strinl
overrf . StringBuffer

gl String (kotln) @

4 = StringIndexOutOfBoundsException

T & StringBuilder ; StringBuilder

t% & StringBuilder

%  StringJoiner Snackbar.LENGTH_LONG)
€ 'u StringTokenizer

e StringCharacterIterator

€ & StringReader
overr '€ StringWriter ‘
/fp =TT Ea ré nqnu-;;”dnaprintgruou v W LIS W NEWTT wuf‘L -i |{ ,.!: I. !‘ <§ pr{w,geﬂ’f. .

Figure 9-9

If none of the auto-completion suggestions are correct, simply keep
typing and the editor will continue to refine the suggestions where
appropriate. To accept the topmost suggestion, simply press the

Enter or Tab key on the keyboard. To select a different suggestion,



use the arrow keys to move up and down the list, once again using

the Enter or Tab key to select the highlighted item.

Completion suggestions can be manually invoked using the Ctrl-Space
keyboard sequence. This can be useful when changing a word or
declaration in the editor. When the cursor is positioned over a word
in the editor, that word will automatically highlight. Pressing Ctrl-
Space will display a list of alternate suggestions. To replace the
current word with the currently highlighted item in the suggestion

list, simply press the Tab key.

In addition to the real-time auto-completion feature, the Android
Studio editor also offers a system referred to as Smart Smart
completion is invoked using the Shift-Ctrl-Space keyboard sequence
and, when selected, will provide more detailed suggestions based on
the current context of the code. Pressing the Shift-Ctrl-Space shortcut
sequence a second time will provide more suggestions from a wider

range of possibilities.

Code completion can be a matter of personal preference for many
programmers. In recognition of this fact, Android Studio provides a
high level of control over the auto-completion settings. These can be
viewed and modified by selecting the File -> Settings... menu option
(or Android Studio -> Preferences... on macOS) and choosing Editor ->
General -> Code Completion from the settings panel as shown in

Figure
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Figure 9-10



9.5 Statement completion

Another form of auto-completion provided by the Android Studio
editor is statement completion. This can be used to automatically
fill out the parentheses and braces for items such as methods
and loop statements. Statement completion is invoked using the
Shift-Ctrl-Enter (Shift-Cmd-Enter on macOS) keyboard sequence.

Consider for example the following code:

fun myMethod )

Having typed this code into the editor, triggering statement
completion will cause the editor to automatically add the braces
to the method:

fun myMethod() {



9.6 Parameter information

It is also possible to ask the editor to provide information about the
argument parameters accepted by a method. With the cursor
positioned between the brackets of a method call, the Ctrl-P on
macOS) keyboard sequence will display the parameters known to be

accepted by that method, with the most likely suggestion highlighted
in bold:

}

locale: Locale, vararg args: Any?
varargargs: Any?

Figure 9-11



9.7 Parameter name hints

The code editor may be configured to display parameter name
hints within method calls. Figure for example, highlights the
parameter name hints within the calls to the make() and

setAction() methods of the Snackbar class:

fab.setOnflickListener { view -

Snackbar.make{view, [Toxi]"Replace with your own action", Snackbar.LENGTH_LONG)
setActmnl[l | "Action" | ener: Inull). show()

Figure 9-12

The settings for this mode may be configured by selecting the File
-> Settings menu Studio -> Preferences on macOS) option followed
by Editor -> Inlay Hints -> Kotlin in the left-hand panel. On the
resulting screen, select the Parameter Hints item from the list and
enable or disable the Show parameter hints option. To adjust the
hint settings, click on the Exclude list... link and make any

necessary adjustments.



9.8 Code generation

In addition to completing code as it is typed the editor can,
under certain conditions, also generate code for you. The list of
available code generation options shown in Figure g-13_can be
accessed using the Alt-Insert on macOS) keyboard shortcut when
the cursor is at the location in the file where the code is to be

generated.

Generate F

Secondary Constructor

equals() and hashCode() r
toString() ’
)
)

Override Methods... “0
Implement Methods... ~I
Test...

Copyright

Figure 9-13

For example, consider a situation where we want to be notified
when an Activity in our project is about to be destroyed by the
operating system. This can be achieved by overriding the onStop()
lifecycle method of the Activity superclass. To have Android Studio

generate a stub method for this, simply select the Override



Methods... option from the code generation list and select the

onStop() method from the resulting list of available methods:
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Figure 9-14

Having selected the method to override, clicking on OK will
generate the stub method at the current cursor location in the

Kotlin source file as follows:

override fun onStop() {

super.onStop()



9.9 Code folding

Once a source code file reaches a certain size, even the most
carefully formatted and well-organized code can become overwhelming
and difficult to navigate. Android Studio takes the view that it is not
always necessary to have the content of every code block visible at
all times. Code navigation can be made easier through the use of
the code folding feature of the Android Studio editor. Code folding is
controlled using markers appearing in the editor gutter at the
beginning and end of each block of code in a source file. Eigure for
example, highlights the start and end markers for code that is not

currently folded:

@Composable

fun DemoText(message: String, fontSize: Float) {

’ Text(

text = message,

fontSize = funISize.sp,
fontWeight = FontWeight.Bold

W
Figure 9-15

Clicking on either of these markers will fold the statement such that

only the signature line is visible as shown in Figure



@Com b1

fun DemoText(message: String, fontSize: Float) {...}

Figure 9-16

To unfold a collapsed section of code, click on the ‘+’ marker in the
editor gutter. To see the hidden code without unfolding it, hover the
mouse pointer over the “{..}” indicator as shown in Figure The

editor will then display the lens overlay containing the folded code

block:

Con
fun DemoText(message: String, fontSize: Fleat) {..%ﬁ

fun DemoText(message: String, fontSize: Float) {
Text(

- message, range: (Float) -> Unit ) {
f fontSize.sp,
f leigl FontWeight.Bold

Figure 9-17

All of the code blocks in a file may be folded or unfolded using the
Ctrl-Shift-Plus and Ctrl-Shift-Minus keyboard sequences.

By default, the Android Studio editor will automatically fold some
code when a source file is opened. To configure the conditions under

which this happens, select File -> Settings... Studio -> Preferences... on



macOS) and choose the Editor -> General -> Code Folding entry in

the resulting settings panel
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9.10 Quick documentation lookup

Context-sensitive Kotlin and Android documentation can be accessed

by hovering the cursor over the declaration for which documentation

is required. This will display a popup containing the relevant

reference documentation for the item. Figure for example, shows the

documentation for the Android Bundle class.

e tlass Mainpctivity : ComponentActivity() {
o] override fun onCreate(savedInstanceState: Bundle?) {

super.onCreate({savedInstanceState) Al

setContent { Kotlin ~ ava

omposellenoTheme o

Surfocel . :
. . public final class Bundle
2 Modifier.fILIMaX o 4onde BaseBung implements Cloneat
= MateriallTheme.color  q.pning from String keys to various Par
I d See also:
DemoScr ,r!E) # Persistah undlLe
4 < Android APl 32 Platform >
} Bundle’ on developer.android.com
}
Figure 9-19

able » values.

Once displayed, the documentation popup can be moved around the

screen as needed.


developer.android.com

9.1 Code reformatting

In general, the Android Studio editor will automatically format code
in terms of indenting, spacing, and nesting of statements and code
blocks as they are added. In situations where lines of code need to
be reformatted (a common occurrence, for example, when cutting
and pasting sample code from a website), the editor provides a
source code reformatting feature which, when selected, will

automatically reformat code to match the prevailing code style.

To reformat source code, press the Ctrl-Alt-L on macOS) keyboard
shortcut sequence. To display the Reformat File dialog use the Ctrl-
Alt-Shift-L on macOS). This dialog provides the option to reformat
only the currently selected code, the entire source file currently active
in the editor, or only code that has changed as the result of a

source code control update.



& Reformat File: MainActivity.kt

O Whole file

Options
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Code cleanup Do not keep line breaks
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Figure 9-20

The full range of code style preferences can be changed from within
the project settings dialog. Select the File -> Settings menu option
Studio -> Preferences... on macOS) and choose Code Style in the left-
hand panel to access a list of supported programming and markup
languages. Selecting a language will provide access to a vast array of
formatting style options, all of which may be modified from the
Android Studio default to match your preferred code style. To
configure the settings for the Rearrange code option in the above
dialog, for example, unfold the Code Style section, select Kotlin and,

from the Kotlin settings, select the Arrangement tab.



9.12 Finding sample code

The Android Studio editor provides a way to access sample code
relating to the currently highlighted entry within the code listing. This
feature can be useful for learning how a particular Android class or
method is used. To find sample code, highlight a method or class
name in the editor, right-click on it and select the Find Sample Code
menu option. If sample code is available, the Find Sample Code
panel will appear beneath the editor with a list of matching samples.
Selecting a sample from the list will load the corresponding code

into the right-hand panel:

Find Sample Code

Symbol public boolean onPrepareOptionsMenu(Menu menu) {
Menu mAvatar = menu. findItem(R.id.menu_avatar);
Found I if (AccountUtils.hasActiveAccount(this)) {
ound results showAvatar();
. Android Developors }
iosched return super.onPrepareOptionsMenu(menu) ;

[ MylOActivity.java (6 resuits) ; }

[2 kemActivity java @0verride

[ ProductListActivity. java public boolean onCreateOptionsMenu(Menu menu) {

[ ScheduleActivity java super.onCreateOptionshenu(mena); :

[} Gradle build finished in 2s 134ms (yesterday 3:54 PM) 40chars 2848 LF: UTF-83 b

Figure 9-21



9.13 Live templates

As you write Android code you will find that there are common
constructs that are used frequently. For example, a common
requirement is to display a popup message to the user using the
Android Toast class. Live templates are a collection of common code
constructs that can be entered into the editor by typing the initial
characters followed by a special key (set to the Tab key by default)
to insert template code. To experience this in action, type toast in
the code editor followed by the Tab key, and Android Studio will

insert the following code at the cursor position ready for editing:

Toast.makeText(, "", Toast.LENGTH_SHORT).show()

To list and edit existing templates, change the special key, or add
your own templates, open the Preferences dialog and select Live

Templates from the Editor section of the left-hand navigation panel:
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Add, remove, duplicate or reset templates using the buttons marked
A in FEigure 9-22 above. To modify a template, select it from the list

(B) and change the settings in the panel marked C.



9.14 Summary

The Android Studio editor goes to great length to reduce the
amount of typing needed to write code and to make that code
easier to read and navigate. In this chapter, we have covered
many of the key editor features including code completion, code
generation, editor window splitting, code folding, reformatting,

documentation lookup, and live templates.



10. An Overview of the Android Architecture

So far in this book, steps have been taken to set up an
environment suitable for the development of Android applications
using Android Studio. An initial step has also been taken into the
process of application development through the creation of an

Android Studio project.

Before delving further into the practical matters of Android
application development, however, it is important to gain an
understanding of some of the more abstract concepts of both the
Android SDK and Android development in general. Gaining a clear
understanding of these concepts now will provide a sound

foundation on which to build further knowledge.



10.1 The Android software stack

Android is structured in the form of a software stack comprising
applications, an operating system, run-time environment, middle-
ware, services, and libraries. This architecture can, perhaps, best
be represented visually as outlined in Figure Each layer of the
stack, and the corresponding elements within each layer, are
tightly integrated and carefully tuned to provide the optimal
application development and execution environment for mobile
devices. In the rest of this chapter, we will explore the different
layers of the Android stack, starting at the bottom with the Linux

Kernel.



( Applications o

i Mative Android Apps i. i||| Third Party Apps |

Application Framework ]
Ar‘twlfy Window Matificatinn View
Manager Manager Manager System

( Location Y " Package )} Resource Y[ Content |
Manager Manager Manager Providers

Libraries

Android Runtime ||
Surface Media |
oy

Linux Kernel
Display WiFi Audio Binder (IPC)
Driver Driver J\ Drivers JL Drivers

| Camera Power Process Memory
‘ Driver Management Ml Management 8 Management

Figure 10-1



10.2 The Linux kernel

Positioned at the bottom of the Android software stack, the Linux
Kernel provides a level of abstraction between the device hardware
and the upper layers of the Android software stack. The kernel
provides preemptive multitasking, low-level core system services
such as memory, process, and power management in addition to
providing a network stack and device drivers for hardware such as

the device display, WiFi, and audio.

The original Linux kernel was developed in 1991 by Linus Torvalds
and was combined with a set of tools, utilities, and compilers
developed by Richard Stallman at the Free Software Foundation to
create a full operating system referred to as Various Linux
distributions have been derived from these basic underpinnings

such as Ubuntu and Red Hat Enterprise Linux.

It is important to note, however, that Android uses only the Linux
kernel. That said, it is worth noting that the Linux kernel was
originally developed for use in traditional computers in the form
of desktops and servers. In fact, Linux is now most widely
deployed in mission-critical enterprise server environments. It is a
testament to both the power of today’s mobile devices and the
efficiency and performance of the Linux kernel that we find this

software at the heart of the Android software stack.



10.3 Android runtime — ART

When an Android app is built within Android Studio it is
compiled into an intermediate bytecode format (referred to as
DEX format). When the application is subsequently loaded onto
the device, the Android Runtime (ART) uses a process referred to
as Ahead-of-Time (AOT) compilation to translate the bytecode
down to the native instructions required by the device processor.

This format is known as Executable and Linkable Format (ELF).

Each time the application is subsequently launched, the ELF
executable version is run, resulting in faster application

performance and improved battery life.

This contrasts with the Just-in-Time (JIT) compilation approach
used in older Android implementations whereby the bytecode was
translated within a virtual machine (VM) each time the application

was launched.



10.4 Android libraries

In addition to a set of standard Java development libraries
(providing support for such general-purpose tasks as string
handling, networking, and file manipulation), the Android
development environment also includes the Android Libraries.
These are a set of Java and Kotlin-based libraries that are specific
to Android development. Examples of libraries in this category
include the application framework libraries in addition to those
that facilitate user interface building, graphics drawing, and

database access.



10.4.1 C/C++ libraries

The Android runtime core libraries outlined in the preceding
section are Java-based and provide the primary APls for developers
writing Android applications. It is important to note, however, that
the core libraries do not perform much of the actual work and
are, in fact, essentially Java “wrappers” around a set of C/C++-
based libraries. When making calls, for example, to the
android.opengl library to draw 3D graphics on the device display,
the library ultimately makes calls to the OpenGL ES C++ library
which, in turn, works with the underlying Linux kernel to perform

the drawing tasks.

C/C++ libraries are included to fulfill a wide and diverse range of
functions including 2D and 3D graphics drawing, Secure Sockets
Layer (SSL) communication, SQLite database management, audio,
and video playback, bitmap and vector font rendering, display
subsystem, and graphic layer management and an implementation

of the standard C system library

In practice, the typical Android application developer will access
these libraries solely through the Java-based Android core library
APIs. If direct access to these libraries is needed, this can be

achieved using the Android Native Development Kit (NDK), the

purpose of which is to call the native methods of non-Java or



Kotlin programming languages (such as C and C++) from within

Java code using the Java Native Interface (JNI).



10.5 Application framework

The Application Framework is a set of services that collectively
form the environment in which Android applications run and are
managed. This framework implements the concept that Android
applications are constructed from reusable, interchangeable, and
replaceable components. This concept is taken a step further in
that an application is also able to publish its capabilities along
with any corresponding data so that they can be found and

reused by other applications.

The Android framework includes the following key services:

eActivity Manager — Controls all aspects of the application lifecycle

and activity stack.

eContent Providers — Allows applications to publish and share data

with other applications.

eResource Manager — Provides access to non-code embedded
resources such as strings, color settings, and user interface

layouts.

eNotifications Manager — Allows applications to display alerts and

notifications to the user.



eView System — An extensible set of views used to create

application user interfaces.

ePackage Manager — The system by which applications can find
out information about other applications currently installed on the

device.

eTelephony Manager — Provides information to the application
about the telephony services available on the device such as

status and subscriber information.

eLocation Manager — Provides access to the location services

allowing an application to receive updates about location changes.



10.6 Applications

Located at the top of the Android software stack are the
applications. These comprise both the native applications provided
with the particular Android implementation (for example web
browser and email applications) and the third-party applications

installed by the user after purchasing the device.



10.7 Summary

A good Android development knowledge foundation requires an
understanding of the overall architecture of Android. Android is
implemented in the form of a software stack architecture
consisting of a Linux kernel, a runtime environment and
corresponding libraries, an application framework, and a set of
applications. Applications are predominantly written in Java or
Kotlin and compiled down to bytecode format within the Android
Studio build environment. When the application is subsequently
installed on a device, this bytecode is compiled down by the
Android Runtime (ART) to the native format used by the CPU.
The key goals of the Android architecture are performance and
efficiency, both in application execution and in the implementation

of reuse in application design.



11. An Introduction to Kotlin

Android development is performed primarily using Android Studio
which is, in turn, based on the Intellij IDEA development
environment created by a company named JetBrains. Before the
release of Android Studio 3.0, all Android apps were written using
Android Studio and the Java programming language (with some

occasional C++ code when needed).

Since the introduction of Android Studio 3.0, however, developers
now have the option of creating Android apps using another
programming language called Kotlin. Although detailed coverage of
all features of this language is beyond the scope of this book
(entire books can and have been written covering solely Kotlin),
the objective of this and the following six chapters is to provide
enough information to begin programming in Kotlin and quickly
get up to speed developing Android apps using this programming

language.



11.1 What is Kotlin?

Named after an island located in the Baltic Sea, Kotlin is a
programming language created by JetBrains and follows Java in
the tradition of naming programming languages after islands.
Kotlin code is intended to be easier to understand and write and
also safer than many other programming languages. The language,
compiler, and related tools are all open source and available for

free under the Apache 2 license.

The primary goals of the Kotlin language are to make code both
concise and safe. Code is generally considered concise when it
can be easily read and understood. Conciseness also plays a role
when writing code, allowing code to be written more quickly and
with greater efficiency. In terms of safety, Kotlin includes several
features that improve the chances that potential problems will be
identified when the code is being written instead of causing

runtime crashes.

A third objective in the design and implementation of Kotlin

involves interoperability with Java.



11.2 Kotlin and Java

Originally introduced by Sun Microsystems in 1995 Java is still by
far the most popular programming language in use today. Until
the introduction of Kotlin, it is quite likely that every Android app
available on the market was written in Java. Since acquiring the
Android operating system, Google has invested heavily in tuning
and optimizing compilation and runtime environments for running

Java-based code on Android devices.

Rather than try to re-invent the wheel, Kotlin is designed to both
integrate with and work alongside Java. When Kotlin code is
compiled it generates the same bytecode as that generated by the
Java compiler enabling projects to be built using a combination of
Java and Kotlin code. This compatibility also allows existing Java
frameworks and libraries to be used seamlessly from within Kotlin

code and also for Kotlin code to be called from within Java.

Kotlin’s creators also acknowledged that while there were ways to
improve on existing languages, there are many features of Java
that did not need to be changed. Consequently, those familiar
with programming in Java will find many of these skills to be
transferable to Kotlin-based development. Programmers with Swift
programming experience will also find much that is familiar when

learning Kotlin.



11.3 Converting from Java to Kotlin

Given the high level of interoperability between Kotlin and Java, it
is not essential to convert existing Java code to Kotlin since these
two languages will comfortably co-exist within the same project.
That being said, Java code can be converted to Kotlin from within
Android Studio using a built-in Java to Kotlin converter. To convert
an entire Java source file to Kotlin, load the file into the Android
Studio code editor and select the Code -> Convert Java File to
Kotlin File menu option. Alternatively, blocks of Java code may be
converted to Kotlin by cutting the code and pasting it into an
existing Kotlin file within the Android Studio code editor. Note
when performing Java to Kotlin conversions that the Java code will
not always convert to the best possible Kotlin code and that time

should be taken to review and tidy up the code after conversion.



11.4 Kotlin and Android Studio

Support for Kotlin is provided within Android Studio via the Kotlin
Plug-in which is integrated by default into Android Studio 3.0 or

later.



11.5 Experimenting with Kotlin

When learning a new programming language, it is often useful to be
able to enter and execute snippets of code. One of the best ways to

do this with Kotlin is to use the Kotlin Playground located at

Kotlin Multiplatiorm  Docs  Community Teach Play Q

1.810 ~ JVM T Program arguments ¢? Copy link <> Share code P Run

fun main() {
printin(

}

Figure 111

In addition to providing an environment in which Kotlin code may be
quickly entered and executed, the playground also includes a set of

examples and tutorials demonstrating key Kotlin features in action.

Try out some Kotlin code by opening a browser window, navigating
to the playground, and entering the following into the main code

panel:

fun main(args: Array) {

println("Welcome to Kotlin")



for (i in 1..8) {

printin("i = $i")

After entering the code, click on the Run button and note the output

in the console panel:

Welcome to Kotlin
i 1

Figure 11-2



11.6 Semi-colons in Kotlin

Unlike programming languages such as Java and C++, Kotlin does
not require semi-colons at the end of each statement or

expression line. The following, therefore, is valid Kotlin code:

val mynumber = 10

println(mynumber)

Semi-colons are only required when multiple statements appear on

the same line:

val mynumber = 10; println(mynumber)



11.7 Summary

For the first time since the Android operating system was
introduced, developers now have an alternative to writing apps in
Java code. Kotlin is a programming language developed by
JetBrains, the company that created the development environment
on which Android Studio is based. Kotlin is intended to make
code safer and easier to understand and write. Kotlin is also
highly compatible with Java, allowing Java and Kotlin code to co-
exist within the same projects. This interoperability ensures that
most of the standard Java and Java-based Android libraries and

frameworks are available for use when developing using Kotlin.

Kotlin support for Android Studio is provided via a plug-in
bundled with Android Studio 3.0 or later. This plug-in also

provides a converter to translate Java code to Kotlin.

When learning Kotlin, the online playground provides a useful

environment for quickly trying out Kotlin code.



12. Kotlin Data Types, Variables and Nullability

Both this and the following few chapters are intended to introduce
the basics of the Kotlin programming language. This chapter will
focus on the various data types available for use within Kotlin
code. This will also include an explanation of constants, variables,

type casting and Kotlin’s handling of null values.

As outlined in the previous chapter, entitled “An_Introduction to

Kotlin”_a useful way to experiment with the language is to use the
Kotlin online playground environment. Before starting this chapter,
therefore, open a browser window, navigate to
https://play.kotlinlang.org_and use the playground to try out the
code in both this and the other Kotlin introductory chapters that

follow.


https://play.kotlinlang.org

12.1 Kotlin data types

When we look at the different types of software that run on
computer systems and mobile devices, from financial applications
to graphics intensive games, it is easy to forget that computers
are really just binary machines. Binary systems work in terms of o
and 1, true or false, set and unset. All the data sitting in RAM,
stored on disk drives and flowing through circuit boards and
buses are nothing more than sequences of 1s and os. Each 1 or
o is referred to as a bit and bits are grouped together in blocks
of 8, each group being referred to as a byte. When people talk
about 32-bit and 64-bit computer systems they are talking about
the number of bits that can be handled simultaneously by the
CPU bus. A 64-bit CPU, for example, is able to handle data in
64-bit blocks, resulting in faster performance than a 32-bit based

system.

Humans, of course, don’t think in binary. We work with decimal
numbers, letters and words. For a human to easily (‘easily’ being
a relative term in this context) program a computer, some middle
ground between human and computer thinking is needed. This is
where programming languages such as Kotlin come into play.
Programming languages allow humans to express instructions to a
computer in terms and structures we understand, and then

compile that down to a format that can be executed by a CPU.



One of the fundamentals of any program involves data, and
programming languages such as Kotlin define a set of data types
that allow us to work with data in a format we understand when
programming. For example, if we want to store a number in a
Kotlin program we could do so with syntax similar to the

following:

val mynumber = 10

In the above example, we have created a variable named
mynumber and then assigned to it the value of 10. When we
compile the source code down to the machine code used by the

CPU, the number 10 is seen by the computer in binary as:

1010

Similarly, we can express a letter, the visual representation of a
digit (‘o' through to ‘9’) or punctuation mark (referred to in

computer terminology as using the following syntax:

val myletter = 'c

Once again, this is understandable by a human programmer, but
gets compiled down to a binary sequence for the CPU to
understand. In this case, the letter ‘c’ is represented by the
decimal number g9 using the ASCII table (an internationally
recognized standard that assigns numeric values to human

readable characters). When converted to binary, it is stored as:



10101100011

Now that we have a basic understanding of the concept of data
types and why they are necessary we can take a closer look at

some of the more commonly used data types supported by Kotlin.



12.1.1 Integer data types

Kotlin integer data types are used to store whole numbers (in
other words a number with no decimal places). All integers in
Kotlin are signed (in other words capable of storing positive,

negative and zero values).

Kotlin provides support for 8, 16, 32 and 64 bit integers
(represented by the Byte, Short, Int and Long types respectively).



12.1.2 Floating point data types

The Kotlin floating-point data types are able to store values
containing decimal places. For example, 4353.1223 would be stored
in a floating-point data type. Kotlin provides two floating-point
data types in the form of Float and Double. Which type to use
depends on the size of value to be stored and the level of
precision required. The Double type can be used to store up to
64-bit floating-point numbers. The Float data type, on the other

hand, is limited to 32-bit floating-point numbers.



12.1.3 Boolean data type

Kotlin, like other languages, includes a data type for the purpose
of handling true or false (1 or o) conditions. Two Boolean
constant values and are provided by Kotlin specifically for working

with Boolean data types.



12.1.4 Character data type

The Kotlin Char data type is used to store a single character of
rendered text such as a letter, numerical digit, punctuation mark
or symbol. Internally characters in Kotlin are stored in the form of
16-bit Unicode grapheme clusters. A grapheme cluster is made of
two or more Unicode code points that are combined to represent

a single visible character.

The following lines assign a variety of different characters to

Character type variables:

val myChar = 'f'

val myCharz2 =

val myChar3 = 'X'

Characters may also be referenced using Unicode code points. The
following example assigns the ‘X’ character to a variable using

Unicode:

val myCharg = "\uoos&



Note the use of single quotes when assigning a character to a
variable. This indicates to Kotlin that this is a Char data type as
opposed to double quotes which indicate a String data type.



12.1.5 String data type

The String data type is a sequence of characters that typically

make up a word or sentence. In addition to providing a storage
mechanism, the String data type also includes a range of string
manipulation features allowing strings to be searched, matched,
concatenated and modified. Double quotes are used to surround

single line strings during assignment, for example:

val message = "You have 10 new messages."

Alternatively, a multi-line string may be declared using triple

quotes
val message = """You have 10 new messages,
5 old messages

and 6 spam messages.

The leading spaces on each line of a multi-line string can be
removed by making a call to the trimMargin() function of the

String data type:

val message = """You have 10 new messages,



5 old messages

and 6 spam

Strings can also be constructed using combinations of strings,
variables, constants, expressions, and function calls using a
concept referred to as string interpolation. For example, the
following code creates a new string from a variety of different
sources using string interpolation before outputting it to the

console:

val username = "John"

val inboxCount = 25

val maxcount = 100

val message = "$username has $inboxCount messages. Message

capacity remaining is ${maxcount - inboxCount} messages"

println(message)

When executed, the code will output the following message:



John has 25 messages. Message capacity remaining is 75

messages.



12.1.6 Escape sequences

In addition to the standard set of characters outlined above, there
is also a range of special characters (also referred to as escape
characters) available for specifying items such as a new line, tab
or a specific Unicode value within a string. These special
characters are identified by prefixing the character with a backslash
(a concept referred to as escaping). For example, the following

assigns a new line to the variable named newline:

var newline = '\n'

In essence, any character that is preceded by a backslash is
considered to be a special character and is treated accordingly.
This raises the question as to what to do if you actually want a
backslash character. This is achieved by escaping the backslash

itself:

var backslash = '\\'

The complete list of special characters supported by Kotlin is as

follows:

«\n - New line



[ ]
—
-

1

Carriage return

\t - Horizontal tab

Backslash

[ ]
—
—

1

\" - Double quote (used when placing a double quote into a

string declaration)

«\' - Single quote (used when placing a single quote into a string
declaration)

«\$ - Used when a character sequence containing a $ is

misinterpreted as a variable in a string template.

«\unnnn — Double byte Unicode scalar where nnnn is replaced by

four hexadecimal digits representing the Unicode character.



12.2 Mutable variables

Variables are essentially locations in computer memory reserved
for storing the data used by an application. Each variable is given
a name by the programmer and assigned a value. The name
assigned to the variable may then be used in the Kotlin code to
access the value assigned to that variable. This access can involve
either reading the value of the variable or, in the case of mutable

changing the value.



12.3 Immutable variables

Often referred to as a constant, an immutable variable is similar
to a mutable variable in that it provides a named location in

memory to store a data value. Immutable variables differ in one
significant way in that once a value has been assigned it cannot

subsequently be changed.

Immutable variables are particularly useful if there is a value
which is used repeatedly throughout the application code. Rather
than use the value each time, it makes the code easier to read if
the value is first assigned to a constant which is then referenced
in the code. For example, it might not be clear to someone
reading your Kotlin code why you used the value 5 in an
expression. If, instead of the value 5, you use an immutable
variable named interestRate the purpose of the value becomes
much clearer. Immutable values also have the advantage that if
the programmer needs to change a widely used value, it only
needs to be changed once in the constant declaration and not

each time it is referenced.



12.4 Declaring mutable and immutable variables

Mutable variables are declared using the var keyword and may be

initialized with a value at creation time. For example:

var userCount = 10

If the variable is declared without an initial value, the type of the
variable must also be declared (a topic which will be covered in
more detail in the next section of this chapter). The following, for
example, is a typical declaration where the variable is initialized

after it has been declared:

var userCount: Int

userCount = 42

Immutable variables are declared using the val keyword.

val maxUserCount = 20

As with mutable variables, the type must also be specified when

declaring the variable without initializing it:

val maxUserCount: Int



maxUserCount = 20

When writing Kotlin code, immutable variables should always be

used in preference to mutable variables whenever possible.



12.5 Data types are objects

All of the above data types are objects, each of which provides a
range of functions and properties that may be used to perform a
variety of different type specific tasks. These functions and
properties are accessed using so-called dot notation. Dot notation
involves accessing a function or property of an object by
specifying the variable name followed by a dot followed in turn by

the name of the property to be accessed or function to be called.

A string variable, for example, can be converted to uppercase via

a call to the toUpperCase() function of the String class:

val myString = "The quick brown fox"

val uppercase = myString.toUpperCase()

Similarly, the length of a string is available by accessing the

length property:

val length = myString.length

Functions are also available within the String class to perform
tasks such as comparisons and checking for the presence of a

specific word. The following code, for example, will return a true



Boolean value since the word “fox” appears within the string

assigned to the myString variable:

val result = myString.contains("fox")

All of the number data types include functions for performing
tasks such as converting from one data type to another such as

converting an Int to a Float:

val mylnt = 10

val myFloat = mylInt.toFloat()

A detailed overview of all of the properties and functions provided
by the Kotlin data type classes is beyond the scope of this book
(there are hundreds). An exhaustive list for all data types can,
however, be found within the Kotlin reference documentation

available online at:

https: //kotlinlang.org /api/latest /jvm /stdlib /kotlin/


https://kotlinlang.org/a

12.6 Type annotations and type inference

Kotlin is categorized as a statically typed programming language.
This essentially means that once the data type of a variable has
been identified, that variable cannot subsequently be used to store
data of any other type without inducing a compilation error. This
contrasts to loosely typed programming languages where a
variable, once declared, can subsequently be used to store other

data types.

There are two ways in which the type of a variable will be
identified. One approach is to use a type annotation at the point
the variable is declared in the code. This is achieved by placing a
colon after the variable name followed by the type declaration.
The following line of code, for example, declares a variable named

userCount as being of type Int:

val userCount: Int = 10

In the absence of a type annotation in a declaration, the Kotlin
compiler uses a technique referred to as type inference to identify
the type of the variable. When relying on type inference, the
compiler looks to see what type of value is being assigned to the
variable at the point that it is initialized and uses that as the

type. Consider, for example, the following variable declarations:

var signalStrength = 2.231



val companyName = "My Company"

During compilation of the above lines of code, Kotlin will infer
that the signalStrength variable is of type Double (type inference in
Kotlin defaults to Double for all floating-point numbers) and that

the companyName constant is of type String.

When a constant is declared without a type annotation it must be

assigned a value at the point of declaration:

val bookTitle = "Android Studio Development Essentials"

If a type annotation is used when the constant is declared,
however, the value can be assigned later in the code. For

example:

val iosBookType = false

val bookTitle: String

if (iosBookType) {

bookTitle = "iOS App Development Essentials"

} else {



bookTitle = "Android Studio Development Essentials"



12.7 Nullable type

Kotlin nullable types are a concept that does not exist in most
other programming languages (with the exception of the optional
type in Swift). The purpose of nullable types is to provide a safe
and consistent approach to handling situations where a variable
may have a null value assigned to it. In other words, the
objective is to avoid the common problem of code crashing with
the null pointer exception errors that occur when code encounters

a null value where one was not expected.

By default, a variable in Kotlin cannot have a null value assigned

to it. Consider, for example, the following code:

val username: String = null

An attempt to compile the above code will result in a compilation

error similar to the following:

Error: Null cannot be a value of a non-null string type String

If a variable is required to be able to store a null value, it must
be specifically declared as a nullable type by placing a question

mark (?) after the type declaration:

val username: = null



The username variable can now have a null value assigned to it
without triggering a compiler error. Once a variable has been
declared as nullable, a range of restrictions are then imposed on
that variable by the compiler to prevent it being used in
situations where it might cause a null pointer exception to occur.
A nullable variable, cannot, for example, be assigned to a variable

of non-null type as is the case in the following code:

val username: String? = null

val firstname: String = username

The above code will elicit the following error when encountered by

the compiler:

Error: Type mismatch: inferred type is String? but String was

expected

The only way that the assignment will be permitted is if some
code is added to check that the value assigned to the nullable

variable is non-null:

val username: String? = null

if (username != null) {



val firstname: String = username

In the above case, the assighment will only take place if the

username variable references a non-null value.



12.8 The safe call operator

A nullable variable also cannot be used to call a function or to
access a property in the usual way. Earlier in this chapter, the
toUpperCase() function was called on a String object. Given the
possibility that this could cause a function to be called on a null

reference, the following code will be disallowed by the compiler:

val username: String? = null

val uppercase = username.toUpperCase()

The exact error message generated by the compiler in this

situation reads as follows:

Error: (Only safe (2.) or non-null asserted (!l.) calls are allowed on

a nullable receiver of type String?

In this instance, the compiler is essentially refusing to allow the
function call to be made because no attempt has been made to
verify that the variable is non-null. One way around this is to add
some code to verify that something other than null value has

been assigned to the variable before making the function call:

if (username != null) {



val uppercase = username.toUpperCase()

A much more efficient way to achieve this same verification,
however, is to call the function using the safe call operator

(represented by as follows:

val uppercase = username?.toUpperCase()

In the above example, if the username variable is null, the
toUpperCase() function will not be called and execution will
proceed at the next line of code. If, on the other hand, a non-null
value is assigned the toUpperCase() function will be called and the

result assigned to the uppercase variable.

In addition to function calls, the safe call operator may also be

used when accessing properties:

val uppercase = username?.length



12.9 Not-null assertion

The not-null assertion removes all of the compiler restrictions from
a nullable type, allowing it to be used in the same ways as a
non-null type, even if it has been assigned a null value. This
assertion is implemented using double exclamation marks after the

variable name, for example:

val username: String? = null

val length =

The above code will now compile, but will crash with the
following exception at runtime since an attempt is being made to

call a function on a non existent object:

Exception in thread "main" kotlin.KotlinNullPointerException

Clearly, this causes the very issue that nullable types are designed
to avoid. Use of the not-null assertion is generally discouraged
and should only be used in situations where you are certain that

the value will not be null.



12.10 Nullable types and the let function

Earlier in this chapter, we looked at how the safe call operator
can be used when making a call to a function belonging to a
nullable type. This technique makes it easier to check if a value is
null without having to write an if statement every time the
variable is accessed. A similar problem occurs when passing a
nullable type as an argument to a function which is expecting a
non-null parameter. As an example, consider the times() function
of the Int data type. When called on an Int object and passed
another integer value as an argument, the function multiplies the
two values and returns the result. When the following code is
executed, for example, the value of 200 will be displayed within

the console:

val firstNumber = 10

val secondNumber = 20

val result = firstNumber.times(secondNumber)

print(result)

The above example works because the secondNumber variable is a
non-null type. A problem, however, occurs if the secondNumber

variable is declared as being of nullable type:



val firstNumber = 10

val secondNumber: Int? = 20

val result = firstNumber.times(secondNumber)

print(result)

Now the compilation will fail with the following error message
because a nullable type is being passed to a function that is

expecting a non-null parameter:

Error: Type mismatch: inferred type is Int? but Int was expected

A possible solution to this problem is to simply write an if

statement to verify that the value assigned to the variable is non-

null before making the call to the function:

val firstNumber = 10

val secondNumber: Int? = 20

if (secondNumber = null) {

val result = firstNumber.times(secondNumber)



print(result)

A more convenient approach to addressing the issue, however,
involves use of the let function. When called on a nullable type
object, the let function converts the nullable type to a non-null
variable named it which may then be referenced within a lambda

statement.

secondNumber?.let {

val result =

print(result)

Note the use of the safe call operator when calling the let
function on secondVariable in the above example. This ensures
that the function is only called when the variable is assigned a

non-null value.



12.11 Late initialization

As previously outlined, non-null types need to be initialized when
they are declared. This can be inconvenient if the value to be
assigned to the non-null variable will not be known until later in
the code execution. One way around this is to declare the variable
using the lateinit modifier. This modifier designates that a value
will be initialized with a value later. This has the advantage that a
non-null type can be declared before it is initialized, with the
disadvantage that the programmer is responsible for ensuring that
the initialization has been performed before attempting to access

the variable. Consider the following variable declaration:

var myName: String

Clearly, this is invalid since the variable is a non-null type but has
not been assigned a value. Suppose, however, that the value to be
assigned to the variable will not be known until later in the
program execution. In this case, the lateinit modifier can be used

as follows:

lateinit var myName: String

With the variable declared in this way, the value can be assigned

later, for example:

myName = "John Smith"



print("My Name is " + myName)

Of course, if the variable is accessed before it is initialized, the

code will fail with an exception:

lateinit var myName: String

print("My Name is " + myName)

Exception in thread "main"
kotlin.UninitializedPropertyAccessException: lateinit property

myName has not been initialized

To verify whether a lateinit variable has been initialized, check the
isinitialized property on the variable. To do this, we need to access

the properties of the variable by prefixing the name with the ‘:

operator:

if (::myName.islnitialized) {

print("My Name is " + myName)



12.12 The Elvis operator

The Kotlin Elvis operator can be used in conjunction with nullable
types to define a default value that is to be returned if a value or
expression result is null. The Elvis operator (?:) is used to
separate two expressions. If the expression on the left does not
resolve to a null value that value is returned, otherwise the result
of the rightmost expression is returned. This can be thought of as
a quick alternative to writing an if-else statement to check for a

null value. Consider the following code:

if (myString = null) {

return myString

} else {

return "String is null"

The same result can be achieved with less coding using the Elvis

operator as follows:

return myString ?: "String is null"



12.13 Type casting and type checking

When compiling Kotlin code, the compiler can typically infer the
type of an object. Situations will occur, however, where the
compiler is unable to identify the specific type. This is often the
case when a value type is ambiguous or an unspecified object is
returned from a function call. In this situation it may be
necessary to let the compiler know the type of object that your
code is expecting or to write code that checks whether the object

is of a particular type.

Letting the compiler know the type of object that is expected is
known as type casting and is achieved within Kotlin code using
the as cast operator. The following code, for example, lets the
compiler know that the result returned from the getSystemService()

method needs to be treated as a KeyguardManager object:

val keyMgr = getSystemService(Context. KEYGUARD_SERVICE) as
KeyguardManager

The Kotlin language includes both safe and unsafe cast operators.
The above cast is an unsafe cast and will cause the app to throw
an exception if the cast cannot be performed. A safe cast, on the
other hand, uses the as? operator and returns null if the cast

cannot be performed:



val keyMgr = getSystemService(Context. KEYGUARD_SERVICE) as?
KeyguardManager

A type check can be performed to verify that an object conforms

to a specific type using the is operator, for example:

if (keyMgr is KeyguardManager) {

/| It is a KeyguardManager object



12.14 Summary

This chapter has begun the introduction to Kotlin by exploring
data types together with an overview of how to declare variables.
The chapter has also introduced concepts such as nullable types,
type casting and type checking and the Elvis operator, each of
which is an integral part of Kotlin programming and designed

specifically to make code writing less prone to error.



13. Kotlin Operators and Expressions

So far we have looked at using variables and constants in Kotlin
and also described the different data types. Being able to create
variables is only part of the story, however. The next step is to

learn how to use these variables in Kotlin code. The primary

method for working with data is in the form



13.1 Expression syntax in Kotlin

The most basic expression consists of The following is an

example of an expression:

val myresult = 1 + 2

In the above example, the (+) operator is used to add two
operands (1 and 2) together. subsequently assigns the result of
the addition to a variable The operands could just have easily
been variables (or a mixture of values and variables) instead of

the actual numerical values used in the example.

In the remainder of this chapter, we will look at the basic types

of operators available in Kotlin.



13.2 The Basic assignment operator

We have already looked at the most basic of assignment
operators, the = operator. This assignment operator simply assigns
the result of an expression to a variable. In essence, the =
assignment operator takes two operands. The left-hand operand is
the variable to which a value is to be assigned and the right-hand
operand is the value to be assigned. The right-hand operand is,
more often than not, an expression that performs some type of
arithmetic or logical evaluation or a call to a function, the result
of which will be assigned to the variable. The following examples

are all valid uses of the assignment operator:

var x: Int // Declare a mutable Int variable

val y = 10 // Declare and initialize an immutable Int variable

x = 10 /| Assign a value to x

X = X + Y /| Assign the result of x + y to x

x =y [/ Assign the value of y to x



13.3 Kotlin arithmetic operators

Kotlin provides a range of operators for creating mathematical
expressions. These operators primarily fall into the category of
binary operators in that they take two operands. The exception is
negative which serves to indicate that a value is negative rather
than positive. This contrasts with which takes two operands (i.e.

one value to be subtracted from another). For example:

var x = -10 [/ Unary - operator used to assign -10 to variable x

X = X - 5 // Subtraction operator. Subtracts 5 from x

The following table lists the primary Kotlin arithmetic operators:

operators:

operators: operators: operators: operators: operators: operators:

operators: operators:

operators:

operators:

operators:

operators:

operators:




Table 13-1

Note that multiple operators may be used in a single expression.

For example:

X=yY*10+2z-5/4



13.4 Augmented assignment operators

In an earlier section, we looked at the basic assignment operator
(=). Kotlin provides several operators designed to combine an
assighment with a mathematical or logical operation. These are
primarily of use when performing an evaluation where the result
is to be stored in one of the operands. For example, one might

write an expression as follows:

X =X+Y

The above expression adds the value contained in variable x to
the value contained in variable y and stores the result in variable
x. This can be simplified using the addition augmented

assignment operator:

X +=Yy

The above expression performs the same task = x + saves the

programmer some typing.

Numerous augmented assignment operators are available in Kotlin.
The most frequently used of which are outlined in the following

table:

table:




table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table:

table: table:

Table 13-2




13.5 Increment and decrement operators

Another useful shortcut can be achieved using the Kotlin
increment and decrement operators (also referred to as unary
operators because they operate on a single operand). Consider the

code fragment below:

X = X + 1 /[ Increase value of variable x by 1

X = x - 1 /| Decrease value of variable x by 1

These expressions increment and decrement the value of x by 1.
Instead of using this approach, however, it is quicker to use the
++ and -- operators. The following examples perform the same

tasks as the examples above:

x++ /| Increment x by 1

x-- /| Decrement x by 1

These operators can be placed either before or after the variable
name. If the operator is placed before the variable name, the
increment or decrement operation is performed before any other
operations are performed on the variable. For example, in the
following code, x is incremented before it is assigned to y, leaving

y with a value of 10:



var x = 9

val y = ++x

In the next example, however, the value of x (9) is assigned to
variable y before the decrement is performed. After the expression

is evaluated the value of y will be 9 and the value of x will be 8.

var x = 9

val y = x--



13.6 Equality operators

Kotlin also includes a set of logical operators useful for
performing comparisons. These operators all return a Boolean
result depending on the result of the comparison. These operators

that they work with two operands.

Equality operators are most frequently used in constructing
program control flow logic. For example may be constructed based

onh whether one value matches another:

i (x == y) {

/| Perform task

The result of a comparison may also be stored in a Boolean
variable. For example, the following code will result in value being

stored in the variable result:

var result: Boolean

val x = 10

val y = 20



result =

X <Yy

Clearly 10 is less than 20, resulting in of < The following table

lists the full set of Kotlin comparison operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

operators:

Table 13-3




13.7 Boolean logical operators

Kotlin also provides a set of so-called logical operators designed
to return values. These operators both return Boolean results and
take Boolean values as operands. The key operators are NOT (1),
AND (&&), and OR (||).

The NOT (!) operator simply inverts the current value of a
Boolean variable or the result of an expression. For example, if a

(|)

variable currently true, prefixing the variable with a ‘I' character

will invert the value to false:

val flag = true // variable is true

val secondFlag = !flag // secondFlag set to false

The OR (||) operator returns true if one of its two operands
evaluates to true, otherwise, it returns false. For example, the
following code evaluates to true because at least one of the

expressions on either side of the OR operator is true:

if (10 < 20) || (20 < 10)) {

print("Expression is true")



The AND (&&) operator returns true only if both operands
evaluate to be true. The following example will return false

because only one of the two operand expressions evaluates
to true:

if (1o < 20) && (20 < 10)) {

print("Expression is true")



13.8 Range operator

Kotlin includes a useful operator that allows a range of values to
be declared. As will be seen in later chapters, this operator is

invaluable when working with looping in program logic.

The syntax for the range operator is as follows:

X..y

This operator represents the range of numbers starting at x and
ending at y where both x and y are included within the range
(referred to as a closed range). The range operator 5..8, for

example, specifies the numbers 5, 6, 7, and 8.



13.9 Bitwise operators

As previously discussed, computer processors work in binary.
These are essentially streams of ones and zeros, each one
referred to as a bit. Bits are formed into groups of 8 to form
bytes. As such, it is not surprising that we, as programmers, will
occasionally end up working at this level in our code. To facilitate

this requirement, Kotlin provides a range

Those familiar with bitwise operators in other languages such as
C, C++, C#, Objective-C, and Java will find nothing new in this
area of the Kotlin language syntax. For those unfamiliar with
binary humbers, now may be a good time to seek out reference
materials on the subject to understand how ones and zeros are
formed into bytes to form numbers. Other authors have done a
much better job of describing the subject than we can do within

the scope of this book.

For this exercise, we will be working with the binary representation
of two numbers. First, the decimal number 171 is represented in

binary as:

10101011

Second, the number 3 is represented by the following binary

sequence:



00000011

Now that we have two binary numbers with which to work, we

can begin to look at the Kotlin bitwise operators:



13.9.1 Bitwise inversion

The Bitwise inversion (also referred to as NOT) is performed
using the inv() operation and has the effect of inverting all of the
bits in a number. In other words, all the zeros become ones and
all the ones become zeros. Taking our example 3 number, a

Bitwise NOT operation has the following result:

00000011 NOT

11111100

The following Kotlin code, therefore, results in a value of -4

val y = 3

val z = y.inv()

print("Result is $z")



13.9.2 Bitwise AND

The Bitwise AND is performed using the and() operation. It
makes a bit-by-bit comparison of two numbers. Any corresponding
position in the binary sequence of each number where both bits
are 1 results in a 1 appearing in the same position of the
resulting number. If either bit position contains a o then a zero
appears in the result. Taking our two example numbers, this

would appear as follows:

10101011 AND

00000011

00000011

As we can see, the only locations where both numbers have 1s
are the last two positions. If we perform this in Kotlin code,

therefore, we should find that the result is 3 (00000011):

val x = 171

val y = 3



val z = x.and(y)

print("Result is $z")



13.9.3 Bitwise OR

The bitwise OR also performs a bit-by-bit comparison of two
binary sequences. Unlike the AND operation, the OR places a 1 in
the result if there is a 1 in the first or second operand. Using

our example numbers, the result will be as follows:

10101011 OR

00000011

10101011

If we perform this operation in Kotlin using the or() operation the

result will be 171:

val x = 171

val y = 3

val z = x.or(y)



print("Result is $z")



13.9.4 Bitwise XOR

The bitwise XOR (commonly referred to performed using the xor()
operation) performs a similar task to the OR operation except that
a 1 is placed in the result if one or other corresponding bit
positions in the two numbers is 1. If both positions are a 1 or a
o then the corresponding bit in the result is set to a o. For

example:

10101011 XOR

00000011

10101000

The result, in this case, is 10101000 which converts to 168 in

decimal. To verify this we can, once again, try some Kotlin code:

val x = 171

val y = 3

val z = xxor(y)



print("Result is $z")

When executed, we get the following output from print:

Result is 168



13.9.5 Bitwise left shift

The bitwise left shift moves each bit in a binary number a
specified number of positions to the left. Shifting an integer one

position to the left has the effect of doubling the value.

As the bits are shifted to the left, zeros are placed in the vacated
rightmost (low order) positions. Note also that once the leftmost
(high order) bits are shifted beyond the size of the variable

containing the value, those high order bits are discarded:

10101011 Left Shift one bit

101010110

In Kotlin the bitwise left shift operator is performed using the
shl() operation, passing through the number of bit positions to be
shifted. For example, to shift left by 1 bit:

val x = 171

val z = x.shl(1)



print("Result is $z")

When compiled and executed, the above code will display a
message stating that the result is 342 which, when converted to

binary, equates to 101010110.



13.9.6 Bitwise right shift

A bitwise right shift is, as you might expect, the same as a left
except that the shift takes place in the opposite direction. Shifting
an integer one position to the right has the effect of halving the

value.

Note that since we are shifting to the right there is no
opportunity to retain the lowermost bits regardless of the data
type used to contain the result. As a result, the low order bits
are discarded. Whether or not the vacated high order bit positions
are replaced with zeros or ones depends on whether to indicate

positive and negative numbers is set or not.

10101011 Right Shift one bit

01010101

The bitwise right shift is performed using the shr() operation
passing through the shift count:

val x = 171



val z = x.shr(1)

print("Result is $z")

When executed, the above code will report the result of the shift

as being 8s, which equates to binary o1o10101.



13.10 Summatry

Operators and expressions provide the underlying mechanism by
which variables and constants are manipulated and evaluated
within Kotlin code. This can take the simplest of forms whereby
two numbers are added using the addition operator in an
expression and the result stored in a variable using the
assignment operator. Operators fall into a range of categories,

details of which have been covered in this chapter.



14. Kotlin Control Flow

Regardless of the programming language used, application
development is largely an exercise in applying logic, and much of
the art of programming involves writing code that makes decisions
based on one or more criteria. Such decisions define which code
gets executed, how many times it is executed, and, conversely,
which code gets bypassed when the program is running. This is
often referred to as control flow since it controls the flow of
program execution. Control flow typically falls into the categories
of looping control (how often code is executed) and conditional
control flow (whether or not code is executed). This chapter is
intended to provide an introductory overview of both types of

control flow in Kotlin.



14.1 Looping control flow

This chapter will begin by looking at control flow in the form of
loops. Loops are essentially sequences of Kotlin statements that
are to be executed repeatedly until a specified condition is met.

The first looping statement we will explore is the for loop.



14.1.1 The Kotlin for-in Statement

The for-in loop is used to iterate over a sequence of items

contained in a collection or number range.

The syntax of the for-in loop is as follows:

for variable name in collection or range {

/| code to be executed

In this syntax, variable name is the name to be used for a
variable that will contain the current item from the collection or
range through which the loop is iterating. The code in the body
of the loop will typically use this name as a reference to the
current item in the loop cycle. The collection or range references
the item through which the loop is iterating. This could, for
example, be an array of string values, a range operator, or even a

string of characters.

Consider, for example, the following for-in loop construct:

for (index in 1..5) {



printin("Value of index is $index")

The loop begins by stating that the current item is to be assigned
to a constant named The statement then declares a closed range

operator to indicate that the for loop is to iterate through a range
of numbers, starting at 1 and ending at 5. The body of the loop

simply prints out a message to the console indicating the current
value assigned to the index constant, resulting in the following

output:

Value of index is 1

Value of index is 2

Value of index is 3

Value of index is 4

Value of index is 5

The for-in loop is of particular benefit when working with
collections such as arrays. In fact, the for-in loop can be used to

iterate through any object that contains more than one item. The



following loop, for example, outputs each of the characters in the

specified string:

for (index in "Hello") {

printin("Value of index is $index")

The operation of a for-in loop may be configured using the
downTo and until functions. The downTo function causes the for
loop to work backward through the specified collection until the
specified number is reached. The following for loop counts

backward from 100 until the number go is reached:

for (index in 100 downTo go) {

print("$index.. ")

When executed, the above loop will generate the following output:

100.. 99.. 98.. 97.. 96.. 95.. 94.. 93.. 92.. 91.. 9O..

The until function operates in much the same way with the

exception that counting starts from the bottom of the collection



range and works up until (but not including) the specified

endpoint (a concept referred to as a half-closed range):

for (index in 1 until 10) {

print("$index.. ")

The output from the above code will range from the start value

of 1 through to o:

1.. 2.. 3.. 4.. 5.. 6.. 7.. 8.. 9..

The increment used on each iteration through the loop may also

be defined using the step function as follows:

for (index in o until 100 step 10) {

print("$index.. ")

The above code will result in the following console output:

O.. 10.. 20.. 30.. 40.. 50.. 60.. 70.. 80.. 9O..



14.1.2 The while loop

The Kotlin for loop described previously works well when it is
known in advance how many times a particular task needs to be
repeated in a program. There will, however, be instances where
code needs to be repeated until a certain condition is met, with
no way of knowing in advance how many repetitions are going to
be needed to meet that criterion. To address this need, Kotlin

includes the while loop.

Essentially, the while loop repeats a set of tasks while a specified

condition is met. The while loop syntax is defined as follows:

while condition {

/| Kotlin statements go here

In the above syntax, condition is an expression that will return
either true or false and the // Kotlin statements go here comment
represents the code to be executed while the condition expression

is true. For example:

var myCount = o



while (myCount < 100) {

myCount++

println(myCount)

In the above example, the while expression will evaluate whether
the myCount variable is less than 100. If it is already greater than
100, the code in the braces is skipped and the loop exits without

performing any tasks.

If, on the other hand, myCount is not greater than 100 the code
in the braces is executed and the loop returns to the while
statement and repeats the evaluation of This process repeats until
the value of myCount is greater than 100, at which point the loop

exits.



14.1.3 The do ... while loop

It is often helpful to think of the do ... while loop as an inverted
while loop. The while loop evaluates an expression before
executing the code contained in the body of the loop. If the
expression evaluates to false on the first check then the code is
not executed. The do ... while loop, on the other hand, is
provided for situations where you know that the code contained in
the body of the loop will always need to be executed at least
once. For example, you may want to keep stepping through the
items in an array until a specific item is found. You know that
you have to at least check the first item in the array to have any
hope of finding the entry you need. The syntax for the do ... while

loop is as follows:

do {

/| Kotlin statements here

} while conditional expression

In the do ... while example below the loop will continue until the

value of a variable named i equals o:

var i = 10



do {

println (i)

} while (i > o)



14.1.4 Breaking from Loops

Having created a loop, it is possible that under certain conditions
you might want to break out of the loop before the completion
criteria have been met (particularly if you have created an infinite
loop). One such example might involve continually checking for
activity on a network socket. Once activity has been detected it
will most likely be necessary to break out of the monitoring loop

and perform some other task.

To break out of a loop, Kotlin provides the break statement which
breaks out of the current loop and resumes execution at the code

directly after the loop. For example:

var j = 10

for (i in 0..100)

j =]

if (j > 100) {

break



printin("j = $j")

In the above example, the loop will continue to execute until the
value of j exceeds 100 at which point the loop will exit and

execution will continue with the next line of code after the loop.



14.1.5 The continue statement

The continue statement causes all remaining code statements in a
loop to be skipped, and execution to be returned to the top of
the loop. In the following example, the println function is only

called when the value of variable i is an even number:

var i = 1

while (i < 20)

I += 1

if i % 21=0) {

continue

printin("i = $i")



The continue statement in the above example will cause the println
call to be skipped unless the value of i can be divided by 2 with
no remainder. If the continue statement is triggered, execution will
skip to the top of the while loop and the statements in the body

of the loop will be repeated (until the value of i exceeds 19).



14.1.6 Break and continue labels

Kotlin expressions may be assigned a label by preceding the
expression with a label name followed by the @ sign. This label
may then be referenced when using break and continue
statements to designate where execution is to resume. This is
particularly useful when breaking out of nested loops. The
following code contains a for loop nested within another for loop.
The inner loop contains a break statement which is executed

when the value of j reaches 10:

for (i in 1.100) {

printin("Outer loop i = $i")

for (j in 1..100) {

printin("Inner loop j = $j")

if (j == 10) break



As currently implemented, the break statement will exit the inner
for loop but execution will resume at the top of the outer for
loop. Suppose, however, that the break statement is required to
also exit the outer loop. This can be achieved by assigning a label
to the outer loop and referencing that label with the break

statement as follows:

outerloop@ for (i in 1..100) {

printin("Outer loop i = $i")

for (j in 1..100) {

printin("Inner loop j = $j")

if (j == 10)

Now when the value assigned to variable j reaches 10 the break
statement will break out of both loops and resume execution at

the line of code immediately following the outer loop.



14.2 Conditional control flow

In the previous chapter, we looked at how to use logical
expressions in Kotlin to determine whether something is true or
Since programming is largely an exercise in applying logic, much
of the art of programming involves writing code that makes
decisions based on one or more criteria. Such decisions define
which code gets executed and, conversely, which code gets

bypassed when the program is executing.



14.2.1 Using the if expressions

The if expression is perhaps the most basic of control flow
options available to the Kotlin programmer. Programmers who are
familiar with C, Swift, C++, or Java will immediately be
comfortable using Kotlin if statements, although there are some

subtle differences.

The basic syntax of the Kotlin if expression is as follows:

if (boolean expression) {

/| Kotlin code to be performed when expression evaluates to

true

Unlike some other programming languages, it is important to note
that the braces are optional in Kotlin if only one line of code is
associated with the if expression. In fact, in this scenario, the

statement is often placed on the same line as the if expression.

Essentially if the Boolean expression evaluates to true then the code

in the body of the statement is executed. If, on the other hand,



the expression evaluates to false the code in the body of the

statement is skipped.

For example, if a decision needs to be made depending on
whether one value is greater than another, we would write code

similar to the following:

val x = 10

if (x > 9) println("x is greater than g!")

Clearly, x is indeed greater than 9 causing the message to appear

in the console panel.

At this point, it is important to notice that we have been referring
to the if expression instead of the if statement. The reason for
this is that unlike the if statement in other programming
languages, the Kotlin if returns a result. This allows if constructs
to be used within expressions. As an example, a typical if
expression to identify the largest of two numbers and assign the

result to a variable might read as follows:

if (x >y)

largest = x

else



largest =y

The same result can be achieved using the if statement within an

expression using the following syntax:

variable = if (condition) return_val_1 else return_val_2

The original example can, therefore be re-written as follows:

val largest = if (x > y) x else y

The technique is not limited to returning the values contained
within the condition. The following example is also a valid use of
if in an expression, in this case assigning a string value to the

variable:

val largest = if (x > y) "x is greatest" else "y is greatest"

println(largest)

For those familiar with programming languages such as Java, this
feature allows code constructs similar to ternary statements to be

implemented in Kotlin.



14.2.2 Using if ... else ... expressions

The next variation of the if expression allows us to also specify
some code to perform if the expression in the if expression

evaluates to The syntax for this construct is as follows:

if (boolean expression) {

/| Code to be executed if expression is true

} else {

/| Code to be executed if expression is false

The braces are, once again, optional if only one line of code is to

be executed.

Using the above syntax, we can now extend our previous example
to display a different message if the comparison expression

evaluates to be

val x = 10



if (x > 9) println("x is greater than g!")

else println("x is less than g!")

In this case, the second println statement will execute if the value

of x was less than .



14.2.3 Using if ... else if ... Expressions

So far we have looked at if statements that make decisions based
on the result of a single logical expression. Sometimes it becomes
necessary to make decisions based on several different criteria. For
this purpose, we can use the if ... else if ... construct, an example

of which is as follows:

var x = 9

if (x == 10) printIn("x is 10")

else if (x == g) println("x is 9")

else if (x == 8) println("x is 8")

else println("x is less than 8")



14.2.4 Using the when statement

The Kotlin when statement provides a cleaner alternative to the if

. else if ... construct and uses the following syntax:
when (value) {
match1 -> // code to be executed on match

match2 -> // code to be executed on match

else -> // default code to executed if no match

Using this syntax, the previous if ... else if ... construct can be

rewritten to use the when statement:

when (x) {



10 -> println ("x is 10")

9 -> println("x is 9")

& -> println("x is 8")

else -> printin("x is less than 8")

The when statement is similar to the switch statement found in

many other programming languages.



14.3 Summary

The term control flow is used to describe the logic that dictates
the execution path that is taken through the source code of an
application as it runs. This chapter has looked at the two types of
control flow provided by Kotlin (looping and conditional) and
explored the various Kotlin constructs that are available to

implement both forms of control flow logic.



15. An Overview of Kotlin Functions and Lambdas

Kotlin functions and lambdas are a vital part of writing well-
structured and efficient code and provide a way to organize
programs while avoiding code repetition. In this chapter, we will
look at how functions and lambdas are declared and used within

Kotlin.



15.1 What is a function?

A function is a named block of code that can be called upon to
perform a specific task. It can be provided data on which to
perform the task and is capable of returning results to the code
that called it. For example, if a particular arithmetic calculation
needs to be performed in a Kotlin program, the code to perform
the arithmetic can be placed in a function. The function can be
programmed to accept the values on which the arithmetic is to
be performed (referred to as parameters) and to return the result
of the calculation. At any point in the program code where the
calculation is required, the function is simply called, parameter

values passed through as arguments and the result returned.

The terms parameter and argument are often used interchangeably
when discussing functions. There is, however, a subtle difference.
The values that a function can accept when it is called are
referred to as parameters. At the point that the function is called
and passed those values, however, they are referred to as

arguments.



15.2 How to declare a Kotlin function

A Kotlin function is declared using the following syntax:

fun name> (name>: type>, name>: type>, ... ): type> {

/| Function code

This combination of function name, parameters, and return type is
referred to as the function signature or Explanations of the various

fields of the function declaration are as follows:

«fun — The prefix keyword used to notify the Kotlin compiler that

this is a function.

«name> - The name assigned to the function. This is the name
by which the function will be referenced when it is called from

within the application code.

ename> - The name by which the parameter is to be referenced

in the function code.

«type> - The type of the corresponding parameter.



«type> - The data type of the result returned by the function. If
the function does not return a result then no return type is

specified.

«Function code - The code of the function that does the work.

As an example, the following function takes no parameters,

returns no result, and simply displays a message:

fun sayHello() {

printin("Hello")

The following sample function, on the other hand, takes an

integer and a string as parameters and returns a string result:

fun buildMessageFor(name: String, count: Int): String {

return("$name, you are customer number $count")



15.3 Calling a Kotlin function

Once declared, functions are called using the following syntax:

hame> (, , ... )

Each argument passed through to a function must match the
parameters the function is configured to accept. For example, to
call a function named sayHello that takes no parameters and

returns no value, we would write the following code:

sayHello()

In the case of a message that accepts parameters, the function

could be called as follows:

buildMessageFor("John", 10)



15.4 Single expression functions

When a function contains a single expression, it is not necessary
to include the braces around the expression. All that is required is
an equals sign (=) after the function declaration followed by the
expression. The following function contains a single expression

declared in the usual way:

fun multiply(x: Int, y: Int): Int {

return x * vy

Below is the same function expressed as a single line expression:

fun multiply(x: Int, y: Int): Int = x *y

When using single-line expressions, the return type may be
omitted in situations where the compiler can infer the type

returned by the expression making for even more compact code:

1.

fun multiply(x: Int, y: Int) = x *



15.5 Local functions

A local function is a function that is embedded within another
function. In addition, a local function has access to all of the

variables contained within the enclosing function:

fun main(args: Array) {

val name = "John"

val count = g

fun displayString() {

for (index in o..count) {

printin(name)

displayString()



15.6 Handling return values

To call a function named buildMessage that takes two parameters
and returns a result, on the other hand, we might write the

following code:

val message = buildMessageFor("John", 10)

To improve code readability, the parameter names may also be

specified when making the function call:

val message = buildMessageFor(name = "John", count = 10)

In the above examples, we have created a new variable called
message and then used the assignment operator (=) to store the

result returned by the function.



15.7 Declaring default function parameters

Kotlin provides the ability to designate a default parameter value
to be used if the value is not provided as an argument when the
function is called. This simply involves assigning the default value

to the parameter when the function is declared.

To see default parameters in action the buildMessageFor function
will be modified so that the string “Customer” is used as a
default if a customer name is not passed through as an
argument. Similarly, the count parameter is declared with a default

value of o:

fun buildMessageFor(name: String = count: Int = String {

return("$name, you are customer number $count")

When parameter names are used when making the function call,
any parameters for which defaults have been specified may be
omitted. The following function call, for example, omits the
customer name argument but still compiles because the parameter

name has been specified for the second argument:

val message = buildMessageFor(count = 10)



If parameter names are not used within the function call, however,

only the trailing arguments may be omitted:

buildMessageFor("John") // Valid

val message

val message = buildMessageFor(10) // Invalid



15.8 Variable number of function parameters

It is not always possible to know in advance the number of
parameters a function will need to accept when it is called within
the application code. Kotlin handles this possibility through the
use of the vararg keyword to indicate that the function accepts an
arbitrary number of parameters of a specified data type. Within
the body of the function, the parameters are made available in
the form of an array object. The following function, for example,
takes as parameters a variable number of String values and then

outputs them to the console panel:

fun displayStrings(vararg strings: String)

for (string in strings) {

println(string)

displayStrings("one", "two", "three", "four")



Kotlin does not permit multiple vararg parameters within a
function and any single parameters supported by the function

must be declared before the vararg declaration:

fun displayStrings(name: String, vararg strings: String)

for (string in strings) {

println(string)



15.9 Lambda expressions

Having covered the basics of functions in Kotlin it is now time to
look at the concept of lambda expressions. Essentially, lambdas
are self-contained blocks of code. The following code, for example,
declares a lambda, assigns it to a variable named sayHello, and

then calls the function via the lambda reference:

val sayHello = { printin("Hello") }

sayHello()

Lambda expressions may also be configured to accept parameters

and return results. The syntax for this is as follows:

{name>: type>, name> type>, ... ->

/| Lambda expression here

The following lambda expression, for example, accepts two integer

parameters and returns an integer result:

val multiply = { vali: Int, val2: Int -> vali * val2 }



val result = multiply(ro, 20)

Note that the above lambda examples have assigned the lambda
code block to a variable. This is also possible when working with
functions. Of course, the following syntax will execute the function
and assign the result of that execution to a variable, instead of

assigning the function itself to the variable:

val myvar = myfunction()

To assign a function reference to a variable, simply remove the
parentheses and prefix the function name with double colons (:)
as follows. The function may then be called simply by referencing

the variable name:

val myvar = :myfunction

myvar ()

A lambda block may be executed directly by placing parentheses

at the end of the expression including any arguments. The

following lambda directly executes the multiplication lambda

expression multiplying 10 by 20.

val result = { vali: Int, val2: Int -> vali * valz2 }(10, 20)



The last expression within a lambda serves as the expression’s
return value (hence the value of 200 being assigned to the result
variable in the above multiplication examples). In fact, unlike
functions, lambdas do not support the return statement. In the
absence of an expression that returns a result (such as an
arithmetic or comparison expression), simply declaring the value
as the last item in the lambda will cause that value to be
returned. The following lambda returns the Boolean true value

after printing a message:

val result = { printIn("Hello"); true }()

Similarly, the following lambda simply returns a string literal:

val nextmessage = { println("Hello"); "Goodbye" }()

A particularly useful feature of lambdas and the ability to create
function references is that they can be both passed to functions
as arguments and returned as results. This concept, however,
requires an understanding of function types and higher-order

functions.



15.10 Higher-order functions

On the surface, lambdas and function references do not seem to
be particularly compelling features. The possibilities that these
features offer become more apparent, however, when we consider
that lambdas and function references have the same capabilities
as many other data types. In particular, these may be passed
through as arguments to another function, or even returned as a

result from a function.

A function that is capable of receiving a function or lambda as an
argument, or returning one as a result is referred to as a higher-

order

Before we look at what is, essentially, the ability to plug one
function into another, it is first necessary to explore the concept
of function The type of a function is dictated by a combination of
the parameters it accepts and the type of result it returns. A
function that accepts an Int and a Double as parameters and
returns a String result for example is considered to have the

following function type:

(Int, Double) -> String

To accept a function as a parameter, the receiving function simply

declares the type of function it can accept.



As an example, we will begin by declaring two unit conversion

functions:

fun inchesToFeet (inches: Double): Double {

return inches * 0.0833333

fun inchesToYards (inches: Double): Double {

return inches * 0.0277778

The example now needs an additional function, the purpose of
which is to perform a unit conversion and print the result in the
console panel. This function needs to be as general-purpose as
possible, capable of performing a variety of different measurement
unit conversions. To demonstrate functions as parameters, this
new function will take as a parameter a function type that
matches both the inchesToFeet and inchesToYards functions
together with a value to be converted. Since the type of these
functions is equivalent to (Double) -> Double, our general-purpose

function can be written as follows:



fun outputConversion(converterFunc: (Double) -> Double, value:
Double) {

val result = converterFunc(value)

println("Result of conversion is $result")

When the outputConversion function is called, it will need to be
passed a function matching the declared type. That function will
be called to perform the conversion and the result displayed in
the console panel. This means that the same function can be
called to convert inches to both feet and yards, simply by
“plugging in” the appropriate converter function as a parameter,
keeping in mind that it is the function reference that is being

passed as an argument:

outputConversion(::inchesToFeet, 22.45)

outputConversion(::inchesToYards, 22.45)

Functions can also be returned as a data type simply by declaring
the type of the function as the return type. The following function
is configured to return either our inchesToFeet or inchesToYards

function type (in other words a function that accepts and returns

a Double value) based on the value of a Boolean parameter:



fun decideFunction(feet: Boolean): (Double) -> Double

if (feet) {

return :inchesToFeet

} else {

return ::inchesToYards

When called, the function will return a function reference which

can then be used to perform the conversion:

val converter = decideFunction(true)

val result = converter(22.4)

println(result)



15.11 Summary

Functions and lambda expressions are self-contained blocks of
code that can be called upon to perform a specific task and
provide a mechanism for structuring code and promoting reuse.
This chapter has introduced the basic concepts of function and
lambda declaration and implementation in addition to the use of
higher-order functions that allow lambdas and functions to be

passed as arguments and returned as results.



16. The Basics of Object-Oriented Programming in Kotlin

Kotlin provides extensive support for developing object-oriented
applications. The subject area of object-oriented programming is,
however, large. As such, a detailed overview of object-oriented
software development is beyond the scope of this book. Instead,
we will introduce the basic concepts involved in object-oriented
programming and then move on to explaining the concept as it

relates to Kotlin application development.



16.1 What is an object?

Objects (also referred to as instances) are self-contained modules
of functionality that can be easily used and re-used as the

building blocks for a software application.

Objects consist of data variables (called properties) and functions
(called methods) that can be accessed and called on the object or
instance to perform tasks and are collectively referred to as class

members.



16.2 What is a class?

Much as a blueprint or architect’s drawing defines what an item
or a building will look like once it has been constructed, a class
defines what an object will look like when it is created. It defines,
for example, what the methods will do and what the properties

will be.



16.3 Declaring a Kotlin class

Before an object can be instantiated, we first need to define the
class ‘blueprint’ for the object. In this chapter, we will create a
bank account class to demonstrate the basic concepts of Kotlin

object-oriented programming.

In declaring a new Kotlin class we specify an optional parent
class from which the new class is derived and also define the
properties and methods that the class will contain. The basic

syntax for a new class is as follows:

class NewClassName: ParentClass {

/| Properties

/| Methods

The Properties section of the declaration defines the variables and
constants that are to be contained within the class. These are
declared in the same way that any other variable would be

declared in Kotlin.



The Methods sections define the methods that are available to be
called on the class and instances of the class. These are

essentially functions specific to the class that perform a particular
operation when called upon and will be described in greater detail

later in this chapter.

To create an example outline for our BankAccount class, we would

use the following:

class BankAccount {

Now that we have the outline syntax for our class, the next step

is to add some properties to it.



16.4 Adding properties to a class

A key goal of object-oriented programming is a concept referred
to as data encapsulation. The idea behind data encapsulation is
that data should be stored within classes and accessed only

through methods defined in that class. Data encapsulated in a

class are referred to as properties or instance variables.

Instances of our BankAccount class will be required to store some
data, specifically a bank account number and the balance currently
held within the account. Properties are declared in the same way
any other variables are declared in Kotlin. We can, therefore, add

these variables as follows:

class BankAccount {

var accountBalance: Double = 0.0

var accountNumber: Int = o

Having defined our properties, we can now move on to defining
the methods of the class that will allow us to work with our

properties while staying true to the data encapsulation model.



16.5 Defining methods

The methods of a class are essentially code routines that can be
called upon to perform specific tasks within the context of that

class.

Methods are declared within the opening and closing braces of
the class to which they belong and are declared using the

standard Kotlin function declaration syntax.

For example, the declaration of a method to display the account

balance in our example might read as follows:

class BankAccount {

var accountBalance: Double = 0.0

var accountNumber: Int = o

fun displayBalance()

printin("Number $accountNumber")

printin("Current balance is $accountBalance")






16.6 Declaring and initializing a class instance

So far all we have done is define the blueprint for our class. To
do anything with this class, we need to create instances of it. The
first step in this process is to declare a variable to store a
reference to the instance when it is created. We do this as

follows:

val accounti: BankAccount = BankAccount()

When executed, an instance of our BankAccount class will have
been created and will be accessible via the account1 variable. Of
course, the Kotlin compiler will be able to use inference here,

making the type declaration optional:

val account1 = BankAccount()



16.7 Primary and secondary constructors

A class will often need to perform some initialization tasks at the
point of creation. These tasks can be implemented using
constructors within the class. In the case of the BankAccount
class, it would be useful to be able to initialize the account
number and balance properties with values when a new class
instance is created. To achieve this, a secondary constructor can be

declared within the class header as follows:

class BankAccount {

var accountBalance: Double = 0.0

var accountNumber: Int = o

constructor(number: Int, balance: Double) {

accountNumber = number

accountBalance = balance



When creating an instance of the class, it will now be necessary
to provide initialization values for the account number and

balance properties as follows:

val account1: BankAccount = BankAccount(456456234, 342.98)

A class can contain multiple secondary constructors allowing
instances of the class to be initiated with different value sets. The
following variation of the BankAccount class includes an additional
secondary constructor for use when initializing an instance with
the customer’s last name in addition to the corresponding account
number and balance:
class BankAccount {

var accountBalance: Double = 0.0

var accountNumber: Int = o

var lastName: String = ""

constructor(number: Int,



balance: Double) {

accountNumber = number

accountBalance = balance

constructor(number: Int,

balance: Double,

name: String ) {

accountNumber = number

accountBalance = balance

lastName = name



Instances of the BankAccount may now also be created as follows:

val account1: BankAccount = BankAccount(456456234, 342.98,
"Smith")

It is also possible to use a primary constructor to perform basic
initialization tasks. The primary constructor for a class is declared

within the class header as follows:

class BankAccount (val accountNumber: Int, var accountBalance:
Double) {

fun displayBalance()

printin("Number $accountNumber")

printin("Current balance is $accountBalance")



Note that now both properties have been declared in the primary
constructor, it is no longer necessary to also declare the variables
within the body of the class. Since the account number will now
not change after an instance of the class has been created, this

property is declared as being immutable using the val keyword.

Although a class may only contain one primary constructor, Kotlin
allows multiple secondary constructors to be declared in addition
to the primary constructor. In the following class declaration the
constructor that handles the account number and balance is
declared as the primary constructor while the variation that also
accepts the user’s last name is declared as a secondary

constructor:

class BankAccount (val accountNumber: Int, var accountBalance:
Double) {

var lastName: String = ""

constructor(accountNumber: Int,

accountBalance: Double,



name: String ) : this(accountNumber,

accountBalance) {

lastName = name

In the above example, two key points need to be noted. First,
since the lastName property is referenced by a secondary
constructor, the variable is not handled automatically by the
primary constructor and must be declared within the body of the

class and initialized within the constructor.

var lastName: String =

lastName = name



Second, although the accountNumber and accountBalance
properties are accepted as parameters to the secondary
constructor, the variable declarations are still handled by the
primary constructor and do not need to be declared. To associate
the references to these properties in the secondary constructor
with the primary constructor, however, they must be linked back

to the primary constructor using the this keyword:

... this{(accountNumber, accountBalance)...



16.8 Initializer blocks

In addition to the primary and secondary constructors, a class
may also contain initializer blocks which are called after the
constructors. Since a primary constructor cannot contain any code,
these methods are a particularly useful location for adding code
to perform initialization tasks when an instance of the class is
created. Initializer blocks are declared using the init keyword with

the initialization code enclosed in braces:

class BankAccount (val accountNumber: Int, var accountBalance:
Double) {

init {

/| Initialization code goes here



16.9 Calling methods and accessing properties

Now is probably a good time to recap what we have done so far
in this chapter. We have now created a new Kotlin class named
BankAccount. Within this new class, we declared primary and
secondary constructors to accept and initialize account number,
balance, and customer name properties. In the preceding sections,
we also covered the steps necessary to create and initialize an
instance of our new class. The next step is to learn how to call
the instance methods and access the properties we built into our

class. This is most easily achieved using dot notation.

Dot notation involves accessing a property, or calling a method by
specifying a class instance followed by a dot followed in turn by

the name of the property or method:

classInstance.propertyname

classinstance.methodname()

For example, to get the current value of our accountBalance

instance variable:

val balance1 = accounti.accountBalance



Dot notation can also be used to set values of instance

properties:

accounti.accountBalance = 6789.98

The same technique is used to call methods on a class instance.
For example, to call the displayBalance method on an instance of

the BankAccount class:

accounti.displayBalance()



16.10 Custom accessors

When accessing the accountBalance property in the previous
section, the code is making use of property accessors that are
provided automatically by Kotlin. In addition to these default
accessors, it is also possible to implement custom accessors that
allow calculations or other logic to be performed before the

property is returned or set.

Custom accessors are implemented by creating getter and optional
corresponding setter methods containing the code to perform any
tasks before returning the property. Consider, for example, that the
BankAcccount class might need an additional property to contain
the current balance less any recent banking fees. Rather than use
a standard accessor, it makes more sense to use a custom
accessor that calculates this value on request. The modified

BankAccount class might now read as follows:

class BankAccount (val accountNumber: Int, var accountBalance:
Double) {

val fees: Double = 25.00

val balanceLessFees: Double

get() {



return accountBalance - fees

fun displayBalance()

printin("Number $accountNumber")

printin("Current balance is $accountBalance")

The above code adds a getter that returns a computed property
based on the current balance minus a fee amount. An optional
setter could also be declared in much the same way to set the

balance value less fees:

val fees: Double = 25.00

var balancelessFees: Double



get() {

return accountBalance - fees

set(value) {

accountBalance = value - fees

The new setter takes as a parameter a Double value from which
it deducts the fee value before assigning the result to the current
balance property. Even though these are custom accessors, they
are accessed in the same way as stored properties using dot-
notation. The following code gets the current balance less the fees

value before setting the property to a new value:

val balance1 = accounti.balancelessFees



accounti.balancelLessFees = 12123.12



16.11 Nested and inner classes

Kotlin allows one class to be nested within another class. In the

following code, for example, ClassB is nested inside ClassA:

class ClassA {

class ClassB {

In the above example, ClassB does not have access to any of the
properties within the outer class. If access is required, the nested
class must be declared using the inner directive. In the example
below ClassB now has access to the myProperty variable belonging
to ClassA:

class ClassA {

var myProperty: Int = 10

inner class ClassB {

val result = 20 + myProperty






16.12 Companion objects

A Kotlin class can also contain a companion object. A companion
object contains methods and variables that are common to all
instances of the class. In addition to being accessible via class
instances, these properties are also accessible at the class level
(in other words without the need to create an instance of the

class).

The syntax for declaring a companion object within a class is as

follows:

class ClassName: ParentClass {

/| Properties

/| Methods

companion object {

/| properties

/| methods



To experience a companion object example in action, enter the

following into the Kotlin online playground at https://try.kotl.in:

class MyClass {

fun showCount() {

println("counter = " + counter)

companion object {

var counter = 1

fun counterUp() {

counter += 1


https://try.kotl.in

fun main(args: Array) {

println(MyClass.counter)

The class contains a companion object consisting of a counter
variable and a method to increment that variable. The class also
contains a method to display the current counter value. The
main() method simply displays the current value of the counter
variable, but does so by calling the method on the class itself

instead of a class instance:

Modify the main() method to also increment the counter,

displaying the current value both before and after:

fun main(args: Array) {

println(MyClass.counter)

MyClass.counterUp()

printin(MyClass.counter)



Run the code and verify that the following output appears in the

console:

Next, add some code to create an instance of MyClass before

making a call to the showCount() method:

fun main(args: Array) {

println(MyClass.counter)

MyClass.counterUp()

println(MyClass.counter)

val instanceA = MyClass()

instanceA.showCount()

When executed, the following output will appear in the console:



counter = 2

Clearly, the class has access to the variables and methods

contained within the companion object.

Another useful aspect of companion objects is that all instances
of the containing class see the same companion object, including
current variable values. To see this in action, create a second
instance of MyClass and call the showCount() method on that

instance:

fun main(args: Array) {

println(MyClass.counter)

MyClass.counterUp()

println(MyClass.counter)

val instanceA = MyClass()

instanceA.showCount()



val instanceB = MyClass|()

instanceB.showCount()

When run, the code will produce the following console output:

counter = 2

counter = 2

Note that both instances return the incremented value of 2,
showing that the two class instances are sharing the same

companion object data.



16.13 Summary

Object-oriented programming languages such as Kotlin encourage
the creation of classes to promote code reuse and the
encapsulation of data within class instances. This chapter has
covered the basic concepts of classes and instances within Kotlin
together with an overview of primary and secondary constructors,
initializer blocks, properties, methods, companion objects, and

custom accessors.



17. An Introduction to Kotlin Inheritance and Subclassing

In “The Basics of Object-Oriented Programming_in Kotlin” we

covered the basic concepts of object-oriented programming and

worked through an example of creating and working with a new
class using Kotlin. In that example, our new class was not
specifically derived from a base class (though in practice, all
Kotlin classes are ultimately derived from the Any class). In this
chapter, we will provide an introduction to the concepts of

subclassing, inheritance, and extensions in Kotlin.



17.1 Inheritance, classes, and subclasses

The concept of inheritance brings something of a real-world view
to programming. It allows a class to be defined that has a certain
set of characteristics (such as methods and properties) and then
other classes to be created which are derived from that class. The
derived class inherits all of the features of the parent class and
typically then adds some features of its own. In fact, all classes in
Kotlin are ultimately subclasses of the Any superclass which

provides the basic foundation on which all classes are based.

By deriving classes, we create what is often referred to as a class
hierarchy. The class at the top of the hierarchy is known as the
base class or root class and the derived classes as subclasses or
child classes. Any number of subclasses may be derived from a
class. The class from which a subclass is derived is called the

parent class or superclass.

Classes need not only be derived from a root class. For example,
a subclass can also inherit from another subclass with the

potential to create large and complex class hierarchies.

In Kotlin a subclass can only be derived from a single direct

parent class. This is a concept referred to as single inheritance.



17.2 Subclassing syntax

As a safety measure designed to make Kotlin code less prone to
error, before a subclass can be derived from a parent class, the
parent class must be declared as open. This is achieved by

placing the open keyword within the class header:

open class MyParentClass {

var myProperty: Int = o

With a simple class of this type, the subclass can be created as f

ollows:

class MySubClass : MyParentClass() {

For classes containing primary or secondary constructors, the rules
for creating a subclass are slightly more complicated. Consider the

following parent class which contains a primary constructor:

open class MyParentClass(var myProperty: Int) {



To create a subclass of this class, the subclass declaration
references any base class parameters while also initializing the

parent class using the following syntax:

class : {

If, on the other hand, the parent class contains one or more
secondary constructors, the constructors must also be
implemented within the subclass declaration and include a call to
the secondary constructors of the parent class, passing through as
arguments the values passed to the subclass secondary
constructor. When working with subclasses, the parent class can
be referenced using the super keyword. A parent class with a

secondary constructor might read as follows:

open class MyParentClass {

var myProperty: Int = o

constructor(number: Int) {

myProperty = number



The code for the corresponding subclass would need to be

implemented as follows:

class MySubClass : MyParentClass {

constructor(number: Int) : super(number)

If additional tasks need to be performed within the constructor of
the subclass, this can be placed within curly braces after the

constructor declaration:

class MySubClass : MyParentClass {

constructor(number: Int) : super(number) {

/| Subclass constructor code here



17.3 A Kotlin inheritance example

As with most programming concepts, the subject of inheritance in
Kotlin is perhaps best illustrated with an example. In “The Basics

of Object-Oriented Programming_in_Kotlin” we created a class

named BankAccount designed to hold a bank account number and
corresponding current balance. The BankAccount class contained
both properties and methods. A simplified declaration for this
class is reproduced below and will be used for the basis of the

subclassing example in this chapter:

class BankAccount {

var accountNumber = o

var accountBalance = 0.0

constructor(number: Int, balance: Double) {

accountNumber = number

accountBalance = balance

open fun displayBalance()



printin("Number $accountNumber")

printin("Current balance is $accountBalance")

Though this is a somewhat rudimentary class, it does everything
necessary if all you need it to do is store an account number and
account balance. Suppose, however, that in addition to the
BankAccount class you also needed a class to be used for savings
accounts. A savings account will still need to hold an account
number and a current balance and methods will still be needed
to access that data. One option would be to create an entirely
new class, one that duplicates all of the functionality of the
BankAccount class together with the new features required by a
savings account. A more efficient approach, however, would be to
create a new class that is a subclass of the BankAccount class.
The new class will then inherit all the features of the BankAccount
class but can then be extended to add the additional functionality
required by a savings account. Before a subclass of the
BankAccount class can be created, the declaration needs to be

modified to declare the class as open:



open class BankAccount {

To create a subclass of BankAccount that we will call
SavingsAccount, we simply declare the new class, this time
specifying BankAccount as the parent class and add code to call

the constructor on the parent class:

class SavingsAccount : BankAccount {

constructor(accountNumber: Int, accountBalance: Double) :

super(accountNumber, accountBalance)

Note that although we have yet to add any properties or
methods, the class has inherited all the methods and properties
of the parent BankAccount class. We could, therefore, create an
instance of the SavingsAccount class and set variables and call
methods in the same way we did with the BankAccount class in
previous examples. That said, we haven’t achieved anything unless

we take steps to extend the class.



17.4 Extending the functionality of a subclass

So far we have been able to create a subclass that contains all
the functionality of the parent class. For this exercise to make
sense, however, we now need to extend the subclass so that it
has the features we need to make it useful for storing savings
account information. To do this, we simply add the properties and
methods that provide the new functionality, just as we would for

any other class we might wish to create:

class SavingsAccount : BankAccount {

var interestRate: Double = 0.0

constructor(accountNumber: Int, accountBalance: Double) :

super(accountNumber,

accountBalance)

fun calculatelnterest(): Double

return interestRate * accountBalance






17.5 Overriding inherited methods

When using inheritance it is not unusual to find a method in the
parent class that almost does what you need, but requires
modification to provide the precise functionality you require. That
being said, it is also possible you'll inherit a method with a name
that describes exactly what you want to do, but it does not come
close to doing what you need. One option in this scenario would
be to ignore the inherited method and write a new method with
an entirely new name. A better option is to override the inherited

method and write a new version of it in the subclass.

Before proceeding with an example, three rules that must be
obeyed when overriding a method. First, the overriding method in
the subclass must accept the same number and type of
parameters as the overridden method in the parent class. Second,
the new method must have the same return type as the parent
method. Finally, the original method in the parent class must be
declared as open before the compiler will allow it to be

overridden.

In our BankAccount class, we have a method named
displayBalance that displays the bank account number and current
balance held by an instance of the class. In our SavingsAccount
subclass, we might also want to output the current interest rate

assigned to the account. To achieve this, we simply declare a new



version of the displayBalance method in our SavingsAccount

subclass, prefixed with the override keyword:

class SavingsAccount : BankAccount {

var interestRate: Double = 0.0

constructor(accountNumber: Int, accountBalance: Double) :

super(accountNumber, accountBalance)

fun calculatelnterest(): Double

.

return interestRate *

accountBalance

override fun displayBalance()

printin("Number $accountNumber")

printin("Current balance is $accountBalance")



printin("Prevailing interest rate is $interestRate")

Before this code will compile, the displayBalance method in the

BankAccount class must be declared as open:

open fun displayBalance()

printin("Number $accountNumber")

printin("Current balance is $accountBalance")

It is also possible to make a call to the overridden method in the
superclass from within a subclass. The displayBalance method of
the superclass could, for example, be called to display the account
number and balance, before the interest rate is displayed, thereby

eliminating further code duplication:

override fun displayBalance()



super.displayBalance()

printin("Prevailing interest rate is SinterestRate")



17.6 Adding a custom secondary constructor

As the SavingsAccount class currently stands, it makes a call to
the secondary constructor from the parent BankAccount class

which was implemented as follows:

constructor(accountNumber: Int, accountBalance: Double) :

super(accountNumber, accountBalance)

Clearly this constructor takes the necessary steps to initialize both
the account number and balance properties of the class. The
SavingsAccount class, however, contains an additional property in
the form of the interest rate variable. The SavingsAccount class,
therefore, needs its own constructor to ensure that the
interestRate property is initialized when instances of the class are
created. Modify the SavingsAccount class one last time to add an
additional secondary constructor allowing the interest rate to also

be specified when class instances are initialized:

class SavingsAccount : BankAccount {

var interestRate: Double = 0.0

constructor(accountNumber: Int, accountBalance: Double) :



super({accountNumber, accountBalance)

constructor(accountNumber: Int, accountBalance: Double, rate:
Double) :

super(accountNumber,

accountBalance) {

interestRate = rate



17.7 Using the SavingsAccount class

Now that we have completed work on our SavingsAccount class,
the class can be used in some example code in much the same

way as the parent BankAccount class:

val savings1 = SavingsAccount(12311, 600.00, 0.07)

println(savingsi.calculatelnterest())

savingsi.displayBalance()



17.8 Summary

Inheritance extends the concept of object re-use in object oriented
programming by allowing new classes to be derived from existing
classes, with those new classes subsequently extended to add new
functionality. When an existing class provides some, but not all, of
the functionality required by the programmer, inheritance allows
that class to be used as the basis for a new subclass. The new
subclass will inherit all the capabilities of the parent class, but

may then be extended to add the missing functionality.



18. An Overview of Compose

Now that Android Studio has been installed and the basics of the
Kotlin programing language covered, it is time to start introducing

Jetpack Compose.

Jetpack Compose is an entirely new approach to developing apps
for all of Google’s operating system platforms. The basic goals of
Compose are to make app development easier, faster, and less
prone to the types of bugs that typically appear when developing
software projects. These elements have been combined with
Compose-specific additions to Android Studio that allow Compose
projects to be tested in near real-time using an interactive preview

of the app during the development process.

Many of the advantages of Compose originate from the fact that
it is both declarative and topics which will be explained in this

chapter.

The discussion in this chapter is intended as a high-level overview
of Compose and does not cover the practical aspects of
implementation within a project. Implementation and practical

examples will be covered in detail in the remainder of the book.



18.1 Development before Compose

To understand the meaning and advantages of the Compose
declarative syntax, it helps to understand how user interface
layouts were designed before the introduction of Compose.
Previously, Android apps were still built entirely using Android
Studio together with a collection of associated frameworks that

make up the Android Development Kit.

To aid in the design of the user interface layouts that make up
the screens of an app, Android Studio includes a tool called the
Layout Editor. The Layout Editor is a powerful tool that allows

XML files to be created which contain the individual components

that make up a screen of an app.

The user interface layout of a screen is designed within the
Layout Editor by dragging components (such as buttons, text, text
fields, and sliders) from a widget palette to the desired location
on the layout canvas. Selecting a component in a scene provides
access to a range of property panels where the attributes of the

components can be changed.

The layout behavior of the screen (in other words how it reacts
to different device screen sizes and changes to device orientation
between portrait and landscape) is defined by configuring a range

of constraints that dictate how each component is positioned and



sized in relation to both the containing window and the other

components in the layout.

Finally, any components that need to respond to user events
(such as a button tap or slider motion) are connected to

methods in the app source code where the event is handled.

At various points during this development process, it is necessary
to compile and run the app on a simulator or device to test that

everything is working as expected.



18.2 Compose declarative syntax

Compose introduces a declarative syntax that provides an entirely
different way of implementing user interface layouts and behavior
from the Layout Editor approach. Instead of manually designing
the intricate details of the layout and appearance of components
that make up a scene, Compose allows the scenes to be
described using a simple and intuitive syntax. In other words,
Compose allows layouts to be created by declaring how the user
interface should appear without having to worry about the

complexity of how the layout is built.

This essentially involves declaring the components to be included
in the layout, stating the kind of layout manager in which they
are to be contained (column, row, box, list, etc.), and using
modifiers to set attributes such as the text on a button, the
foreground color of a label, or the handler to be called in the
event of a tap gesture. Having made these declarations, all the
intricate and complicated details of how to position, constrain and
render the layout are handled automatically by Compose. Compose
declarations are structured hierarchically, which also makes it easy
to create complex views by composing together small, re-usable

custom sub-views.

While a layout is being declared and tested, Android Studio
provides a preview canvas that changes in real-time to reflect the

appearance of the layout. Android Studio also includes an



interactive mode which allows the app to be launched within the
preview canvas and fully tested without the need to build and run

oh a simulator or device.

Coverage of the Compose declaration syntax begins with the

chapter entitled “Composable Functions



18.3 Compose is data-driven

When we say that Compose is data-driven, this is not to say that
it is no longer necessary to handle events generated by the user
(in other words the interaction between the user and the app user
interface). It is still necessary, for example, to know when the user
taps a button or moves a slider and to react in some app-specific
way. Being data-driven relates more to the relationship between

the underlying app data and the user interface and logic of the
app.

Before the introduction of Compose, an Android app would
contain code responsible for checking the current values of data
within the app. If data was likely to change over time, code had
to be written to ensure that the user interface always reflected the
latest state of the data (perhaps by writing code to frequently
check for changes to the data, or by providing a refresh option
for the user to request a data update). Similar challenges arise
when keeping the user interface state consistent and making sure
issues like toggle button settings are stored appropriately.
Requirements such as these can become increasingly complex

when multiple areas of an app depend on the same data sources.

Compose addresses this complexity by providing a system that is
based on Data that is stored as state ensures that any changes

to that data are automatically reflected in the user interface



without the need to write any additional code to detect the
change. Any user interface component that accesses a state is
essentially subscribed to that state. When the state is changed
anywhere in the app code, any subscriber components to that
data will be destroyed and recreated to reflect the data change in
a process called This ensures that when any state on which the
user interfaces is dependent changes, all components that rely on
that data will automatically update to reflect the latest state. State

and recomposition will be covered in the chapter entitled “An

Qverview of Compose State and



18.4 Summary

Jetpack introduces a different approach to app development than
that offered by the Android Studio Layout Editor. Rather than
directly implement the way in which a user interface is to be
rendered, Compose allows the user interface to be declared in
descriptive terms and then does all the work of deciding the best

way to perform the rendering when the app runs.

Compose is also data-driven in that data changes drive the
behavior and appearance of the app. This is achieved through

states and recomposition.

This chapter has provided a very high-level view of Jetpack
Compose. The remainder of this book will explore Compose in

greater depth.



19. Composable Functions Overview

Composable functions are the building blocks used to create user
interfaces for Android apps when developing with Jetpack
Compose. In the ComposeDemo project created earlier in the
book, we made use of both the built-in compose functions
provided with Compose and also created our own functions. In
this chapter, we will explore composable functions in more detail,
including topics such as stateful and stateless functions, function
syntax, and the difference between foundation and material

composables.



19.1 What is a composable function?

Composable functions (also referred to as composables or are
special Kotlin functions that are used to create user interfaces
when working with Compose. A composable function is
differentiated from regular Kotlin functions in code using the

@Composable annotation.

When a composable is called, it is typically passed some data
and a set of properties that define how the corresponding section
of the user interface is to behave and appear when rendered to
the user in the running app. In essence, composable functions
transform data into user interface elements. Composables do not
return values in the traditional sense of the Kotlin function, but
instead, emit user interface elements to the Compose runtime

system for rendering.

Composable functions can call other composables to create a
hierarchy of components as demonstrated in the ComposeDemo
project. While a composable function may also call standard Kotlin

functions, standard functions may not call composable functions.

A typical Compose-based user interface will be comprised of a

combination of built-in and custom-built composables.



19.2 Stateful vs. stateless composables

Composable functions are categorized as being either stateful or
State, in the context of Compose, is defined as being any value
that can change during the execution of an app. For example, a
slider position value, the string entered into a text field, or the

current setting of a check box are all forms of state.

As we saw in the ComposeDemo project, a composable function
can store a state value which defines in some way how the
composable function, or those that it calls appear or behave. This
is achieved using the remember keyword and the mutableStateOf
function. Our DemoScreen composable, for example, stored the

current slider position as state using this technique:

@Composable

fun DemoScreen() {

var sliderPosition by remember { mutableStateOf(20f) }



Because the DemoScreen contains state, it is considered to be a
stateful composable. Now consider the DemoSlider composable

which reads as follows:

@Composable

fun DemoSlider(sliderPosition: Float, onPositionChange : (Float) ->

Unit ) {

Slider(

modifier = Modifier.padding(10.dp),

valueRange = 20f..40f,

value = sliderPosition,

onValueChange = onPositionChange

Although this composable is passed and makes use of the state

value stored by the DemoScreen, it does not itself store any state



value. DemoSlider is, therefore, considered to be a stateless

composable function.

The topic of state will be covered in greater detail in the chapter

entitled “An_Overview of Compose State and



19.3 Composable function syntax

Composable functions, as we already know, are declared using the
@Composable annotation and are written in much the same way
as a standard Kotlin function. We can, for example, declare a

composable function that does nothing as follows:

@Composable

fun MyFunction() {

We can also call other composables from within the function:

@Composable

fun MyFunction() {

Text("Hello")

Composables may also be implemented to accept parameters. The
following function accepts text, font weight, and color parameters

and passes them to the built-in Text composable. The fragment



also includes a preview composable to demonstrate how the

CustomText function might be called:

@Composable

fun CustomText(text: String, fontWeight: FontWeight, color: Color) {

Text(text = text, fontWeight = fontWeight, color = color)

@ Preview(showBackground = true)

@Composable

fun GreetingPreview() {

CustomText(text = "Hello Compose", fontWeight =
FontWeight.Bold,

color = Color.Magenta)

When previewed, magenta-colored bold text reading “Hello

Compose” will be rendered in the preview panel.



Just about any Kotlin logic code may be included in the body of
a composable function. The following composable, for example,
displays different text within a Column depending on the setting

of a built-in Switch composable:
@Composable
fun CustomSwitch() {
val checked = remember { mutableStateOf(true) }
Column {
Switch (
checked = checked.value,

onCheckedChange = { checked.value = it }

if (checked.value) {

Text("Switch is On")

} else {



Text("Switch is Off")

In the above example, we have declared a state value named
checked initialized to true and then constructed a Column
containing a Switch composable. The state of the Switch is based
on the value of checked and a lambda assigned as the
onCheckedChanged event handler. This lambda sets the checked
state to the current Switch setting. Finally, an if statement is used
to decide which of two Text composables are displayed depending
on the current value of the checked state. When run, the text

displayed will alternate between “Switch is on” and “Switch is

off”:



DefaultPreview

Switch is On

Figure 19-1

Similarly, we could use looping syntax to iterate through the items
in a list and display them in a Column separated by instances of

the Divider composable:
@Composable
fun CustomlList(items: List) {
Column {
for (item in items) {
Text(item)

Divider(color = Color.Black)



The following composable could be used to preview the above

function:

@ Preview(showBackground = true)

@Composable

fun GreetingPreview() {

MyApplicationTheme {

CustomList(listOf("One", "Two", "Three", "Four", "Five",
”SiX”))

Once built and refreshed, the composable will appear in the

Preview panel as shown in Figure 19-2 below:
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19.4 Foundation and Material composables

When developing apps with Compose we do so using a mixture
of our own composable functions (for example the CustomText
and CustomlList composables created earlier in the chapter)
combined with a set of ready to use components provided by the
Compose development kit (such as the Text, Button, Column and

Slider composables).

The composables bundled with Compose fall into three categories,

referred to as Foundation, and Material Design components.

Layout components provide a way to define both how components
are positioned on the screen, and how those components behave

in relation to each other. The following are all layout composables:

Foundation components are a set of minimal components that
provide basic user interface functionality. While these components
do not, by default, impose a specific style or theme, they can be
customized to provide any look and behavior you need for your

app. The following lists the set of Foundation components:



The Material Design components, on the other hand, have been
designed so that they match Google’'s Material theme guidelines

and include the following composables:



When choosing components, it is important to note that the
Foundation and Material Design components are not mutually
exclusive. You will inevitably use components from both categories
in your design since the Material Design category has components

for which there is no Foundation equivalent and vice versa.



19.5 Summary

In this chapter, we have looked at composable functions and
explored how they are used to construct Android-based user
interfaces. Composable functions are declared using the
@Composable annotation and use the same syntax as standard
Kotlin functions, including the passing and handling of parameters.
Unlike standard Kotlin functions, composable functions do not
return values. Instead, they emit user interface units to be
rendered by the Compose runtime. A composable function can be
either stateful or stateless depending on whether the function
stores a state value. The built-in composables are categorized as
either Layout, Foundation, or Material Desigh components. The
Material Design components conform with the Material style and
theme guidelines provided by Google to encourage consistent Ul

design.

One type of composable we have not yet introduced is the Slot
APl composable, a topic that will be covered later in the chapter

entitled “An_Overview of Compose Slot




20. An Overview of Compose State and Recomposition

State is the cornerstone of how the Compose system is
implemented. As such, a clear understanding of state is an
essential step in becoming a proficient Compose developer. In this
chapter, we will explore and demonstrate the basic concepts of
state and explain the meaning of related terms such as
unidirectional data flow, and state The chapter will also cover

saving and restoring state through configuration



20.1 The basics of state

In declarative languages such as Compose, state is generally
referred to as “a value that can change over time”. At first glance,
this sounds much like any other data in an app. A standard
Kotlin variable, for example, is by definition designed to store a
value that can change at any time during execution. State,

however, differs from a standard variable in two significant ways.

First, the value assigned to a state variable in a composable
function needs to be remembered. In other words, each time a
composable function containing state (a stateful is called, it must
remember any state values from the last time it was invoked. This
is different from a standard variable which would be re-initialized

each time a call is made to the function in which it is declared.

The second key difference is that a change to any state variable
has far reaching implications for the entire hierarchy tree of
composable functions that make up a user interface. To
understand why this is the case, we now need to talk about

recomposition.



20.2 Introducing recomposition

When developing with Compose, we build apps by creating
hierarchies of composable functions. As previously discussed, a
composable function can be thought of as taking data and using
that data to generate sections of a user interface layout. These
elements are then rendered on the screen by the Compose
runtime system. In most cases, the data passed from one
composable function to another will have been declared as a state
variable in a parent function. This means that any change of state
value in a parent composable will need to be reflected in any
child composables to which the state has been passed. Compose

addresses this by performing an operation referred to as

Recomposition occurs whenever a state value changes within a
hierarchy of composable functions. As soon as Compose detects a
state change, it works through all of the composable functions in
the activity and recomposes any functions affected by the state
value change. Recomposing simply means that the function gets

called again and passed the new state value.

Recomposing the entire composable tree for a user interface each
time a state value changes would be a highly inefficient approach
to rendering and updating a user interface. Compose avoids this
overhead using a technique called intelligent recomposition that

involves only recomposing those functions directly affected by the



state change. In other words, only functions that read the state

value will be recomposed when the value changes.



20.3 Creating the StateExample project

Launch Android Studio and select the New Project option from
the welcome screen. Within the resulting new project dialog,
choose the Empty Activity template before clicking on the Next
button.

Enter StateExample into the Name field and specify
com.example.stateexample as the package name. Before clicking on
the Finish button, change the Minimum API level setting to API
26: Android 8.0 (Oreo). On completion of the project creation
process, the StateExample project should be listed in the Project
tool window located along the left-hand edge of the Android

Studio main window.



20.4 Declaring state in a composable

The first step in declaring a state value is to wrap it in a
MutableState object. MutableState is a Compose class which is
referred to as an observable Any function that reads a state value
is said to have subscribed to that observable state. As a result,
any changes to the state value will trigger the recomposition of all

subscribed functions.

Within Android Studio, open the MainActivity.kt file, delete the
Greeting composable and modify the class so that it reads as

follows:

package com.example.stateexample

class MainActivity : ComponentActivity() {

override fun onCreate(savedinstanceState: Bundle?) {

super.onCreate(savedInstanceState)

setContent {



StateExampleTheme {

Surface(color =

MaterialTheme.colorScheme.background) {

DemoScreen()

@Composable

fun DemoScreen() {

MyTextField()



@Composable

fun MyTextField() {

@ Preview(showBackground = true)

@Composable

fun GreetingPreview() {

StateExampleTheme {

DemoScreen()

The objective here is to implement MyTextField as a stateful
composable function containing a state variable and an event
handler that changes the state based on the user’s keyboard
input. The result is a text field in which the characters appear as

they are typed.



MutableState instances are created by making a call to the
mutableStateOf() runtime function, passing through the initial state
value. The following, for example, creates a MutableState instance

initialized with an empty String value:

var textState = { mutableStateOf("") }

This provides an observable state which will trigger a
recomposition of all subscribed functions when the contained
value is changed. The above declaration is, however, missing a key
element. As previously discussed, state must be remembered
through recompositions. As currently implemented, the state will
be reinitialized to an empty string each time the function in
which it is declared is recomposed. To retain the current state

value, we need to use the remember keyword:

var myState = remember { mutableStateOf("") }

Remaining within the MainActivity.kt file, add some imports and

modify the MyTextField composable as follows:

import androidx.compose.material3.*



import androidx.compose.runtime.mutableStateOf

import androidx.compose.runtime.remember

import androidx.compose.foundation.layout.Column

@Composable

fun MyTextField() {

var textState = remember { mutableStateOf{"") }

val onTextChange = { text : String ->

textState.value = text

TextField(

value = textState.value,

onValueChange = onTextChange



If the code editor reports that the Material 3 TextField is

experimental, modify the MyTextField composable as follows:

@ Optin(ExperimentalMaterial3Api::class)

@Composable

fun MyTextField() {

var textState by remember { mutableStateOf("") }

Test the code using the Preview panel in interactive mode and
confirm that keyboard input appears in the TextField as it is
typed.

When looking at Compose code examples, you may see

MutableState objects declared in different ways. When using the



above format, it is necessary to read and set the value property of
the MutableState instance. For example, the event handler to

update the state reads as follows:

val onTextChange = { text: String ->

= text

Similarly, the current state value is assigned to the TextField as

follows:

TextField(

value =

onValueChange = onTextChange

A more common and concise approach to declaring state is to
use Kotlin property delegates via the by keyword as follows (note
that two additional libraries need to be imported when using

property delegates):



import androidx.compose.runtime.getValue

import androidx.compose.runtime.setValue

@Composable

fun MyTextField() {

var textState by remember { mutableStateOf("") }

We can now access the state value without needing to directly

reference the MutableState value property within the event handler:

val onTextChange = { text: String ->



textState = text

This also makes reading the current value more concise:

TextField(

value =

onValueChange = onTextChange

A third technique separates the access to a MutableState object

into a value and a setter function as follows:

var (textValue, setText) = remember { mutableStateOf("") }

When changing the value assigned to the state we now do so by

calling the setText setter, passing through the new value:

val onTextChange = { text: String ->

setText(text)



The state value is now accessed by referencing

TextField(

value =

onValueChange = onTextChange

In most cases, the use of the by keyword and property delegates
is the most commonly used technique because it results in
cleaner code. Before continuing with the chapter, revert the

example to use the by keyword.



20.5 Unidirectional data flow

Unidirectional data flow is an approach to app development
whereby state stored in a composable should not be directly
changed by any child composable functions. Consider, for example,
a composable function named FunctionA containing a state value
in the form of a Boolean value. This composable calls another
composable function named FunctionB that contains a Switch
component. The objective is for the switch to update the state
value each time the switch position is changed by the user. In
this situation, adherence to unidirectional data flow prohibits

FunctionB from directly changing the state value.

Instead, FunctionA would declare an event handler (typically in the
form of a lambda) and pass it as a parameter to the child
composable along with the state value. The Switch within
FunctionB would then be configured to call the event handler each
time the switch position changes, passing it the current setting
value. The event handler in FunctionA will then update the state

with the new value.

Make the following changes to the MainActivity.kt file to
implement FunctionA and FunctionB together with a corresponding

modification to the preview composable:

@Composable



fun FunctionA() {

var switchState by remember { mutableStateOf{true) }

val onSwitchChange = { value : Boolean ->

switchState = value

}
FunctionB(
switchState = switchState,
onSwitchChange = onSwitchChange
)
}
@Composable

fun FunctionB(switchState: Boolean, onSwitchChange
Unit ) {

Switch(

: (Boolean) ->



checked = switchState,

onCheckedChange = onSwitchChange

@ Preview(showBackground = true)

@Composable

fun GreetingPreview() {

StateExampleTheme {

Column {
DemoScreen()
FunctionA()

}



Preview the app using interactive mode and verify that clicking the

switch changes the slider position between on and off states.

We can now use this example to break down the state process
into the following individual steps which occur when FunctionA is

called:

1. The switchState state variable is initialized with a true value.

2. The onSwitchChange event handler is declared to accept a

Boolean parameter which it assigns to switchState when called.

3. FunctionB is called and passed both switchState and a reference

to the onSwitchChange event handler.

4. FunctionB calls the built-in Switch component and configures it
to display the state assigned to The Switch component is also
configured to call the onSwitchChange event handler when the user

changes the switch setting.

5. Compose renders the Switch component on the screen.

The above sequence explains how the Switch component gets

rendered on the screen when the app first launches. We can now



explore the sequence of events that occur when the user slides

the switch to the “off” position:

1. The switch is moved to the “off” position.

2. The Switch component calls the onSwitchChange event handler

passing through the current switch position value (in this case

3. The onSwitchChange lambda declared in FunctionA assigns the

hew value to

4. Compose detects that the switchState state value has changed

and initiates a recomposition.

5. Compose identifies that FunctionB contains code that reads the

value of switchState and therefore needs to be recomposed.

6. Compose calls FunctionB with the latest state value and the

reference to the event handler.

7. FunctionB calls the Switch composable and configures it with

the state and event handler.

8. Compose renders the Switch on the screen, this time with the

switch in the “off” position.



The key point to note about this process is that the value
assigned to switchState is only changed from within FunctionA and
never directly updated by FunctionB. The Switch setting is not
moved from the “on” position to the “off” position directly by
FunctionB. Instead, the state is changed by calling upwards to the
event handler located in FunctionA, and allowing recomposition to

regenerate the Switch with the new position setting.

As a general rule, data is passed down through a composable
hierarchy tree while events are called upwards to handlers in

ancestor components as illustrated in Eigure

{ FunctionA }

Data . Event
(switchState) [ FunctionB } (onSwitchChange)
{ Switch J

Figure 20-1




20.6 State hoisting

If you look up the word “hoist” in a dictionary it will likely be
defined as the act of raising or lifting something. The term state
hoisting has a similar meaning in that it involves moving state from
a child composable up to the calling (parent) composable or a
higher ancestor. When the child composable is called by the parent,
it is passed the state along with an event handler. When an event
occurs in the child composable that requires an update to the state,
a call is made to the event handler passing through the new value
as outlined earlier in the chapter. This has the advantage of making
the child composable stateless and, therefore, easier to reuse. It also
allows the state to be passed down to other child composables later

in the app development process.

Consider our MyTextField example from earlier in the chapter:

@Composable

fun DemoScreen() {

MyTextField ()

@Composable



fun MyTextField() {

var textState by remember { mutableStateOf("") }

val onTextChange = { text : String ->

textState = text

TextField (

value = textState,

onValueChange = onTextChange

The self-contained nature of the MyTextField composable means that
it is not a particularly useful component. One issue is that the text
entered by the user is not accessible to the calling function and,
therefore, cannot be passed to any sibling functions. It is also not
possible to pass a different state and event handler through to the

function, thereby limiting its re-usability.



To make the function more useful we need to hoist the state into

the parent DemoScreen function as follows:

@Composable

fun DemoScreen() {

var textState by remember { mutableStateOf("") }

val onTextChange = { text : String ->

textState = text

= textState, onTextChange =

@Composable

fun String, onTextChange : (String) > {

var textState by remember { mutableStateOf("") }

val onTextChange = { text : String ->



textState = text

TextField (

value =

onValueChange = onTextChange

@ Preview(showBackground = true)

@Composable

fun GreetingPreview() {

StateExampleTheme {

DemoScreen()



With the state hoisted to the parent function, MyTextField is now a
stateless, reusable composable which can be called and passed any
state and event handler. Also, the text entered by the user is now

accessible by the parent function and may be passed down to other

composables if necessary.

State hoisting is not limited to moving to the immediate parent of a
composable. State can be raised any number of levels upward within
the composable hierarchy and subsequently passed down through as
many layers of children as needed (within reason). This will often be
necessary when multiple children need access to the same state. In

such a situation, the state will need to be hoisted up to an ancestor

that is common to both children.

In Figure 20-2 below, for example, both NameField and NameText
need access to The only way to make the state available to both
composables is to hoist it up to the MainScreen function since this

is the only ancestor both composables have in common:
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Figure 20-2

The solid arrows indicate the path of textState as it is passed down
through the hierarchy to the NameField and NameText functions (in
the case of the NameField, a reference to the event handler is also
passed down), while the dotted line represents the calls from

NameField function to an event handler declared in MainScreen as

the text changes.

Note that if you find yourself passing state down through an
excessive number of child layers, it may be worth looking at a topic

covered in the chapter entitled “An_Introduction to Composition

When adding state to a function, take some time to decide whether
hoisting state to the caller (or higher) might make for a more re-

usable and flexible composable. While situations will arise where state



is only needed to be used locally in a composable, in most cases it

probably makes sense to hoist the state up to an ancestor.



20.7 Saving state through configuration changes

We now know that the remember keyword can be used to save
state values through recompositions. This technique does not,
however, retain state between configuration A configuration change
generally occurs when some aspect of the device changes in a
way that alters the appearance of an activity (such as rotating the
orientation of the device between portrait and landscape or

changing a system-wide font setting).

Changes such as these will cause the entire activity to be
destroyed and recreated. The reasoning behind this is that these
changes affect resources such as the layout of the user interface
and simply destroying and recreating impacted activities is the
quickest way for an activity to respond to the configuration
change. The result is a newly initialized activity with ho memory

of any previous state values.

To experience the effect of a configuration change, run the
StateExample app on an emulator or device and, once running,
enter some text so that it appears in the TextField before
changing the orientation from portrait to landscape. When using
the emulator, device rotation may be simulated using the rotation
button located in the emulator toolbar. To complete the rotation
on Android 11 or older, it may also be necessary to tap on the
rotation button. This appears in the toolbar of the device or

emulator screen as shown in Figure



Figure 20-3

Before performing the rotation on Android 12 or later, you may
need to enter the Settings app, select the Display category and

enable the Auto-rotate screen option.

Note that after rotation, the TextField is now blank and the text
entered has been lost. In situations where state needs to be
retained through configuration changes, Compose provides the
rememberSaveable keyword. When rememberSaveable is used, the
state will be retained not only through recompositions, but also
configuration changes. Modify the textState declaration to use

rememberSaveable as follows:



import androidx.compose.runtime.saveable.rememberSaveable

@Composable

fun DemoScreen() {

var textState by rememberSaveable { mutableStateOf("") }

Build and run the app once again, enter some text and perform
another rotation. Note that the text is now preserved following the

configuration change.



20.8 Summary

When developing apps with Compose it is vital to have a clear
understanding of how state and recomposition work together to
make sure that the user interface is always up to date. In this
chapter, we have explored state and described how state values
are declared, updated, and passed between composable functions.
You should also have a better understanding of recomposition and

how it is triggered in response to state changes.

We also introduced the concept of unidirectional data flow and
explained how data flows down through the compose hierarchy
while data changes are made by making calls upward to event

handlers declared within ancestor stateful functions.

An important goal when writing composable functions is to
maximize re-usability. This can be achieved, in part, by hoisting
state out of a composable up to the calling parent or a higher

function in the compose hierarchy.

Finally, the chapter described configuration changes and explained
how such changes result in the destruction and recreation of
entire activities. Ordinarily, state is not retained through
configuration changes unless specifically configured to do so using

the rememberSaveable keyword.



21. An Introduction to Composition Local

We already know from previous chapters that user interfaces are
built in Compose by constructing hierarchies of composable
functions. We also know that Compose is state-driven and that
state should generally be declared in the highest possible node of
the composable tree (a concept referred to as state hoisting) and
passed down through the hierarchy to the descendant
composables where it is needed. While this works well for most
situations, it can become cumbersome if the state needs to be
passed down through multiple levels within the hierarchy. A
solution to this problem exists in the form of CompositionLocal,

which is the subject of this chapter.



21.1 Understanding CompositionLocal

In simple terms, CompositionLocal provides a way to make state

declared higher in the composable hierarchy tree available to

functions lower in the tree without having to pass it through

every composable between the point where it is declared and the

function where it is used. Consider, for example, the following

hierarchy diagram:
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Composable 1 colorstate
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Composable 2 Composable 3 colorstate
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Composable 4 Composable 5 colorState
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Figure 21-1

In the hierarchy, a state named colorState is declared in

Composable1 but is only used in Composable8. Although the state

is not needed in either Composable3 or Composables, colorState

still needs to be passed down through those functions to reach

Composable8. The deeper the tree becomes, the more levels



through which the state needs to be passed to reach the function

where it is used.

A solution to this problem is to use CompositionlLocal.

CompositionLocal allows us to declare the data at the highest
necessary node in the tree and then access it in descendants
without having to pass it through the intervening children as

shown in Eigure

Composable 1

Composable 2 Composable 3
3 5 < colorState
accessibility
( A branch
Composable 4 Composable 5
e A |
Composable 6 ] ’ Composable 7 ‘ ‘ Composable 8
Figure 21-2

CompositionLocal has the added advantage of only making the
data available to the tree branch below the point at which it is
assigned a value. In other words, if the state were assigned a
value when calling composable3 it would be accessible within
composable numbers 3, 5, 7, and 8, but not to composables 1, 2,

4, or 6. This allows state to be kept local to specific branches of



the composable tree and for different sub-branches to have
different values assigned to the same CompositionlLocal state. So
Composables could, for example, have a different color assigned

to colorState from that set when Composable7 is called.



21.2 Using CompositionLocal

Declaring state using CompositionlLocal starts with the creation of
a ProvidableCompositionLocal instance which can be obtained via
a call to either the compositionLocalOf() or
staticCompositionLocalOf() function. In each case, the function
accepts a lambda defining a default value to be assigned to the

state in the absence of a specific assignment, for example:

val LocalColor = compositionLocalOf { Color.Red }

val LocalColor

staticCompositionLocalOf { Color.Red }

The staticCompositionLocalOf() function is recommended for storing
state values that are unlikely to change very often. This is because
any changes to the state value will cause the entire tree beneath
where the value is assigned to be recomposed. The
compositionLocalOf() function, on the other hand, will only cause
recomposition to be performed on composables where the current
state is accessed. This function should be used when dealing with

states that change frequently.

The next step is to assign a value to the
ProvidableCompositionLocal instance and wrap the call to the
immediate descendant child composable in a

CompositionLocalProvider call:



val color = Color.Blue

CompositionLocalProvider(LocalColor provides color) {

Composables()

Any descendants of Compositions will now be able to access the
CompositionLocal state via the current property of the

ProviderCompositionLocal instance, for example:

val background = LocalColor.current

In the rest of this chapter, we will build a project that mirrors the

hierarchy illustrated in Figure 21-1 to show CompositionLocal in

action.



21.3 Creating the ComplLocalDemo project

Launch Android Studio and create a new Empty Activity project
named ComplocalDemo. Specify com.example.complocaldemo as the
package name and select a minimum API level of API 26:
Android 8.0 (Oreo).

Within the MainActivity.kt file, delete the Greeting function and

add a new empty composable named Composable1:

@Composable

fun Composable1() {

Next, edit the OnCreate() method and GreetingPreview function to

call Composable1 instead of Greeting.



21.4 Designing the layout

Within the MainActivity.kt file, implement the composable hierarchy

as follows:

import androidx.compose.foundation.background

import androidx.compose.foundation.isSysteminDarkTheme

import androidx.compose.foundation.layout.Column

import androidx.compose.runtime.CompositionLocalProvider

import androidx.compose.runtime.staticCompositionLocalOf

import androidx.compose.ui.graphics.Color



@Composable

fun Composable1() {

Column {

Composablez()

Composables()

@Composable

fun Composablez() {

Composable4()

@Composable

fun Composable3() {

Composablesy()



@Composable

fun Composables() {

Composable6()

@Composable

fun Composables() {

Composabley()
Composable8§()
}
@Composable

fun Composable6() {

Text("Composable 6")



@Composable

fun Composablez() {

@Composable

fun Composable8() {

Text("Composable 8")



21.5 Adding the CompositionLocal state

The objective for this project is to declare a color state that can
be changed depending on whether the device is in light or dark
mode, and use that to control the background color of the text
component in Composable8. Since this value will not change
regularly, we can use the staticCompositionLocalOf() function.
Remaining within the MainActivity.kt file, add the following line

above the Composable1 declaration:

val LocalColor = staticCompositionLocalOf { Color(oxFFffdbcf) }

@Composable
fun Composable1() {

Column {



Next, a call to isSysteminDarkTheme() needs to be added, and the
result used to assign a different color to the LocalColor state. We
also need to call Composable3 from within the context of the

CompositionLocal provider:

@Composable

fun Composable1() {

val color = if (isSysteminDarkTheme()) {

Color{oxFFao8d87)

} else {

Color(oxFFffdbcf)

Column {

Composable2()

CompositionLocalProvider(LocalColor provides color) {

Composables|)






21.6 Accessing the CompositionLocal state

The final task before testing the code is to assign the color state

to the Text component in Composable8 as follows:

@Composable

fun Composable8() {

Text("Composable 8", modifier



21.7 Testing the design

To test the activity code in both light and dark modes, add a new
Preview composable to MainActivity.kt with uiMode set to
UI_NIGHT_MODE_YES:

import android.content.res.Configuration.UI_MODE_NIGHT_YES

@ Preview(showBackground = true, uiMode =
UI_MODE_NIGHT_YES)

@Composable

fun DarkPreview() {

ComplocalDemoTheme {



Composablei()

After refreshing the Preview panel, both the default and dark
preview should appear, each using a different color as the

background for the Text component in Composable8:

GreetingPreview
Composable 6
Composable 8

DarkPreview

Composable 6

Figure 21-3



We can also modify the code so that composables 3, 5, 7, and 8
have different color settings. All this requires is calling each
composable from within a CompositionLocalProvider with a

different color assignment:

@Composable

fun Composable3() {

Text("Composable 3", modifier =

Modifier.background(LocalColor.current))

CompositionLocalProvider(LocalColor provides Color.Red) {

Composables()



@Composable

fun Composables() {

Text("Composable 5", modifier =

Modifier.background(LocalColor.current))

CompositionLocalProvider(LocalColor provides Color.Green) {

Composabley ()

CompositionLocalProvider(LocalColor provides Color.Yellow) {

Composable§|()



@Composable

fun Composable7() {

Text("Composable 7", modifier =

Modifier.background(LocalColor.current))

Now when the Preview panel is refreshed, all four components

will have a different color, all based on the same LocalColor state:



GreetingPreview

Composable 6
Composable 3

Composable 8

DarkPreview

Composable 6

Composable 8



Figure 21-4

As one final step, try to access the LocalColor state from

Composableé:

@Composable

fun Composable6() {

Text("Composable modifier =

On refreshing the preview the Text component for Compsoable6
will appear using the default color assigned to LocalColor. This is
because Composable6 is in a different branch of the tree and

does not have access to the current LocalColor setting.



21.8 Summary

This chapter has introduced CompositionLocal and demonstrated
how it can be used to declare state that is accessible to
composables lower down in the layout hierarchy without having to
be passed from one child to another. State declared in this way is
local to the branch of the hierarchy tree in which a value is

assigned.



22. An Overview of Compose Slot APIs

Now that we have a better idea of what composable functions are
and how to create them, it is time to explore composables that
provide a slot In this chapter, we will explain what a slot API is,
what it is used for and how you can include slots in your own
composable functions. We will also explore some of the built-in

composables that provide slot APl support.



22.1 Understanding slot APIs

As we already know, composable functions can include calls to
one or more other composable functions. This usually means that
the content of a composable is predefined in terms of which
other composables it calls and, therefore, the content it displays.
Consider the following function consisting of a Column and three

Text components:

@Composable

fun SlotDemo() {

Column {

Text("Top Text")

Text("Middle Text")

Text("Bottom Text")



The function could be modified to pass in parameters that specify
the text to be displayed or even the color and font size of that
text. Regardless of the changes we make, however, the function is
still restricted to displaying a column containing three Text

components:

S

Top Text
Middle Text
Bottom Text

Figure 22-1

Suppose, however, that we need to display three items in a
column, but do not know what composable will take up the
middle position until just before the composable is called. In its
current form, there is no way to display anything but the declared
Text component in the middle position. The solution to this

problem is to open up the middle composable as a slot into



which any other composable may be placed when the function is
called. This is referred to as providing a slot API for the
composable. API is an abbreviation of Application Programming
Interface and, in this context, implies that we are adding a
programming interface to our composable that allows the caller to
specify the composable to appear within a slot. In fact, a
composable function can provide multiple slots to the caller. In
the above function, for example, all of the Text components could

be declared as slots if required.



22.2 Declaring a slot API

It can be helpful to think of a slot APl composable as a user
interface template in which one or more elements are left blank.
These missing pieces are then passed as parameters when the
composable is called and included when the user interface is

rendered by the Compose runtime system.

The first step in adding slots to a composable is to specify that
it accepts a slot as a parameter. This is essentially a case of
declaring that a composable accepts other composables as
parameters. In the case of our example SlotDemo composable, we

would modify the function signature as follows:

@Composable

fun @Composable () > {

When the SlotDemo composable is called, it will now need to be
passed a composable function. Note that the function is declared
as returning a Unit object. Unit is a Kotlin type used to indicate

that a function does not return any value. Unit can be considered



to be the Kotlin equivalent of void in other languages. The
parameter has been assigned a label of “middleContent”, though
this could be any valid label name that helps to describe the slot

and allows us to reference it within the body of the function.

The only remaining change to this composable is to substitute the

middleContent component into the Column declaration as follows:

@Composable

fun SlotDemo(middleContent: @Composable () -> Unit) {

Column {

Text("Top Text")

middleContenty()

Text("Bottom Text")

We have now successfully declared a slot API for our SlotDemo

composable.



22.3 Calling slot APl composables

The next step is to learn how to make use of the slot API

configured into our SlotDemo composable. This simply involves
passing a composable through as a parameter when making the
SlotDemo function call. Suppose, for example, that we need the

following composable to appear in the middleContent slot:

@Composable

fun ButtonDemo() {

Button(onClick = { }) {

Text("Click Me")

We can now call our SlotDemo composable function as follows:

SlotDemo(middleContent = { ButtonDemo() })

While this syntax works, it can quickly become cluttered if the

composable has more than one slot to be filled. A cleaner syntax



reads as follows:
SlotDemo {

ButtonDemo()

Regardless of the syntax used, the design will be rendered as

shown below in Figure

DefaultPreview

Top Text

Click Me

Bottom Text



Figure 22-2

A slot API is not, of course, limited to a single slot. The

SlotDemo example could be composed entirely of slots as follows:

@Composable

fun SlotDemo(
topContent: @Composable () -> Unit,
middleContent: @Composable () -> Unit,

bottomContent: @Composable () -> Unit) {

Column {
topContent()
middleContent()

bottomContent|()



With these changes made, the call to SlotDemo could be

structured as follows:

SlotDemo(

topContent = { Text("Top Text") },

middleContent = { ButtonDemo() },

bottomContent = { Text("Bottom Text") }

As with the single slot, this can be abbreviated for clarity:

SlotDemo(

{ Text("Top Text") },

{ ButtonDemo() },

{ Text("Bottom Text") }



22.4 Summary

In this chapter, we have introduced the concept of slot APIs and
demonstrated how they can be added to composable functions. By
implementing a slot API, the content of a composable function
can be specified dynamically at the point that it is called. This
contrasts with the static content of a typical composable where
the content is defined at the point the function is written and
cannot subsequently be changed. A composable with a slot API is
essentially a user interface template containing one or more slots

into which other composables can be inserted at runtime.

With the basics of slot APIs covered in this chapter, the next

chapter will create a project that puts this theory into practice.



23. A Compose Slot API Tutorial

In this chapter, we will be creating a project within Android
Studio to practice the use of slot APIs to build flexible and
dynamic composable functions. This will include writing a
composable function with two slots and calling that function with
different content composables based on selections made by the

user.



23.1 About the project

Once the project is completed, it will consist of a title, progress
indicator, and two checkboxes. The checkboxes will be used to
control whether the title is represented as text or graphics, and
also whether a circular or linear progress indicator is displayed.
Both the title and progress indicator will be declared as slots
which will be filled with either a Text or Image composable for
the title or, in the case of the progress indicator, a

LinearProgressindicator or CircularProgressindicator component.



23.2 Creating the SlotApiDemo project

Launch Android Studio and select the New Project option from
the welcome screen. Choose the Empty Activity template within

the New Project dialog before clicking on the Next button.

Enter SlotApiDemo into the Name field and specify
com.example.slotapidemo as the package name. Before clicking on
the Finish button, change the Minimum API level setting to API
26: Android 8.0 (Oreo). Once the project has been created, the
SlotApiDemo project should be listed in the Project tool window
located along the left-hand edge of the Android Studio main

window.



23.3 Preparing the MainActivity class file

Android Studio should have automatically loaded the MainActivity.kt
file into the code editor. If it has not, locate it in the Project tool
window -> java -> com.example.slotapidemo -> and double-click on
it to load it into the editor. Once loaded, modify the file to

remove the template code as follows:

package com.example.slotapidemo

class MainActivity : ComponentActivity() {

override fun onCreate(savedinstanceState: Bundle?) {

super.onCreate(savedInstanceState)

setContent {

SlotApiDemoTheme {

Surface(



modifier = Modifier.filMaxSize(),

color =

MaterialTheme.colorScheme.background

) {

Greeting("Android")

@Composable

fun Greeting(name: String) {

Text(text = "Hello $name!")



@ Preview(showBackground = true)

@Composable

fun GreetingPreview() {

SlotApiDemoTheme {

Greeting("Android")



23.4 Creating the MainScreen composable

Edit the onCreate method of the MainActivity class to call a
composable named MainScreen from within the Surface

component:

override fun onCreate(savedinstanceState: Bundle?) {

super.onCreate(savedInstanceState)

setContent {

SlotDemoTheme {

Surface(

modifier = Modifier.filMaxSize(),

color = MaterialTheme.colorScheme.background

) {

MainScreen()



MainScreen will contain the state and event handlers for the two
Checkbox components. Start adding this composable now, making
sure to place it after the closing brace (}) of the MainActivity

class declaration:

import androidx.compose.runtime.*

import androidx.compose.material3.*

import androidx.compose.foundation.layout.*

@Composable



fun MainScreen() {

var linearSelected by remember { mutableStateOf{true) }

var imageSelected by remember { mutableStateOf{true) }

val onlLinearClick = { value : Boolean ->

linearSelected = value

val onTitleClick = { value : Boolean ->

imageSelected = value

Here we have declared two state variables, one for each of the
two Checkbox components, and initialized them to true. Next,
event handlers have been declared to allow the state of each

variable to be changed when the user toggles the Checkbox



settings. Later in the project, MainScreen will be modified to call

a second composable named ScreenContent.



23.5 Adding the ScreenContent composable

When the MainScreen function calls it, the ScreenContent
composable will need to be passed the state variables and event

handlers and can initially be declared as follows:

package com.example.slotapidemo

import androidx.compose.ui.Alignment

import androidx.compose.ui.unit.dp

@Composable

fun ScreenContent(

linearSelected: Boolean,



imageSelected: Boolean,

onTitleClick: (Boolean) -> Unit,

onLinearClick: (Boolean) -> Unit) {

Column(

modifier = Modifier.fillMaxSize(),

horizontalAlignment = Alignment.CenterHorizontally,

verticalArrangement = Arrangement.SpaceBetween

) {

As the name suggests, the ScreenContent composable is going to
be responsible for displaying the screen content including the title,
progress indicator, and checkboxes. In preparation for this content,
we have made a call to the Column composable and configured it

to center its children along the horizontal axis. The SpaceBetween



arrangement property has also been set. This tells the column to
space its children evenly but not to include spacing before the
first or after the last child.

One of the child composables which ScreenContent will call will
be responsible for rendering the two Checkbox components. While
these could be added directly within the Column composable, a
better approach is to place them in a separate composable which

can be called from within ScreenContent.



23.6 Creating the Checkbox composable

The composable containing the checkboxes will consist of a Row
component containing two Checkbox instances. In addition, Text
composables will be positioned to the left of each Checkbox with

a Spacer separating the two Text/Checkbox pairs.

When it is called, the Checkboxes composable will need to be
passed the two state variables which will be used to make sure
the checkboxes display the current state. Also passed will be
references to the onlLinearClick and onTitleClick event handlers
which will be assigned to the onCheckChange properties of the two

Checkbox components.

Remaining within the MainActivity.kt file, add the CheckBoxes

composable so that it reads as follows:

@Composable

fun CheckBoxes(

linearSelected: Boolean,

imageSelected: Boolean,

onTitleClick: (Boolean) -> Unit,



onlLinearClick: (Boolean) -> Unit

Row/(

Modifier.padding(20.dp),

verticalAlignment = Alignment.CenterVertically
) {

Checkbox(

checked = imageSelected,

onCheckedChange = onTitleClick

Text("Image Title")

Spacer(Modifierwidth (20.dp))

Checkbox(checked = linearSelected,



onCheckedChange = onlLinearClick

Text("Linear Progress")

If you would like to preview the composable before proceeding,
add the following preview declaration before clicking on the Build

& Refresh link in the Preview panel:

@ Preview

@Composable

fun DemoPreview() {

CheckBoxes (

linearSelected = true,

imageSelected = true,



onTitleClick = { /*TODO%*/ },

onlinearClick = { /*TODO%*/})

When calling the CheckBoxes composable in the above preview
function we are setting the two state properties to true and

assigning stub lambdas that do nothing as the event callbacks.

Once the preview has been refreshed, the layout should match

that shown in Eigure 23-1 below:

Image Title Linear Progress

Figure 23-1



23.7 Implementing the ScreenContent slot API

Now that we have added the composable containing the two
checkboxes, we can call it from within the Column contained
within ScreenContent. Since both the state variables and event
handlers were already passed into ScreenContent, we can simply
pass these to the Checkboxes composable when we call it. Locate

the ScreenContent composable and modify it as follows:

@Composable

fun ScreenContent(

linearSelected: Boolean,

imageSelected: Boolean,

onTitleClick: (Boolean) -> Unit,

onlLinearClick: (Boolean) -> Unit) {

Column(

modifier = Modifier.filMaxSize(),

horizontalAlignment = Alighment.CenterHorizontally,



verticalArrangement = Arrangement.SpaceBetween

) {

CheckBoxes(linearSelected, imageSelected, onTitleClick,

onLinearClick)

In addition to the row of checkboxes, ScreenContent also needs
slots for the title and progress indicator. These will be named
titleContent and progressContent and need to be added as

parameters and referenced as children of the Column:

@Composable

fun ScreenContent(

linearSelected: Boolean,

imageSelected: Boolean,

onTitleClick: (Boolean) -> Unit,



onlLinearClick: (Boolean) ->
titleContent: @Composable () -> Unit,
progressContent: @Composable () -> {
Column(
modifier = Modifier.fillMaxSize(),
horizontalAlignment = Alighment.CenterHorizontally,

Arrangement.SpaceBetween

verticalArrangement

) {
titleContenty()

progressContent()

CheckBoxes(linearSelected, imageSelected, onTitleClick,

onLinearClick)



All that remains is to add some code to the MainScreen
declaration so that different composables are provided for the
slots based on the current values of the linearSelected and
imageSelected state variables. Before taking that step, however, we

need to add one more composable to display an image in the
title slot.



23.8 Adding an Image drawable resource

For this example, we will use one of the built-in vector drawings
included with the Android SDK. To select a drawing and add it to
the project, begin by locating the drawable folder in the Project tool
window -> res -> and right-click on it. In the resulting menu select

the New -> Vector Asset menu option:
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Figure 23-2

Once the menu option has been selected, Android Studio will display

the Asset Studio dialog shown in Figure 23-3_below:

1



5] @ Asset Studio

Asset Type: @ Clip At Local file (SVG, PSD)

Name: ic_android_black_24dp

Clip Art: P h

Size: dp

Color:

Opacity: 100 %

Enable auto mirroring for RTL layout

Vector Drawable Preview

? Cancel Previous m Finish

Figure 23-3

Within the dialog, click on the image to the right of the Clip Art
label as indicated by the arrow in the above figure to display a list
of available icons. In the search box, enter “cloud” and select the

“Cloud Download” icon as shown in Figure 23-4_below:
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Figure 23-4

Click on the OK button to select the drawing and return to the

Asset Studio dialog. Increase the size of the image to 150dp x 150dp

before clicking the Next button. On the subsequent screen, click on

Finish to save the file in the default location.

While changing the image’s color in the Asset Studio dialog was

possible, the color selector only allows us to specify colors by RGB

value. Instead, we want to use a named color from the project



resources. So, in the Project tool window, find and open the
colors.xml file under app -> res -> This file contains a set of named

color properties. In this example, the plan is to use the color named

version="1.0" encoding="utf-8"?>

name="purple_700">#FF3700B3

Having chosen a color from the resources, double-click on the
baseline_cloud_download_24.xm| vector asset file in the Project tool
window to load it into the code editor and modify the android:tint

property as follows:

android:height="150dp"

android:viewportHeight="24" android:viewportWidth="24"

android:width="150dp"

xmlns:android="http://schemas.android.com/apk/res/android">

android:fillColor="@android:color/white"

android:pathData="M19.35,10.04C18.67,6.59 15.64,4 12,4 9.11,4 6.6,5.64


http://schemas.android.com/apk/res/android

5.35,8.04 2.34,8.36 0,10.91 0,14€0,3.31 2.69,6 6,6h13¢c2.76,0 §,-2.24 5,-§
0,-2.64 -2.05,-4.78 -4.65,-4.96zM17,13l-5,5 -5,-5h3Voh4v4h3z" />



23.9 Writing the Titlelmage composable

Now that we have an image to display for the title, the next step
is to add a composable to the MainActivity.kt file to display the
image. To make this composable as reusable as possible, we will

design it so that it is passed the image resource to be displayed:

import androidx.compose.foundation.Image

import androidx.compose.ui.res.painterResource

@Composable
fun Titlelmage(drawing: Int) {

Image(



painter = painterResource(drawing),

contentDescription = "title image",

modifier = Modifier.size(150.dp)

The Image component provides several ways to render graphics
depending on which parameters are used when it is called. Since
we are using a resource image, the component makes a call to

the painterResource method to render the image.



23.10 Completing the MainScreen composable

Now that all of the child composables have been added and the
state variable and event handlers implemented, it is time to
complete work on the MainScreen declaration. Specifically, code
needs to be added to this composable to display different content
in the two ScreenContent slots depending on the current checkbox

selections.

Locate the MainScreen composable in the MainActivity.kt file and

add code to call the ScreenContent function as follows:

@Composable

fun MainScreen() {

var linearSelected by remember { mutableStateOf(true) }

var imageSelected by remember { mutableStateOf(true) }

val onLinearClick = { value : Boolean ->

linearSelected = value



val onTitleClick = { value : Boolean -

imageSelected = value

ScreenContent(

linearSelected = linearSelected,

imageSelected = imageSelected,

onlLinearClick = onLinearClick,

onTitleClick

onTitleClick,

titleContent = {

if (imageSelected) {

Titlelmage(drawing =

R.drawable.baseline_cloud_download_24)

} else {

Text("Downloading",



style = MaterialTheme.typography.headlineSmall,

modifier = Modifier.padding(30.dp))

progressContent = {

if (linearSelected) {

LinearProgressindicator(Modifier.height(40.dp))

} else {

CircularProgressindicator(Modifier.size(200.dp),

strokeWidth = 18.dp)



The ScreenContent call begins by passing through the state
variables and event handlers which will subsequently be passed

down to the two Checkbox instances:

ScreenContent(

linearSelected = linearSelected,

imageSelected = imageSelected,

onlLinearClick = onLinearClick,

onTitleClick = onTitleClick,

The next parameter deals with the titleContent slot and uses an if

statement to pass through either a Titlelmage or Text component

depending on the current value of the imageSelected state:

titleContent = {

if (imageSelected) {

Titlelmage(drawing =

R.drawable.baseline_cloud_download_24)



} else {

Text("Downloading", style =
MaterialTheme.typography.headlineSmall,

modifier = Modifier.padding(30.dp))

Finally, either a linear or circular progress indicator is used to fill
ScreenContent’s progressContent slot based on the current value of

the linearSelected state:

progressContent = {

if (linearSelected) {

LinearProgressindicator(Modifier.height(40.dp))

} else {

CircularProgressindicator(Modifier.size(200.dp), strokeWidth
= 18.dp)



Note that we haven't passed a progress value through to either of
the progress indicators. This will cause the components to enter
indeterminate progress mode which will cause them to show a

continually cycling indicator.



23.11 Previewing the project

With these changes complete, the project is now ready to preview.
Locate the DemoPreview composable added earlier in the chapter
and modify it to call MainScreen instead of the Checkboxes

composable. Also, add the system Ul to the preview:

= true)

@Composable

fun DemoPreview() {

MainScreen()

Once a rebuild has been performed, the Preview panel should

resemble that shown in Figure
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Figure 23-5

To test that the project works, start interactive mode by clicking

%

(O et

on the button indicated in Eigure

DemoPreview

A

Figure 23-6

Once interactive mode has started, experiment with different
combinations of checkbox settings to confirm that the slot API for
the ScreenContent composable is performing as expected. Eigure

for example, shows the rendering with both checkboxes disabled:
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Figure 23-7



23.12 Summatry

In this chapter, we have demonstrated the use of a slot API to
insert different content into a composable at the point that it is
called during runtime. Incidentally, we also passed state variables
and event handler references down through multiple levels of
composable functions and explored how to use Android Studio’s
Asset Studio to select and configure built-in vector drawable
assets. Finally, we also used the built-in Image component to

render an image within a user interface layout.



24. Using Modifiers in Compose

In this chapter, we will introduce Compose modifiers and explain
how they can be used to customize the appearance and behavior
of composables. Topics covered will include an overview of
modifiers and an introduction to the Modifier object. The chapter
will also explain how to create and use modifiers, and how to

add modifier support to your own composables.



24.1 An overview of modifiers

Many composables accept one or more parameters that define
their appearance and behavior within the running app. We can, for
example, specify the font size and weight of a Text composable by

passing through parameters as follows:

@Composable

fun DemoScreen() {

Text(

"My Vacation”,

fontSize = 40.sp,

fontWeight = FontWeight.Bold

In addition to parameters of this type, most built-in composables
also accept an optional modifier parameter which allows additional

aspects of the composable to be configured. Unlike parameters,



which are generally specific to the type of composable (a font
setting would have no meaning to a Column component for
example), modifiers are more general in that they can be applied

to any composable.

The foundation for building modifiers is the Modifier object.
Modifier is a built-in Compose object designed to store
configuration settings that can be applied to composables. The
Modifier object provides a wide selection of methods that can be
called upon to configure properties such as borders, padding,
background, size requirements, event handlers, and gestures to
name just a few. Once declared, a Modifier can be passed to

other composables and used to change appearance and behavior.

In the remainder of this chapter, we will explore the key concepts

of modifiers and demonstrate their use within an example project.



24.2 Creating the ModifierDemo project

Launch Android Studio and select the New Project option from
the welcome screen. Within the new project dialog, choose the

Empty Activity template before clicking on the Next button.

Enter ModifierDemo into the Name field and specify
com.example.modifierdemo as the package name. Before clicking on
the Finish button, change the Minimum API level setting to API
26: Android 8.0 (Oreo). Once the project has been created, the
project files should be listed in the Project tool window located

along the left-hand edge of the Android Studio main window.

Load the MainActivity.kt file into the code editor and delete the

Greeting composable before making the following changes:

package com.example.modifierdemo

import androidx.compose.ui.graphics.Color

import androidx.compose.ui.unit.sp



import androidx.compose.ui.text.font.FontWeight

class MainActivity : ComponentActivity() {

override fun onCreate(savedinstanceState: Bundle?) {

super.onCreate(savedInstanceState)

setContent {

Surface(

modifier = Modifier.filMaxSize(),

color = MaterialTheme.colorScheme.background

) {

DemoScreen()



@Composable

fun DemoScreen() {

Text(

"Hello Compose”,

fontSize = 40.sp,

fontWeight = FontWeight.Bold

@ Preview(showBackground = true)

@Composable

fun {



ModifierDemoTheme {

DemoScreen()



24.3 Creating a modifier

The first step in learning to work with modifiers is to create one. To
begin with, we can create a modifier without any configuration

settings as follows:

val modifier = Modifier

This essentially gives us a blank modifier containing no configuration
settings. To configure the modifier, we need to call methods on it.
For example, the modifier can be configured to add 10dp of padding

on all four sides of any composable to which it is applied:

val modifier = Modifier.padding(all = 10.dp)

Method calls on a Modifier instance may be chained together to
apply multiple configuration settings in a single operation. The
following addition to the modifier will draw a black, 2dp wide border

around a composable:

val modifier = Modifier

.padding(all = 10.dp)

.border(width = 2.dp, color = Color.Black)



Once a modifier has been created it can be passed to any
composable which accepts a modifier parameter. Edit the
DemoScreen function so that it reads as follows to pass our modifier

to the Text composable:

import androidx.compose.foundation.border

import androidx.compose.foundation.layout.padding

import androidx.compose.ui.unit.dp

@Composable

fun DemoScreen() {

val modifier = Modifier

.border(width = 2.dp, color = Color.Black)



.padding(all = 10.dp)

Text(

"Hello Compose",

modifier = modifier,

fontSize = 4o0.sp,

fontWeight = FontWeight.Bold

When the layout is previewed it should appear as illustrated in

Figure

Hello Compose

Figure 24-1



As we can see from the preview, the padding and border have been
applied to the text. Clearly, the Text composable has been
implemented such that it accepts a modifier as a parameter. If a
composable accepts a modifier it will always be the first optional
parameter in the parameter list. This has the added benefit of
allowing the modifier to be passed without declaring the argument

name. The following, therefore, is syntactically correct:

Text(

"Hello Compose",

modifier,

fontSize = 4o0.sp,

fontWeight = FontWeight.Bold



24.4 Modifier ordering

The order in which modifiers are chained is of great significance to
the resulting output. In the above example, the border was applied
first followed by the padding. This has the result of the border
appearing outside the padding. To place the border inside the

padding, the order of the modifiers needs to be swapped as follows:
val modifier = Modifier

.padding(all = 10.dp)

.border(width = 2.dp, color = Color.Black)

When previewed, the Text composable will appear as shown in Figure

24-2 below:

AC
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Figure 24-2



If you don’t see the expected effects when working with chained
modifiers, keep in mind this may be because of the order in which

they are being applied to the component.



24.5 Adding modifier support to a composable

So far in this chapter, we have shown how to create a modifier and
use it with a built-in composable. When developing your own
composables it is important to consider whether modifier support

should be included to make the function more configurable.

When adding modifier support to a composable the first rule is that
the parameter should be named “modifier” and must be the first
optional parameter in the function’s parameter list. As an example,
we can add a new composable named Customimage to our project
which accepts as parameters the image resource to display and a
modifier. Edit the MainActivity.kt file and add this composable so that

it reads as follows:

import androidx.compose.foundation.Image

import androidx.compose.ui.res.painterResource



@Composable

fun Customimage(image: Int) {

Image(

painter = painterResource(image),

contentDescription = null

As currently declared, the function only accepts one parameter in the

form of the image resource. The next step is to add the modifier

parameter:

@Composable

fun Customlmage(image: modifier: {

Image(

painter = painterResource(image),

contentDescription = null



It is important to remember that the modifier parameter must be
optional so that the function can be called without one. This means
that we need to specify an empty Modifier instance as the default

for the parameter:

@Composable

fun Customlimage(image: Int, modifier: {

Finally, we need to make sure that the modifier is applied<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>